




Introduction (English)
This Concise User’s Guide introduces the main features
of your computer. The English version of this guide be-
gins on page 1. The expanded User’s Manual is on the
Device Drivers & Utilities + User’s Manual DVD-ROM.

Einführung (Deutsch)
Dieses Ausführliche Benutzerhandbuch führt Sie in die
Hauptfunktionen des Notebooks ein. Die deutsche Versi-
on des Handbuchs beginnt auf Seite 41. Das erweiterte
Benutzerhandbuch finden Sie auf der DVD-ROM Device
Drivers & Utilities + User's Manual (DVD-ROM für die
Gerätetreiber und Hilfsprogramme).

Présentation (Français)
Ce Guide Utilisateur Concis présente les fonctionnalités
principales de votre ordinateur. La version française de
ce guide commence à la page 81. Le Manuel de l'Utilisa-
teur étendu se trouve sur le DVD-ROM Device Drivers
& Utilities + User's Manual (DVD-ROM de pilotes &
utilitaires + manuel de l'utilisateur).

Introducción (Español)
Esta Guía del Usuario Concisa le presenta las caracterís-
ticas principales de su ordenador. La versión española de
esta guía comienza en la página 121. El Manual del usua-
rio completo se encuentra en el DVD-ROM Device Dri-
vers & Utilities + User's Manual (DVD-ROM de
controladores del dispositivo y utilidades + manual del
usuario).

Introduzione (Italiano)
La presente Guida Rapida per l'Utente introduce le carat-
teristiche principali del computer. La versione italiana di
questa guida inizia da pagina 161. Il Manuale utente
completo si trova nel DVD-ROM Device Drivers & Uti-
lities + User's Manual (DVD-ROM contenente driver e
utilità + manuale utente).
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Notice
The company reserves the right to revise this publication or to change its contents without notice. Information con-
tained herein is for reference only and does not constitute a commitment on the part of the manufacturer or any sub-
sequent vendor. They assume no responsibility or liability for any errors or inaccuracies that may appear in this
publication nor are they in anyway responsible for any loss or damage resulting from the use (or misuse) of this pub-
lication.
This publication and any accompanying software may not, in whole or in part, be reproduced, translated, transmitted
or reduced to any machine readable form without prior consent from the vendor, manufacturer or creators of this pub-
lication, except for copies kept by the user for backup purposes.
Brand and product names mentioned in this publication may or may not be copyrights and/or registered trademarks
of their respective companies. They are mentioned for identification purposes only and are not intended as an endorse-
ment of that product or its manufacturer.
© November 2007

Trademarks
This product incorporates copyright protection technology that is protected by method claims of certain U.S. patents
and other intellectual property rights owned by Macrovision Corporation and other rights owners. Use of this copy-
right protection technology must be authorized by Macrovision Corporation, and is intended for home or other limited
viewing uses only unless otherwise authorized by Macrovision Corporation. Reverse engineering or disassembly is
prohibited.
Intel and Intel Core are trademarks/registered trademarks of Intel Corporation.

 is a trademark of SRS Labs, Inc.
WOW technology is incorporated under license from SRS Labs, Inc.
Notice - 1
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About this Concise User Guide
This quick guide is a brief introduction to getting your system started. This is a supplement, and not a substitute for
the expanded English language User’s Manual in Adobe Acrobat format on the Device Drivers & Utilities + User’s
Manual DVD-ROM supplied with your computer. This DVD-ROM also contains the drivers and utilities necessary
for the proper operation of the computer. 

Some or all of the computer’s features may already have been setup. If they aren’t, or you are planning to re-configure
(or re-install) portions of the system, refer to the expanded User’s Manual. The Device Drivers & Utilities + User’s
Manual DVD-ROM does not contain an operating system.

Regulatory Information
Regulatory notices and information are contained in the expanded User’s Manual on the Device Drivers & Utilities
+ User’s Manual DVD-ROM.

Wireless Device Operation Aboard Aircraft

The use of any portable electronic transmission devices aboard aircraft is usually prohibited. Make sure the wireless modules are
OFF if you are using the computer aboard aircraft.
2 -  About this Concise User Guide
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Instructions for Care and Operation
The computer is quite rugged, but it can be damaged. To prevent this, follow these suggestions:

• Don’t drop it, or expose it to shock. If the computer falls, the case and the components could be damaged.
• Keep it dry, and don’t overheat it. Keep the computer and power supply away from any kind of heating element. 

This is an electrical appliance. If water or any other liquid gets into it, the computer could be badly damaged.
• Avoid interference. Keep the computer away from high capacity transformers, electric motors, and other strong mag-

netic fields. These can hinder proper performance and damage your data.
• Follow the proper working procedures for the computer. Shut the computer down properly and don’t forget to 

save your work. Remember to periodically save your data as data may be lost.
• Take care when using peripheral devices.

Servicing
Do not attempt to service the computer yourself. Doing so may violate your warranty and expose you and the com-
puter to electric shock. Refer all servicing to authorized service personnel. Unplug the computer from the power sup-
ply. Then refer servicing to qualified service personnel under any of the following conditions:

• When the power cord is damaged or frayed.
• If the computer has been exposed to any liquids.
• If the computer does not work normally when you follow the operating instructions.
• If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
• If there is an unusual odor, heat or smoke coming from your computer.
Instructions for Care and Operation - 3
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Power Safety
The computer has specific power requirements:
• Only use an AC/DC adapter approved for use with this computer.
• Your AC/DC adapter may be designed for international travel but it still requires a steady, uninterrupted power supply. 

If you are unsure of your local power specifications, consult your service representative or local power company.
• The AC/DC adapter may have either a 2-prong or a 3-prong grounded plug. The third prong is an important safety fea-

ture; do not defeat its purpose. If you do not have access to a compatible outlet, have a qualified electrician install one.
• When you want to unplug the power cord, be sure to disconnect it by the plug head, not by its wire.
• Make sure the socket and any extension cord(s) you use can support the total current load of all the connected devices.
• Before cleaning the computer, make sure it is disconnected from any external power supplies.

Cleaning
Do not apply cleaner directly to the computer, use a soft clean cloth. Do not use volatile (petroleum distillates) or
abrasive cleaners on any part of the computer.

Power Safety Warning

Before you undertake any upgrade procedures, make sure that you have turned off the power, and disconnected all peripherals
and cables (including telephone lines). It is advisable to also remove your battery in order to prevent accidentally turning the ma-
chine on.

Power Off Before Traveling

Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a note-
book which is powered on in a travel bag may cause the vent(s) to be blocked. To prevent your computer from overheating make
sure nothing blocks the vent(s) while the computer is in use.
4 -  Instructions for Care and Operation
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Battery Precautions
• Only use batteries designed for this computer. The wrong battery type may explode, leak or damage the computer.
• Do not continue to use a battery that has been dropped, or that appears damaged (e.g. bent or twisted) in any way. 

Even if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may pos-
sibly result in fire.

• Recharge the batteries using the notebook’s system. Incorrect recharging may make the battery explode.
• Do not try to repair a battery pack. Refer any battery pack repair or replacement to your service representative or qual-

ified service personnel.
• Keep children away from, and promptly dispose of a damaged battery. Always dispose of batteries carefully. Batteries 

may explode or leak if exposed to fire, or improperly handled or discarded.
• Keep the battery away from metal appliances.
• Affix tape to the battery contacts before disposing of the battery.
• Do not touch the battery contacts with your hands or metal objects.

Battery Disposal & Caution

The product that you have purchased contains a rechargeable battery. The battery is recyclable. At the end of its useful life, under
various state and local laws, it may be illegal to dispose of this battery into the municipal waste stream. Check with your local solid
waste officials for details in your area for recycling options or proper disposal.

Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommended by the manu-
facturer. Discard used battery according to the manufacturer’s instructions.
Instructions for Care and Operation - 5
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System Startup
1. Remove all packing materials.
2. Place the computer on a stable surface.
3. Securely attach any peripherals you want to use with the notebook (e.g. keyboard and 

mouse) to their ports.
4. Attach the AC/DC adapter to the DC-In jack at the rear of the computer, then plug the AC 

power cord into an outlet, and connect the AC power cord to the AC/DC adapter.
5. Move the LCD latches at the front of the computer outwards towards the sides of the 

computer to release the top cover.
6. Raise the lid/LCD to a comfortable viewing angle, and press the power button.
7. Adjust the LCD panel to a comfortable viewing angle.

Model Differences
This notebook series includes two different design types, however only one design is pic-
tured in this manual.

Shutdown

Note that you should al-
ways shut your comput-
er down by choosing the
Shut Down command
from the Lock Button
Menu in Windows Vis-
ta. This will help prevent
hard disk or system
problems.

Figure 1 - AC/DC 
Adapter In
6 -  System Startup
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System Software
Your computer may already come with system software
pre-installed. Where this is not the case, or where you are
re-configuring your computer for a different system, you
will find this manual refers to the Microsoft Windows
Vista operating system. Further information on installing
the drivers and utilities is available in Chapters 4 & 7 of
the expanded User’s Manual on the Device Drivers &
Utilities + User’s Manual DVD-ROM.

Operating Systems Supported

*For information on the Windows XP OS see the Device
Drivers & Utilities + User’s Manual DVD-ROM.

Not Included
Operating Systems (e.g. Windows Vista/Windows XP)
and applications (e.g. word processing, spreadsheet and
database programs) have their own manuals, so please
consult the appropriate manuals. 

Drivers
If you are installing/re-installing new system software, you
will need to install the appropriate drivers. It is very important
that you install the drivers in the order listed in Table 5, on
page 21. 

Intel Turbo Memory Module
If you have included an Intel Turbo Memory (Robson) NAND
flash memory card module in your purchase option (see
page 33), then you will need to enable the option in the BIOS
BEFORE installing the Windows Vista operating system
software (do not enable this option in Windows XP or on a
Windows Vista operating system that has been installed
without the option enabled).

Operating System Note

*Windows XP (Home Edition or 
Professional)

Windows Vista (64-bit) Home 
Basic Edition

In order to run Win-
dows Vista without 

limitations or 
decreased perfor-

mance, your computer 
requires a minimum 

1GB of system mem-
ory (RAM).

Windows Vista (64-bit)
Home Premium/Business/Enter-

prise/Ultimate Editions
System Software - 7
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System Map: Front View with LCD Panel OpenFigure 2 
Front View with LCD 

Panel Open

1. Built-In PC Camera 
(optional)

2. LCD
3. Hot-Key Buttons
4. Power Button
5. Keyboard
6. TouchPad and Buttons
7. Fingerprint Reader 

Module (optional)
8. LED Indicators
9. Built-In Microphone

7

6

2

1

5

7 8

6

43

9

Wireless Device 
Operation Aboard 

Aircraft

The use of any portable
electronic transmission de-
vices (e.g. WLAN or Blue-
tooth) aboard aircraft is
usually prohibited. Make
sure the wireless mod-
ules (WLAN/Bluetooth)
are OFF if you are using
the computer aboard air-
craft.

Use the appropriate func-
tion key combination (see
Table 3, on page 11) to
toggle power to the wire-
less modules (WLAN/Blue-
tooth), and check the LED
indicator  to see if the
modules are powered on or
not (see Table 1, on
page 9).
8 -  System Map: Front View with LCD Panel Open
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LED Indicators
The LED indicators on the computer display helpful information about the current status of the computer.

Table 1 - LED Indicators

Icon Color Description Icon Color Description

Green The Computer is On Orange The Battery is Charging

Blinking
Green The Computer is In Sleep Mode Blinking 

Orange
The Battery has Reached Critically Low 
Power Status

Orange The AC/DC Adapter is Plugged In Green The Battery is Fully Charged

Green Number Lock (Numeric Keypad) is 
Activated Green Hard Disk Activity

Green Caps Lock is Activated Orange The Bluetooth Module is Powered On

Green Scroll Lock is Activated Green The WLAN Module is Powered On
LED Indicators - 9
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Hot-Key Buttons & Keyboard
The Hot-Key buttons give instant access to the default In-
ternet browser and e-mail program, and to a user-defined
application (see “Application Hot-Key Button” on
page 12), with one quick button press. 

Table 2 - Hot-Key Buttons

The keyboard includes a numeric keypad (on the right
side of the keyboard) for easy numeric data input. Press-
ing the Num Lk key turns on/off the numeric keypad. It
also features Function Keys to allow you to change oper-
ational features instantly.

Figure 3 - Keyboard

Hot-Key Button Function

Activate the Default E-Mail Browser

 Activate the Default Internet Program

Activate the user specified application 
e.g. Microsoft Word or Excel

Fn Key

Function Keys
Numeric 
KeypadNum Lk /Scr Lk Key

Special Characters

Some software applications allow the number-keys to be
used with Alt to produce special characters. These special
characters can only be produced by using the numeric key-
pad. Regular number keys (in the upper row of the key-
board) will not work. Make sure that the numeric keypad
(Num Lk) is on.
10 -  Hot-Key Buttons & Keyboard
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Function Keys & Visual Indicators
The function keys (F1 - F12 etc.) will act as hot keys when pressed while the Fn key is held down. In addition to the
basic function key combinations, visual indicators (see the table below) are available when the Hot-Key driver is in-
stalled. After installing the driver an icon  will appear in the taskbar.

Keys Function/Visual Indicators Keys Function/Visual Indicators

Fn + ~ Play/Pause (in Audio/Video Programs) Fn +
F8/F9

Brightness Decrease/
Increase

Fn + F1 TouchPad Toggle Fn + F10 PC Camera Module 
Power Toggle

Fn + F2 Turn LCD Backlight Off
(Press a key to or use TouchPad to turn on) Fn + F11 WLAN Module Power 

Toggle

Fn + F3 Mute Toggle Fn + F12 Bluetooth Module 
Power Toggle

Fn + F4  Sleep Toggle Fn + Scr 
Lk Scroll Lock Toggle

Fn +
F5/F6

Volume Decrease/
Increase Num Lk Number Lock (Numeric Keypad) Toggle

Fn + F7 Display Toggle Table 3 - Function Keys & Visual Indicators
Hot-Key Buttons & Keyboard - 11
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Application Hot-Key Button
To configure a program to open when the application
Hot-Key button  is pressed (Windows Media Player
is the default program), follow the instructions below.

1. Double-click the Hot-Key driver icon  in the taskbar.
2. Click Launch user specified application (button) .
3. An Open dialog box will appear on the screen.
4. Browse to the directory where the desired 

application.exe program exists (see below).
5. Double-Click on the program file or choose Open, and 

click OK (button).
6. Press the application Hot-Key button  to open the 

program (as long as the Hot-Key driver is running in 
the taskbar).

Figure 4 - Hot-Key Driver

Application.exe

You will need to locate the actual application executable
(.exe) file, not just the shortcut. To find the application
right-click its shortcut on the desktop and click Proper-
ties. Click the shortcut (tab) and see where the execut-
able file is located by clicking the Open File Location
(button).

Hot-Key Driver

If you click the Close icon , run the program from the file
location:
(C:\Program Files (x86)\Hotkey_Driver\HotkeyDriv-
er.exe).
12 -  Hot-Key Buttons & Keyboard
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System Map: Front & Rear Views Figure 5
Front & Rear Views

1. LCD Latches
2. Line-In Jack
3. Headphone-Out Jack
4. Microphone-In Jack
5. S/PDIF-Out Jack
6. LED Indicators
7. Infrared & Consumer 

Infrared Transceiver
8. Vent
9. S-Video-Out Jack
10. DVI-Out Port
11. 2 * USB 2.0 Ports
12. DC-In Jack
13. Serial Port

1 1

2 3 4 5
6
7

9 11 12 13
8 8

10

Front

Rear

Overheating

To prevent your computer from overheating make sure nothing blocks the vent while the com-
puter is in use.

USB Ports

Note that the connections to the USB ports only fit one way, do not force them.
System Map: Front & Rear Views - 13
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System Map: Right & Left ViewsFigure 6
Right & Left Views

1. ExpressCard/54(34) Slot
2. 7-in-1 Card Reader
3. 2 * USB 2.0 Ports
4. Mini-IEEE 1394 Port
5. RJ-11 Phone Jack
6. RJ-45 LAN Jack
7. Cable (CATV) Antenna 

Jack (Enabled With TV 
Tuner Only)

8. Speaker
9. Security Lock Slot
10. Optical Device Drive Bay 
11. Emergency Eject Hole

1
2 3 4

5 6 7
3 8

CD/DVD Emergency Eject

If you need to manually eject a CD/
DVD (e.g. due to an unexpected power
interruption) you may push the end of a
straightened paper clip into the emer-
gency eject hole. Do not use a sharp-
ened pencil or any object that may
break and become lodged in the hole.
Don’t try to remove a CD/DVD while the
system is accessing it. This may cause
the system to “crash”.

Mini-IEEE 1394 Port

The Mini-IEEE 1394 port only supports
SELF POWERED IEEE 1394 devices.

ExpressCard Slot

The ExpressCard slot accepts either Ex-
pressCard/34 or ExpressCard/54 for-
mats.

1098 11

Left

Right
14 -  System Map: Right & Left Views



Concise User’s Guide

English
System Map: Bottom View Figure 7
Bottom View

1. Vent
2. Battery
3. Optical Device 

Release Latches
4. Component Bay Cover
5. Infrared & Consumer 

Infrared Transceiver
6. Sub Woofer

1
2

3
4

5

Battery Information

Always completely discharge, then fully charge, a new battery before using it. Completely dis-
charge and charge the battery at least once every 30 days or after about 20 partial discharges.

1

6

1
1

1

3

CPU

The CPU is not a user ser-
viceable part. Accessing
the CPU in any way may
violate your warranty.

Overheating

To prevent your computer
from overheating make
sure nothing blocks the
vent while the computer is
in use.

1

System Map: Bottom View - 15
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Windows Vista Start Menu & Control Panel
Most of the control panels, utilities and programs within Windows Vista (and most other Windows versions) are ac-
cessed from the Start menu. When you install programs and utilities they will be installed on your hard disk drive,
and a shortcut will usually be placed in the Start menu and/or the desktop. You can customize the look of the Start
menu by right-clicking the Start menu and selecting Properties from the menu.

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control Panel
is accessed from the Start menu, and it allows you to configure the settings for most of the key features in Windows
(e.g. power, video, network, audio etc.). Windows Vista provides basic controls for many of the features, however
many new controls are added (or existing ones are enhanced) when you install the drivers provided. To see all controls
it may be necessary to toggle to Classic View on.

Figure 8 - Start Menu & Control Panel
Click here to toggle Classic View 
16 -  Windows Vista Start Menu & Control Panel
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Video Features
You can configure display options, from the Display Settings control panel in Windows as long as the appropriate
video driver is installed.

To access Display Settings in Windows:

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Adjust screen resolution under the Appearance and Personalization menu (or double-click Personalization > 

Display Settings).
3. Move the slider to the preferred setting in Resolution:  (Figure 9 on page 18).
4. Click the arrow, and scroll to the preferred setting in Colors:  (Figure 9 on page 18).
5. Click Advanced Settings (button)  (Figure 9 on page 18).
6. Click GeForce..... (tab).
7. Click Start the NVIDIA Control Panel  (Figure 9 on page 18) to access the control panel.
8. The NVIDIA Control Panel can also be accessed by right-clicking the desktop, and then clicking NVIDIA Control Panel.

1
2

3

4

Video Card Options

Note that card types, specifications and drivers are subject to continual updates and changes. Check with your service center for
the latest details on video cards supported.
Video Features - 17
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Display Devices & Options
Besides the built-in LCD, you can also use an external VGA monitor (CRT)/external Flat Panel Display (connect-
ed to the DVI-Out port) or TV (connected to the S-Video-Out jack) as your display device.

Figure 9 - Display Settings & NVIDIA Control Panel

Table 4 - Display Modes

Display Mode Description

Single One display device is used

Clone Both connected displays output the same view

Dualview Both connected displays are treated as separate devices, and act as a virtual desktop

1 2

3

4

18 -  Video Features
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Audio Features
You can configure the audio options on your computer from the Sound  control panel
in Windows, or from the Realtek HD Audio Manager /  icon in the taskbar/control
panel (right-click the taskbar icon  to bring up an audio menu). The volume may also
be adjusted by means of the Fn + F5/F6 key combination. 

Sound Volume 
Adjustment

The sound volume level is
set using the volume con-
trol within Windows (and
the volume function keys
on the computer). Click
the Volume icon in the
taskbar to check the set-
ting.

Figure 10
Realtek HD Audio 

Manager

Right-click the icon 
to access the menu 
above.
Audio Features - 19
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Power Management Features
The Power Options (Hardware and Sound menu) control panel icon in Windows (see page 16) allows you to con-
figure power management features for your computer. You can conserve power by means of power plans and con-
figure the options for the power button, sleep button, computer lid (when closed), display and sleep mode from
the left menu. Note that the Power saver plan may have an affect on computer performance.

Click to select one of the existing plans, or click Create a power plan in the left menu and select the options to create
a new plan. Click Change Plan Settings and click Change advanced power settings to access further configuration
options.

Figure 11 - Power Options

Note: Sleep is the default power saving state in Windows Vista
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Driver Installation
The Device Drivers & Utilities + User’s Manual DVD-
ROM contains the drivers and utilities necessary for the
proper operation of the computer. Insert the DVD-ROM
and click Install Drivers (button), or Optional (button)
to access the Optional driver menu.

Install the drivers in the order indicated in Table 5. Af-
ter installing each driver it will become grayed out (if you
need to reinstall any driver, click Unlock).

Manual Driver Installation
Click the Browse CD button in the Drivers Installer appli-
cation and browse to the executable file in the appropriate
driver folder.

Windows Update
After installing all the drivers make sure you enable
Window Update in order to get all the latest security up-
dates etc. (all updates will include the latest hotfixes
from Microsoft).

Table 5 - Driver Installation

Driver (Windows Vista) Page #

Chipset page 22

Video page 22

Audio page 22

Modem page 22

Card Reader/ExpressCard page 22

LAN page 22

TouchPad page 22

Hot-Key page 22

WLAN (optional) page 23

Bluetooth (optional) page 24

PC Camera (optional) page 25

Fingerprint Reader (optional) page 28

Consumer Infrared (optional) page 31

TV-Tuner (optional) page 31

Intel Turbo Memory (optional) page 33

Enable Windows Update (see left)
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Chipset
1. Click Install Drivers.
2. Click 1.Install Chipset Driver > Yes.
3. Click Next > Yes > Next > Next.
4. Click Finish to restart the computer.

Video
1. Click Install Drivers.
2. Click 2.Install Video Driver > Yes.
3. Click Next.
4. Click Finish to restart the computer.

Audio
1. Click Install Drivers.
2. Click 3.Install Audio Driver > Yes.
3. Click Next.
4. Click Finish to restart the computer.

Modem
1. Click Install Drivers.
2. Click 4.Install Modem Driver > Yes.
3. Click OK.
4. The modem is now ready for configuration.

Card Reader/ExpressCard
1. Click Install Drivers.
2. Click 5.Install CardReader Driver > Yes.
3. Click Next > Next.
4. Click Finish to restart the computer.

LAN
1. Click Install Drivers.
2. Click 6.Install LAN Driver > Yes.
3. Click Next > Install.
4. Click Finish.

TouchPad
1. Click Install Drivers.
2. Click 7.Install Touch Pad Driver > Yes.
3. Click Next > Next > Next.
4. Click Finish to restart the computer.

Hot-Key
1. Click Install Drivers.
2. Click 8.Install Hotkey Driver > Yes.
3. Click Next > Install.
4. Click Finish > Finish to restart your computer.
22 -  Driver Installation



Concise User’s Guide

English
Wireless LAN

Wireless LAN Driver Installation
1. Make sure the module is powered on.
2. Click Optional (button).
3. Click 1.Install Intel WLan driver > Yes.
4. Click Install Software.
5. Click the button to accept the license and click Next.
6. Click Next > OK.

Note: The operating system is the default setting for
Wireless LAN control in Windows Vista.

Connecting to a Wireless Network
Make sure the Wireless LAN module is turned on.

1. Click the taskbar wireless icon , and then click Connect 
to a network (or right-click the icon , and then click 
Connect to a network).

2. In the Show list, click to choose Wireless from the drop-
down menu.

3. A list of currently available networks will appear.
4. Click a network, and then click Connect.
5. If you do not see a network you want to connect to, click 

Set up a connection or network (a list of options will 
appear allowing manual searching, and creating a new 
network).

6. Move the cursor over the taskbar icon  to see the 
connection status.

7. To disconnect from the wireless network you can click the 
taskbar wireless icon , and then select Connect or 
disconnect to access the network menu, and click 
Disconnect (or right-click the icon , and then click 
Disconnect from).

Power Toggle for the Wireless LAN Module

Enable power to the Wireless LAN module by using the
Fn + F11 key combination. When the Wireless LAN mod-
ule is powered on, the  LED will be green and the indi-
cator  will briefly be displayed.
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Bluetooth

Bluetooth Driver Installation
1. Make sure the module is powered on.
2. Click Optional (button).
3. Click 2.Install BlueTooth driver > Yes.
4. Choose the language you prefer, and click OK > Next.
5. Click the button to accept the license agreement, and 

then click Next.
6. Click Next > Install.
7. Click Finish > Yes to restart the computer.
b

Bluetooth Local Area Connection
You can check the Bluetooth connection status from the
Network and Sharing Center:

1. Use the Fn + F12 key combination to turn on the Bluetooth 
module.

2. Run the IVT Corporation BlueSoleil program from the 
desktop icon or Start menu.

3. Click Start, and click Control Panel (or point to Settings 
and click Control Panel).

4. Double-click Network and Sharing Center (Network and 
Internet).

5. Click Manage network connections.
6. The Bluetooth connection status will then be displayed in 

the control panel.
7. To disconnect click File from the IVT Corporation 

BlueSoleil - Main Window, and select Exit (the Local 
Area Connection will then display “Network cable 
unplugged”).

8. Do not use the Close  button or Fn + F12 key 
combination before clicking File > Exit or the correct 
status will not be displayed.

9. You can then use the Fn + F12 key combination to turn off 
the Bluetooth module (check the LED icon for the 
Bluetooth module power status).

Power Toggle for the Bluetooth Module

Enable power to the Bluetooth module by using the Fn +
F12 key combination. When the Bluetooth module is pow-
ered on, the  LED will be orange and the indicator

 will briefly be displayed.
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PC Camera
There are 2 camera options available for this computer.
The 1.3M pixel camera module uses the BisonCap ap-
plication to capture video files. The 2.0M pixel camera
module uses the VideoView application to capture video
files.

PC Camera Driver Installation
For the 1.3M Pixel Camera Module:
1. Turn on the module using Fn + F10 (the indicator 

 will briefly be displayed when the module is 
powered on).

2. Click Optional (button).
3. Click 3.PC Camera, Web cam > Yes.
4. Choose the language you prefer and click Next > Next.
5. Click Finish to restart the computer.
6. Run the BisonCap application program from the 

BisonCam shortcut on the desktop, or from the 
BisonCam item in the Start > Programs/All 
Programs menu (if the hardware is turned off use the 
Fn + F10 key combination to turn it on again).

For the 2.0M Pixel Camera Module:
1. Turn on the module using Fn + F10 (the indicator 

 will briefly be displayed when the module is 
powered on).

2. Click Optional (button).
3. Click 3.PC Camera, Web cam > Yes.
4. Click Install.
5. Click to select Yes or No in answer to the power system 

question.
6. Click Finish > Finish to restart the computer.
7. Run the VideoView application program from the 

VideoView shortcut on the desktop, or from the 
USB2.0 PC Camera item in the Start > Programs/All 
Programs menu (if the hardware is turned off use the 
Fn + F10 key combination to turn it on again).
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PC Camera Audio Setup
If you wish to capture video & audio with your camera,
it is necessary to setup the audio recording options in
Windows.

1. Click Start, and click Control Panel (or point to Settings 
and click Control Panel).

2. Click Sound  (Hardware and Sound).
3. Click Recording (tab).
4. Right-click Microphone (Realtek High Definition Audio) 

and make sure the item is not disabled.
5. Double-click Microphone (or select Properties from the 

right-click menu).
6. Click Levels (tab), and adjust the Microphone and 

Microphone Boost sliders to the level required.
7. Click OK and close the control panels.
8. Run the BisonCap/VideoView program from the Start > 

Programs/All Programs > BisonCam/USB2.0 PC 
Camera menu.

9. Go to the Devices menu heading and select Microphone 
(Realtek....) (it should have a tick alongside it).

10. Go to the Capture menu heading and select Capture 
Audio (it should have a tick alongside it).

BisonCap/VideoView
The BisonCap (for 1.3M pixel camera) and VideoView
(for 2.0M pixel camera) applications are video viewers
useful for general purpose video viewing and testing, and
can capture video files to .avi format.

1. Run the BisonCap/VideoView program from the Start > 
Programs/All Programs > BisonCam/USB2.0 PC Cam-
era menu (it is recommended that you Set Capture File 
before the capture process - see “Set Capture File” 
below).

2. Go to the Capture menu heading (if you wish to capture 
audio check “PC Camera Audio Setup”) and select Start 
Capture.

3. Click OK (the file location will be displayed in the pop-up 
box) to start capturing the video, and press Esc to stop the 
capture (you can view the file using the Windows Media 
Player).

Set Capture File
Prior to capturing video files you may select the Set Cap-
ture File... option in the File menu, and set the file name
and location before capture (this will help avoid acciden-
tally overwriting files). Set the name and location then
click Open, then set the “Capture file size:” and click
OK. You can then start the capture process as above.
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Zoom
The BisonCap and VideoView programs allow you to
zoom the camera in and out.

For BisonCap:
1. Run the BisonCap program.
2. Go to Zoom and select ZoomOut/Zoom In.

For VideoView:
1. Run the VideoView program.
2. Go to Options and scroll down to select Setting (use the 

slider to adjust the zoom level, and click OK to save the 
setting).

Taking Still Pictures
The BisonCap and VideoView programs allow you to
take still pictures.

1. Run the BisonCap/VideoView program.
2. (BisonCap) Go to Options and select Take Picture.        

or
(VideoView) Go to Capture and select SnapShot.

3. The picture (in JPEG format) will be placed in the 
Snapshot folder  on the desktop (do not move or 
rename the folder).

Eliminating Screen Flicker
If you find that the video screen in the BisonCap/Video-
View program is flickering, you can try to adjust the set-
ting in the Video Capture Filter options.

For BisonCap:
1. Run the BisonCap program.
2. Go to Options and scroll down to select Video Capture 

Filter....
3. Click either 50Hz or 60Hz under Frequency in Property 

Page (tab).

For VideoView:
1. Run the VideoView program.
2. Go to Options and scroll down to select Video Capture 

Filter....
3. Click either 50Hz or 60Hz under Flickering Reduction in 

Image (tab).
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Fingerprint Reader Module
If you have included the fingerprint reader in your pur-
chase option you will need to install the driver as per the
instructions below. 

Make sure you have administrator’s rights to your com-
puter, and have a Windows password enabled for full se-
curity protection.

Before beginning the enrollment process it is recom-
mended that you go through the fingerprint tutorial. To
run the tutorial click Start > Programs/All Programs >
Protector Suite QL > Fingerprint Tutorial after in-
stalling the driver.

Fingerprint Driver Installation
1. Click Optional (button).
2. Click 4.Install FingerPrint Driver > Yes.
3. Click Software Installation.
4. Click Next > Next > Next.
5. Click Finish > Yes to restart the computer.

User Enrollment
1. Click Start > Programs/All Programs > Protector Suite 

QL > User Enrollment, or double click the taskbar icon 
.

2. On the first run of the program you will be asked to click 
the button to accept the license, and then click OK.

3. Click Next (“Enrollment to the hard disk” will 
automatically be selected), and click Finish.

Help & Manual

Right-click the taskbar icon  to bring up the menu to select Help.

Insert the Device Drivers & Utilities + User’s Manual DVD-ROM
and click Optional (button). Click Unlock (button) and then
click 4.Install FingerPrint Driver > Yes.

Click Documentation to open the folder containing the manual in
.pdf format.

To install the Adobe Acrobat Reader software to read the file,
insert the Device Drivers & Utilities + User’s Manual DVD-ROM
and click User’s Manual (button), and click Install Acrobat
Reader (button).
28 -  Fingerprint Reader Module



Concise User’s Guide

English
4. If you have not set a Windows password you will be 
prompted to do so (note: If you have not set a password 
Protector Suite QL cannot secure access to your 
computer).

5. Click Next and you will then be prompted to enter your 
Windows password.

6. Click Next > Next (if you have the “Run interactive 
tutorial” tickbox selected you will run through the 
Fingerprint Tutorial).

7. Click Next for each window of the tutorial (you can click 
the button to “skip tutorial” at any time).

8. Click the button above any of the fingers to begin the 
enrollment process for that finger.

9. Swipe the finger three times to enroll that finger.
10. Repeat the process for all the fingers you wish to enroll, 

and then click Next.
11. Click Finish.
12. Click any of the headings under “Learn more about:” to 

get more information on any topic.
13. Click Close.
14. Restart the computer.
15. Right-click the taskbar icon  to bring up the menu that 

allows you to Edit Fingerprints, Start Control Center, 
access the Help menu etc. You can also run the Control 
Center etc. from the Protector Suite QL item in the 
Programs/All Programs menu.

16. See “Help & Manual” on page 28 for further details.
17. If you swipe your finger over the reader at any time you 

can access the Biomenu to lock the computer, register 
websites, open the Control Center and access the Help 
menu.

18. The Control Center allows you to change the Settings, 
enroll Fingerprints and get Help.

Figure 12 -  Control Center & Biomenu

Fingerprint Enrollment

Note that it is strongly recommended that you enroll more
than one finger in case of injury etc.
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USB TV Tuner Module
A CD containing drivers, software and a user guide will be supplied if your purchase con-
figuration includes the optional USB TV Tuner module. In addition a driver is provided
on the Device Drivers & Utilities + User’s Manual DVD-ROM for the remote con-
trol supplied with the TV Tuner.

You will also be supplied with a remote control unit and appropriate antenna and fittings
for the USB TV Tuner module.

The optional TV Tuner allows you to watch TV, play music CDs, video conference and
capture still images and video on your PC.

The Cable (CATV) antenna jack will only be enabled when the TV Tuner module
is installed. Make sure you install the driver before connecting the TV antenna.

TV Antenna

The TV antenna supplied
with any TV Tuner mod-
ule is intended for indoor
use only. Please do not
use your TV Tuner mod-
ule outdoors.

TV Tuner Remote

Point the remote at the
consumer IR transceiv-
er to change channels
etc.

Figure 13
TV Tuner Ports/

Jacks
1. Infrared & Con-

sumer Infrared 
Transceiver

2. Cable (CATV) 
Antenna Jack

2

1

30 -  USB TV Tuner Module



Concise User’s Guide

English
Consumer Infrared Driver Installation
1. Click Optional (button).
2. Click 5.Install ITE CIR Driver > Yes.
3. Click Next > Yes > Next > Finish.

TV Tuner Driver Installation
1. Insert the TV Tuner Driver CD into the CD/DVD drive.
2. Click MC770A Driver V2.3.3.3 Setup for XP/Vista.
3. Click Install > OK.
4. Click S/W Encoder V1.0.70807 Setup for Vista to 

install the software encoder.
5. Click Next.
6. Click the button to accept the license agreement, and 

then click Next.
7. Click Next > Next > Next > Finish.
8. Click AP V2.0.1810.70802 Setup for XP/Vista to 

install the application.
9. Click Next.
10.Click the button to accept the license agreement, and 

then click Next.
11. Click Next (make sure you input a User and Company 

Name).
12.Type in the CD key provided, and then click Next.
13.Choose the language you prefer, and click Next.

14.Click Next > Next > Next.
15.Click the button to restart the computer, and then click 

Next.
16.Click Finish to restart the computer.
17.Run the Hybrid DTV application program from the 

DTVplayer shortcut on the desktop, or from the 
DTVplayer item in the Start > Programs/All 
Programs > Hybrid DTV menu.
or 

18.Run Windows Media Center directly from the Start 
menu (Start > Programs > Windows Media Center).

19.Windows Help and Support provides information on 
the Windows Media Center functions. Click Start  
and select Help and Support, and then type “Media 
Center” in the Search Help box and click the 
magnifying glass icon  to bring up the results.

Windows Media Center

Note that the Windows Media Center software comes
built-in to the Windows Vista Home Premium and Ulti-
mate Editions only.
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Digital TV Broadcast Signal
The antenna is the most crucial factor in receiving a clear
digital terrestrial TV broadcast signal. The passive an-
tenna provided should provide a clear signal when placed
beside a window. If the signal is not clear then you can
purchase an active antenna (it should also be placed be-
side a window) to improve the signal. You should also
check with any related government website which pro-
vides information on digital terrestrial TV coverage for
your area. Note that (unlike standard analog TV) if the
digital signal is weak then no picture will appear on the
TV at all.

TV Recording and Power Plans
If you intend to use the optional TV Tuner to record live
TV, then go to the Power Options control panel and cre-
ate a power plan to prevent the power saving options
from adjusting the computer’s performance level.

Remote Control Unit
The remote control unit allows you to remotely start and
send the system into a power saving state, to run Win-
dows Media Center and to navigate the Media Center
menus etc. The remote control unit also gives full control
over all TV and video functions.

CATV Cable Safety

Make sure that your CATV system installer has connected
the Coaxial cable shield to the grounding system of the
building, as close to the point of cable entry as practical.

This reminder is provided to call the CATV system install-
er’s attention to Article 820-93 of the NEC (Section 54,
Part I of the Canadian Electrical Code).
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Intel Turbo Memory Module
If you have included an Intel Turbo Memory (Robson) NAND flash memory card mod-
ule in your purchase option, then you will need to enable the option in the BIOS BE-
FORE installing the Windows Vista operating system software (do not enable this option
in Windows XP or on a Windows Vista operating system that has been installed without
the option enabled).

Intel Turbo Memory Technology (also known as Robson flash memory) is an Intel
technology that reduces the time it takes for a computer to boot up, to load applications,
and to write data to the hard drive. Intel Turbo Memory Technology is supported in Win-
dows Vista only (it also supports Windows Vista features such as ReadyBoost, Ready-
Drive, and Superfetch).

Intel Turbo Memory Setup and Driver Installation
1. Start-up your computer and press F2 to enter the BIOS.
2. Go to the Advanced menu.
3. Select Advanced Chipset Control and press Enter.
4. Press the spacebar to make sure that Intel Robson is Enabled.
5. Go to the Boot menu.
6. Set the CD/DVD-ROM Drive (make sure the Microsoft Windows Vista OS CD is 

inserted) as the first device in the boot order from the Boot priority order menu.
7. Select Exit Saving Changes from the Exit menu (or press F10 and Enter) and press 

Enter to exit the BIOS and reboot the computer.

ReadyBoost Issue

When the Intel® Turbo
Memory Console is
opened immediately after
powering on the system,
Windows ReadyBoost
may appear to be disabled.

This is expected behavior.
The status appears as dis-
abled while Microsoft gen-
erates the Windows
ReadyBoost file. Once the
file has been generated,
the status should appear as
Enabled again.

See the Intel website (ht-
tp://support.intel.com/
support/chipsets/itm/sb/
CS-025852.htm) for the
latest updated information
on this issue.
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8. As the computer starts up, press a key when you see the message "Press any key to boot from CD or DVD".
9. The system software will prompt you through the installation procedure (see the Microsoft Windows Vista OS 

documentation for more details).
10.Install the drivers as per the instructions in “Driver Installation” on page 21 (make sure the drivers are installed in the 

order indicated in Table 5, on page 21).
11. Insert the Device Drivers & Utilities + User’s Manual DVD-ROM into the CD/DVD drive.
12.Click Optional (button).
13.Click 6.Install Robson Driver > Yes.
14.Click Next > Yes > Next > Next.
15.Click Finish to restart the computer.
16.After restarting the computer click Restart Now to complete the installation procedure after the computer has made 

the necessary hardware changes.

Figure 14 - BIOS Advanced & Advanced Chipset Control Menus

F1 Help �� Select Item -/+ Change Values F9 Setup Defaults
Esc Exit �� Select Menu Enter Select �Sub-Menu F10 Save and Exit

Item Specific Help

Advanced

Phoenix TrustedCore(tm) Setup Utility

Intel Turbo Memory
Technology

Advanced Chipset Control

Intel Robson [Enabled]
SATA - Device 31, Function 2: [Enhanced]
AHCI Configuration Enabled]
DFOROM(Robson) Support: [Enabled]

Main Advanced Security Boot Exit

F1 Help �� Select Item -/+ Change Values F9 Setup Defaults
Esc Exit �� Select Menu Enter Select �Sub-Menu F10 Save and Exit

Item Specific Help

Advanced

Select options for
Advanced Chipset
features.

Phoenix TrustedCore(tm) Setup Utility

�Advanced Chipset Control
Reset Configuration Data: [No]
Local Bus IDE adapter: [Both]

Boot-time Diagnostic Screen: [Enabled]
Legacy USB Support: [Enabled]
USB 2.0 Enable: [Enabled]
POST Beep Sound [Disabled]
Battery Low Alarm Beep: [Disabled]
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Troubleshooting
Problem Possible Cause - Solution

The DVD regional codes 
can no longer be 
changed.

The code has been changed the maximum 5 times. DVD region detection is device dependent,
not OS-dependent. You can select your module’s region code 5 times. The fifth selection is
permanent. This cannot be altered even if you change your operating system or you use the
module in another computer.

The TouchPad doesn’t 
work.

The TouchPad has been disabled. Press the Touchpad toggle (Fn + F1) key combination (make
sure you have installed the Touchpad driver.

The Wireless LAN/
Bluetooth modules 
cannot be detected.

The modules are off. Check the appropriate LED indicator  to see if the modules are on or off
(see “LED Indicators” on page 9). If the LED indicator is off, then press the appropriate function
key combination in order to enable the modules (see “Function Keys & Visual Indicators” on
page 11).

The PC Camera 
software displays a black 
screen when the PC 
Camera software is run.

The software is using the incorrect device. If you have both an optional PC Camera and an
optional TV Tuner module present, you will need to select which device to use with the
BisonCap/VideoView program. Go to the Devices menu in the BisonCap/VideoView program
and select the BisonCam, NB Pro/USB2.0 2M WebCam device (PC Camera).

The captured video files 
from the PC Camera are 
taking up too much disk 
space.

Note that capturing high resolution video files requires a substantial amount of disk space for
each file.

Note that the Windows Vista system requires a minimum of 15GB of free space on the C: drive
system partition. It is recommended that you save the capture video file to a location other than
the C:drive, limit the file size of the captured video or reduce video resolution (Options > Video
Capture Pin... > Output Size).
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Screen Resolution Error
If you are experiencing either screen resolution reduction, or screen flickering after resuming from Sleep in Win-
dows Vista only then follow the instructions below to fix this problem. This error arises in compliance with Windows
Vista policy, which triggers TMM (Transient Multimon Manager) when the notebook lid (S3) is closed. TMM dis-
connects the LCD display from the OS and then adds the LCD display back when the lid is opened. This may trigger
TMM to restore an old display setting which may result in screen flickering or a screen resolution change.

1. Go to the Control Panel in the Windows OS and double-click the Administrative Tools icon (System and Maintenance).
2. Double-click Task Scheduler (Schedule Tasks)
3. Double-click Task Scheduler Library > Microsoft > Windows, and click MobilePC to open the control panel.
4. Right-click TMM and select Disable, and then close all the control panels.

Figure 15 - Control Panel System and Maintenance
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Specifications

Feature Specification

Processor Types Intel® Core™2 Duo Processor
(478-pin) Micro-FC-PGA Package, Socket P
T7100

65nm (65 Nanometer) Process Technology
2MB On-die L2 Cache & 800MHz FSB
1.80 GHz

Intel® Core™2 Duo Processor
(478-pin) Micro-FC-PGA Package, Socket P
T7300/ T7500/ T7700

65nm (65 Nanometer) Process Technology
4MB On-die L2 Cache & 800MHz FSB
2.0/ 2.2/ 2.4 GHz

Core Logic Intel(R) PM965 + ICH8M Chipset

Memory Two 200 Pin SO-DIMM Sockets Supporting DDRII (DDR2) 533 / 667 MHz
Memory Expandable up to 4GB

Security Security (Kensington® Type) Lock Slot
Fingerprint Reader Module (Factory Option) 

BIOS Password

BIOS One 8Mb Flash ROM Phoenix™ BIOS

Latest Specification Information

The specifications listed in this Appendix are correct at the time of going to press. Certain items (particularly processor types/
speeds and CD/DVD device types) may be changed, updated or delayed due to the manufacturer's release schedule. Check with
your service center for details.
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LCD Options 17" WXGA (1280 * 800) TFT LCD (Glare Type)
17" WXGA (1280 * 800) TFT LCD (Non Glare 
Type)

17" WSXGA+ (1600 * 1050) TFT LCD (Glare 
Type)
17" WUXGA (1920 * 1200) TFT LCD (Glare Type)

Video Card 
Options

NVIDIA GeForce Go 7950 GTX PCI-E Video 
Card
MXM-IV
512MB GDDR3 Video RAM On Board
MS DirectX® 9.0 Compatible

NVIDIA GeForce 8700M GT PCI-E Video Card
MXM-III
512MB GDDR3 Video RAM On Board
MS DirectX® 10.0 Compatible
Supports HDCP

NVIDIA GeForce 8800M GTX PCI-E Video Card
MXM-IV
512MB GDDR3 Video RAM On Board
MS DirectX® 10.0 Compatible
Supports HDCP

Storage One Changeable 12.7mm(h) Optical Device (CD/DVD) Type Drive (see “Optional” on page 40 for 
drive options)
Easy Changeable 2.5" 9.5 mm (h) SATA HDD

Card Reader Embedded 7-in-1 Card Reader (MS/ MS Pro/ SD/ Mini SD/ MMC/ RS MMC/ MS Duo)
Note: MS Duo/ Mini SD/ RS MMC Cards Require a PC Adapter

Feature Specification

Video Card Options

Note that card types, specifications and drivers are
subject to continual updates and changes. Check with
your service center for the latest details on video cards
supported.
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Audio Intel High Definition Audio Compliant Interface
3D Stereo Enhanced Sound System

 SRS WOW Surround Sound Technology 
Inside
Sound-Blaster PRO™ Compatible

S/PDIF Digital Output 
Built-In Microphone
2 * Built-In Speakers (1.5W, 8Ω)
One Sub Woofer (2W, 8Ω)

Keyboard & 
Pointing Device

Full Size Winkey Keyboard with Numeric Keypad Built-In TouchPad (Scroll Functionality Included)

ExpressCard Slot ExpressCard/54(34) Slot

Interface Four USB 2.0 Ports
One DVI-Out Port
One Headphone/Speaker-Out Jack
One Microphone-In Jack
One S/PDIF Out Jack
One Line-In Jack for Audio Input
One Serial Port
One Mini-IEEE1394 Port
One Infrared Transceiver
One RJ-11 Modem Jack
One RJ-45 Giga LAN Jack

One DC-In Jack
One S-Video-Out Jack for TV & HDTV Output
One Cable (CATV) Antenna (Analog/Digital) Jack 
(Functions with Optional TV Tuner Module)
One Consumer Infrared Transceiver 
(Functions with Optional TV Tuner Module)

One Mini Card Slot for TV Tuner or Intel Turbo 
Memory Module
One Mini Card Slot for WLAN only

Power 
Management

Supports ACPI 3.0

Feature Specification
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Communication Built-In 56K MDC Modem with V.90 & V.92 
Compliant
Built-In Gigabit Ethernet LAN
Intel Wireless WiFi Link 4965AGN PCIe Wireless 
LAN Module (Option)
USB TV Tuner Module (Option)

Bluetooth 2.0 + EDR (Enhanced Data Rate) 
Module (Factory Option)
1.3M or 2.0M Pixel USB PC Camera Module 
(Factory Option)

Power Full Range AC/DC Adapter – AC in 100 - 240V, 50 - 60Hz, DC Output 20V, 6.0A (120 Watts)
Easy Changeable 8-Cell Smart Lithium-Ion 4400mAH Battery

Environmental 
Spec

Temperature
Operating: 5°C - 35°C
Non-Operating: -20°C - 60°C

Relative Humidity
Operating: 20% - 80%
Non-Operating: 10% - 90%

Physical 
Dimensions & 
Weight

397mm (w) * 284mm (d) * 22 - 44mm (h) Around 3.95kg (+/- 5%) with 8 Cell Battery

Optional Optical Drive Module Options:
DVD/CD-RW Combo Drive Module
DVD-Super Multi Drive Module

Intel Wireless WiFi Link 4965AGN PCIe Wireless 
LAN Module
USB TV Tuner Module
Intel Turbo Memory (Robson) NAND Flash 
Memory Card Module

(Factory Option) Bluetooth 2.0 + EDR (Enhanced 
Data Rate) Module 
(Factory Option)1.3M or 2.0M Pixel USB PC 
Camera Module 
(Factory Option) Fingerprint Reader Module 

Feature Specification
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Hinweis
Das Unternehmen behält sich das Recht vor, diese Publikation ohne Vorankündigung zu überarbeiten und den Inhalt zu
verändern.  Alle enthaltenen Informationen sind nur Anhaltspunkte und stellen keine Verpflichtung seitens des Herstellers
oder Wiederverkäufers dar. Sie übernehmen weder Verantwortung oder Haftung für mögliche Fehler oder Ungenauigkei-
ten dieser Publikation  noch sind sie in irgendeiner Weise verantwortlich für Verluste oder Schäden aus der Nutzung (oder
fehlerhaften Nutzung) dieser Publikation.
Die Publikation und alle beiliegende Software darf nicht, ganz oder in Teilen, ohne vorheriges Einverständnis des Verkäu-
fers, Herstellers oder Autors dier Publikation reproduziert, übersetzt, übertragen oder in maschinenlesbare Form umgewan-
delt werden, abgesehen von Kopien, die für Archivzwecke erstellt werden.
In dier Publikation erwähnte Marken- und Produktnamen können Copyrights und/oder eingetragene Warenzeichen ihrer
jeweiligen Firmen in. Sie werden nur zu Identifikationszwecken erwähnt und sind nicht als Werbung für die Produkte oder
ihre Hersteller gedacht.

© November 2007

Warenzeichen
Dies Produkt beinhaltet durch Urheberrechte geschützte Technologie, die durch Ansprüche bestimmter US-Patente und an-
dere geistige Eigentumsrechte geschützt ist, welche der Macrovision Corporation und anderen Rechtsbesitzern gehört. Die
Verwendung dier durch Urheberrechte geschützten Technologie muß von der Macrovision Corporation genehmigt werden
und dient nur für den Heimgebrauch bzw. andere beschränkte Ansichtszwecke, wenn nicht anderweitig von der Macrovi-
sion Corporation genehmigt. Reverse Engineering oder Auseinandernehmen ist untersagt.

Intel und Intel Core sind warenzeichen/eingetragenes warenzeichen der Intel Corporation.
ist ein Warenzeichen der SRS Labs, Inc. 

Die WOW-Technologie wird verwendet unter der Lizenz der SRS Labs, Inc.
Hinweis - 41
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Über das Ausführliche Benutzerhandbuch
Diese Kurzanleitung soll einen Überblick über die Schritte geben, die dazu notwendig sind, das System zu starten. Dieses
ist nur eine Ergänzung und kein Ersatz für das erweiterte englischsprachige Benutzerhandbuch, das auf der mitgelieferten
DVD-ROM Device Drivers & Utilities + User's Manual im Adobe-Acrobat-Format vorliegt. Diese DVD-ROM enthält
auch die Treiber und Utility-Programme, die für einen einwandfreien Betrieb des Notebooks notwendig sind. 

Einige oder alle Funktionen des Notebooks sind bereits eingerichtet worden. Falls das nicht der Fall ist oder wenn Sie ein-
zelne Teile des Systems neu konfigurieren (oder neu installieren) möchten, finden Sie eine Anleitung im erweiterten Be-
nutzerhandbuch. Die DVD-ROM Device Drivers & Utilities + User's Manual enthält nicht das Betriebssystem.

Informationen zu gesetzlichen Vorschriften
Die Informationen zu gesetzlichen Vorschriften finden Sie im erweiterten Benutzerhandbuch auf der DVD-ROM Device
Drivers & Utilities + User's Manual.

Betrieb von Wireless-Geraten in Flugzeugen

In der Regel ist die Benutzung jeglicher tragbarer elektronischer Funkgeräte in Flugzeugen verboten. Achten Sie darauf,
daß die Wireless-Module AUSGESCHALTET sind, wenn Sie das Notebook im Flugzeug benutzen.
42 -  Über das Ausführliche Benutzerhandbuch
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Hinweise zu Pflege und Betrieb
Das Notebook ist zwar sehr stabil, kann aber dennoch beschädigt werden. Damit es nicht dazu kommt, sollten Sie die fol-
genden Hinweise beachten:

• Das Gerät darf nicht herunterfallen und in anderer Form Stößen ausgesetzt werden. Wenn der Computer fällt, können das Gehäuse 
und andere Komponenten beschädigt werden.

• Halten Sie den Computer trocken, Das Gerät darf nichtüberhitzt werden. Computer und Netzteil dürfen nicht in der Nähe von Wär-
mequellen stehen oder gelagert werden. Dies ist ein elektrisches Gerät. Wenn Wasser oder andere Flüssigkeiten eindringen, kann der Com-
puter stark beschädigt werden.

• Vermeiden Sie Interferenzen mit anderen Geräten. Halten Sie den Computer fern von magnetischen Feldern, die von Stromquellen, 
Monitoren, Magneten etc. erzeugt werden. Die können die Leistung beeinträchtigen und Ihre Daten beschädigen.

• Achten Sie auf die richtige Bedienung des Computers. Schalten Sie ihn erst aus,  wenn alle Programme geschlossen wurden (speichern 
Sie Ihre Daten!). Speichern Sie regelmäßig Ihre Daten, da diese verloren gehen können, wenn der Akku verbraucht ist.

• Seien Sie vorsichtig bei der Verwendung von Peripheriegeräten.

Reparatur
Reparieren Sie das Gerät nicht selbst.  Damit verstoßen Sie gegen die Garantiebedingungen und Sie können Schäden am
Gerät und an der eigenen Gesundheit verursachen. Überlassen Sie alle Reparaturen autorisiertem Fachpersonal.  Trennen
Sie das Notebook vom Stromnetz.  Unter den folgenden Umständen sollten Sie das Gerät zur Reparatur geben:
• Wenn das Netzkabel oder der AC/DC-Adapter beschädigt oder zerschlissen sind.
• Wenn der Computer Regen ausgesetzt war oder mit Flüssigkeiten in Berührung gekommen ist.
• Wenn der Computer unter Beachtung der Bedienungsanweisungen nicht korrekt arbeitet.
• Wenn der Computer heruntergefallen ist oder beschädigt wurde (berühren Sie nicht die giftige Flüssigkeit des LCD-Bildschirms).
• Wenn ein ungewöhnlicher Geruch, Hitze oder Rauch aus dem Computer entweicht.
Hinweise zu Pflege und Betrieb - 43
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Stromsicherheit
Für dieses Computer  werden bestimmte Stromanforderungen gestellt: 
• Verwenden Sie nur einen AC/DC-Adapter, der für die Verwendung mit diesem Computer zugelassen ist. 
• Der AC/DC-Adapter kann zwar für internationale Benutzung vorgesehen sein, benötigt aber trotzdem eine gleichmäßige, ununterbrochene 

Stromversorgung. Wenn Sie sich über Ihre lokalen Stromspezifikationen nicht im klaren sind, wenden Sie sich an Ihren Servicevertreter 
oder Ihre lokale Stromgellschaft.

• Der AC/DC-Adapter kann einen zwei- oder dreipoligen geerdeten Netzstecker haben.  Der dritte Pol hat eine wichtige Sicherheitsfunktion. 
Setzen Sie die nicht außer Kraft. Wenn Sie keinen Zugang zu einer passenden Steckdose haben, lassen Sie von einem qualifizierten Elektri-
ker eine solche einbauen. 

• Fassen Sie das Netzkabel am Stecker und nicht am Kabel an, wenn Sie es vom Stromnetz trennen möchten. 
• Achten Sie darauf, daß die Steckdose und alle verwendeten Verlängerungskabel die Gesamtstromlast aller angeschlossenen Geräte trägt.
• Trennen Sie den Computer vor dem Reinigen von allen externen Stromquellen.

Reinigung
• Tragen Sie Reinigungsmittel nicht direkt auf das Computer auf. Reinigen Sie es mit einem weichen, sauberen Tuch. 
• Verwenden Sie keine flüchtigen Reinigungsmittel (Petroleumdestillate) oder Scheuermittel zum Reinigen des Computers.

Warnung zur Stromsicherheit

Bevor Sie Schritte zum Aufrüsten des Computers unternehmen, müssen Sie zunächst das Gerät ausschalten und alle Peripheriegeräte
und Kabel (einschließlich Telefonkabel) abtrennen. Sie sollten auch den Akku herausnehmen, damit das Gerät nicht versehentlich ein-
geschaltet werden kann.

Vor dem Transport in einer Tasche ausschalten

Achten Sie darauf, dass Ihr Notebook ausgeschaltet ist, wenn Sie es fur den Transport z.B. wahrend einer Reise in eine Tasche einpak-
ken. In einer Tasche kann/konnen die Luftungsoffnung(en) verdeckt werden. Wenn das Gerat dann noch eingeschaltet ist, kann es uber-
hitzt werden. Damit das eingeschaltete Notebook nicht uberhitzt wird, stellen Sie sicher, dass die Luftungsoffnung(en) immer frei sind.
44 -  Hinweise zu Pflege und Betrieb
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Sicherheitshinweise zum Akku
• Verwenden Sie nur Akkus, die für diesen Computer entwickelt wurden. Ein falscher Akku-Typ kann explodieren, auslaufen oder den Com-

puter beschädigen.
• Verwenden Sie den Akku nicht mehr, wenn er heruntergefallen ist oder in anderer Weise beschädigt (z.B. verzogen) ist. Auch wenn das 

Notebook mit dem beschädigten Akku zu funktionieren schein, können dadurch Stromkreise beschädigt werden, die schließlich einen 
Brand verursachen können.

• Laden Sie die Akkus über das Notebook auf. Durch falsches Laden kann der Akku explodieren.
• Versuchen Sie nicht, Akkus zu reparieren. Lassen Sie die Akkupacks durch den Servicevertreter oder qualifiziertes Fachpersonal reparieren 

oder austauschen.
• Halten Sie Kinder vom Akku fern und entsorgen Sie beschädigte Akkus sofort. Seien Sie vorsichtig bei der Entsorgung der Akkus. Akkus 

können explodieren oder auslaufen, wenn sie Feuer ausgesetzt sind oder unsachgemäß behandelt oder entsorgt werden.
• Halten Sie den Akku von Metallgeräten fern.
• Bringen Sie Klebeband auf den Akkukontakten an, bevor Sie den Akku entsorgen.
• Berühren Sie die Akkukontakte nicht mit Ihren Händen oder mit metallenen Gegenständen.

Entsorgen der Akkus/Batterien & Achtung

Das von Ihnen gekaufte Produkt enthält einen aufladbaren Akku. Dier Akku ist wiederverwertbar. Nach verschiedenen nationalen
und regionalen Getzgebungen kann es verboten in, einen nicht mehr gebrauchsfähigen Akku in den normalen Hausmüll zu wer-
fen. Informieren Sie sich bei Ihrem regionalen Entsorgungsunternehmen über Recycling-Möglichkeiten oder korrekte Entsorgung.

Wenn ein falscher Akku eingesetzt wird, besteht Explosionsgefahr. Tauschen Sie den Akku nur durch den gleichen oder einen
baugleichen  Typ aus, der vom Hersteller empfohlen wird. Entsorgen Sie den verbrauchten Akku entsprechend der Anweisungen
des Herstellers.
Hinweise zu Pflege und Betrieb - 45
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Schnellstart
1. Entfernen Sie das gesamte Verpackungsmaterial.
2. Legen Sie das Notebook auf eine stabile Unterlage.
3. Schließen Sie alle Peripheriegeräte, die Sie mit dem Notebook verwenden wollen (z. B. 

Tastatur und Maus), an die entsprechenden Schnittstellen an.
4. Schließen Sie den AC/DC-Adapter an die DC-Eingangsbuchse an der Rückseite des 

Notebooks an. Verbinden Sie dann das Netzkabel mit einer Netzsteckdose und dem AC/DC-
Adapter.

5. Schieben Sie die LCD-Riegel vorne am Notebook nach außen und heben Sie dabei den 
Deckel an.

6. Heben Sie den Deckel/Bildschirm in einen komfortablen Sichtwinkel. Drücken Sie dann auf 
den Netzschalter, um das Gerät einzuschalten.

Modellunterschiede
Diese Notebook-Serie umfasst zwei verschiedene Designausführungen, Wobei in diesem
Benutzerhandbuch nur eine Designausführung abgebildet wird.

Herunterfahren

Bitte beachten Sie, daß der
Computer immer mit dem
Befehl Herunterfahren in
das Menü der Schaltfläche
Sperren in Windows Vista
heruntergefahren werden
muß. Dadurch werden
Festplatten- bzw. System-
probleme vermieden. 

Abb.  1
Angeschlossener 
AC/DC-Adapter
46 -  Schnellstart
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Systemsoftware
Möglicherweise wurde das Notebook bereits mit vorinstal-
lierter Software ausgeliefert. Ist das nicht der Fall, oder
wenn Sie das Notebook für ein anderes System neu konfi-
gurieren möchten, finden Sie dazu eine Anleitung in diesem
Handbuch zum Betriebssystem Microsoft Windows Vista.
Weitere Informationen zur Installation der Treiber und
Hilfsprogramme finden Sie in den Kapiteln 4 und 7 des er-
weiterten Benutzerhandbuchs auf der DVD-ROM Device
Drivers & Utilities + User's Manual.

Unterstützte Betriebssysteme

*Informationen zum Betriebssystem Windows XP finden
Sie auf der DVD-ROM Device Drivers & Utilities + User’s
Manual.

Nicht enthalten
Zu den Betriebssystemen (z.B.  Windows Vista/Windows
XP) und zu den Programmen (z.B. Textverarbeitung, Kal-
kulationsprogramme und Datenbanken) gibt es eigene
Handbücher, in denen Sie entsprechende Informationen fin-
den. 

Treiber

Wenn Sie eine neue Systemsoftware installieren oder erneut in-
stallieren, müssen Sie die geeigneten Treiber installieren. Es ist
sehr wichtig, dass Sie die Treiber in der in Tabelle 5 auf
Seite 61 angegebenen Reihenfolge installieren. 

Intel Turbo Memory-Modul

Wenn Ihr Modell über ein Intel Turbo Memory (Robson) NAND-
Speicherkartenmodul verfügt, müssen Sie die Option im BIOS
aktivieren, BEVOR Sie das Windows Vista-Betriebssystem in-
stallieren (aktivieren Sie diese Option nicht bei Windows XP
oder Windows Vista, wenn das Betriebssystem ohne aktivierte
Option installiert wurde). Siehe Seite 73.

Betriebssystem Anmerkung

*Windows XP (Home Edition 
oder Professional)

Windows Vista (64-bit) Home 
Basic Edition

Windows Vista kann nur 
dann mit voller Leistung 

laufen, wenn der Compu-
ter über einen Systemspei-

cher (RAM) von 
mindestens 1GB verfügt.

Windows Vista (64-bit)
 Home Premium Edition/Busi-

ness Edition/Enterprise Edition/
Ultimate Edition
Systemsoftware - 47
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Systemübersicht: Ansicht von oben mit geöffne-
tem LCD-Bildschirm

Abb. 2 
Ansicht von oben  mit 
geöffnetem LCD-Bild-

schirm

1. PC-Kamera (optional)
2. LCD-Bildschirm
3. Hot-Key-Tasten
4. Netzschalter
5. Tastatur
6. TouchPad mit Tasten
7. Fingerabdruckleser 

(optional) 
8. LED-Strom- und -

Kommunikationsan-
zeigen

9. Mikrofon

7

6

2

1

5

7 8

6

43

9

Die Benutzung drahtlos 
angeschlossener Geräte in 

Flugzeugen

In der Regel ist die Benutzung
jeglicher tragbarer elektroni-
scher Funkgeräte in Flugzeugen
verboten.   Achten Sie darauf,
daß die Module (WLAN/Blue-
tooth) AUSGESCHALTET
sind, wenn Sie das Notebook
im Flugzeug benutzen.

Drücken Sie die entsprechenden
Tastenkombinationen (siehe
Tabelle 3 auf Seite 51), um das
WLAN- und das Bluetooth-Mo-
dul ein- und auszuschalten. Prü-
fen Sie die Statusanzeige ,
um festzustellen, ob die Module
ein- oder ausgeschaltet sind
(siehe Tabelle 1 auf Seite 49).
48 -  Systemübersicht: Ansicht von oben mit geöffnetem LCD-Bildschirm
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LED-Anzeigen
Die LED-Anzeigen auf dem Computer zeigen wichtige Informationen über den aktuellen Status des Computers.

Tabelle 1 - LED-Anzeigen

Symbol Farbe Beschreibung Symbol Farbe Beschreibung

Grün Der Computer ist ange-
schaltet Orange Der Akku wird geladen

Lampe blinkt 
grün

Das System ist im konfigu-
rierten Energiesparmo-
dus 

Lampe blinkt 
orange

Der Akku hat einen kritisch niedrigen 
Stromstatus erreicht

Orange Der AC/DC-Adapter ist 
angeschlossen Grün Der Akku ist voll geladen

Grün
Die Funktion NumLk 
(Nummerntastatur) ist akti-
viert

Grün Es wird auf die Festplatte zugegriffen

Grün Caps-Lock ist aktiviert Orange Das Bluetooth-Modul ist eingeschaltet

Grün Scroll-Lock ist aktiviert Grün Das Wireless LAN-Modul ist einge-
schaltet
LED-Anzeigen - 49
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Hot-Key-Tasten & Tastatur
Mit den Hot-Key-Tasten haben Sie einen direkten Zugriff
auf den Standard-Internetbrowser und das E-Mail-Pro-
gramm, und ein benutzerdefiniertes Anwendungspro-
gramm (siehe “Programm-Hot-Key-Taste” auf Seite 52).

Tabelle 2 - Hot-Key-Tasten

Die Tastatur umfasst eine Nummerntastatur (an der rechten
Seite der Tastatur) für die Eingabe von Zahlen. Durch
Drücken auf Num wird die Nummerntastatur ein- und aus-
geschaltet. Zusätzlich gibt es Funktionstasten, über die Sie
direkt zwischen den Funktionen umschalten können.

Abb. 3  - Tastatur 

Hot-Key-Taste Funktion

Ein vom Benutzer zugewiesenes Pro-
gramm (z.B. Microsoft Word oder Excel) 

Das Standard-E-Mail-Programm aktivie-
ren

Einen Standard-Internet browser aktivie-
ren

Fn Taste

Nummemtastatur

Funktionstasten

Num/Rollen Taste

Sonderzeichen

Bei einigen Programmen können die Nummern-Tasten zur Er-
zeugung von Sonderzeichen zusammen mit der Taste Alt ge-
drückt werden. Diese Sonderzeichen können nur mit der
Nummerntastatur erzeugt werden. Die normalen Zahlentasten
(in der oberen Tastenreihe der Tastatur)  können dazu nicht
verwendet werden. Die Funktion Num muß aktiviert sein.
50 -  Hot-Key-Tasten & Tastatur
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Funktionstasten und visuelle Anzeigen
Wenn die Funktionstasten (F1 - F12) gleichzeitig mit der Fn-Taste gedrückt werden, funktionieren sie wie Hotkeys. Ne-
ben den Tastenkombinationen für die Grundfunktionen gibt es visuelle Anzeigen, wenn der Hot-Key-Treiber (HotKey
Driver) installiert ist (siehe “Hot-Key” auf Seite 62). Wenn der Treiber installiert ist, erscheint in der Taskleiste das Sym-
bol .

Tasten Funktion/Visuelle Anzeigen Tasten Funktion/Visuelle Anzeigen

Fn + ~ Wiedergabe/Pause (in Audio /Videoprogrammen) Fn + F8/F9 LCD-Helligkeit ver-
ringern/erhöhen

Fn + F1 TouchPad aktivieren/
deaktivieren Fn + F10 PC-Kamera aktivie-

ren/deaktivieren

Fn + F2 
LCD-Hintergrundlicht ausschalten 
(zum Einschalten beliebige Taste drücken oder Touch-
Pad berühren)

Fn + F11 Wireless-LAN akti-
vieren/deaktivieren

Fn + F3 Stummschaltung/Stumm-
schaltung aufheben Fn + F12 Bluetooth aktivieren/

deaktivieren

Fn + F4 Wechsel Schlaf/Wiederaufnahme Num Ein-/Ausschalten des NumLk (Nummerntasta-
tur)

Fn + F5/
F6 

Audio-Lautstärke verrin-
gern/erhöhen

Fn +
Rollen Ein-/Ausschalten des Scroll-Modus

Fn + F7 Wechseln der Anzeigegerate Tabelle 3 - Funktionstasten & visuelle Anzeigen
Hot-Key-Tasten & Tastatur - 51
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Programm-Hot-Key-Taste
Sie können die Programm-Hot-Key-Taste  so konfigu-
rieren, dass beim Drücken dieser Taste ein bestimmtes Pro-
gramm (das Standardprogramm ist Windows Media
Player) gestartet wird. Führen Sie zum Konfigurieren die
folgenden Schritte aus.

1. Klicken Sie doppelt auf das Hot-Key-Treiber-Symbol  
in der Taskleiste.

2. Klicken Sie auf  Launch user specified application .
3. Ein Dialogfeld Öffnen erscheint auf dem Bildschirm. 
4. Wechseln Sie zum Verzeichnis, in dem sich das 

gewünschte .exe-Datei des Programms befindet (siehe 
unten).  

5. Klicken Sie doppelt  auf die Programmdatei oder wählen 
Sie Öffnen, und klicken Sie auf OK.

6. Drücken Sie auf die Programm-Hot-Key-Taste , um 
das Programm zu starten (während der Hot-Key-Treiber in 
der Taskleiste läuft).

Abb. 4 - Hot-Key-Treiber

Application.exe

Sie müssen die eigentliche ausführbare (.exe) Programmda-
tei angeben, nicht nur die Verknüpfung. Um das Programm
zu finden, klicken Sie mit der rechten Maustaste auf die Ver-
knüpfung auf dem Desktop und klicken auf Eigenschaften.
Klicken Sie auf Verknüpfung (Registerkarte) und suchen das
Verzeichnis, in dem sich die ausführbare Datei befindet, in-
dem Sie auf Dateipfad öffnen (Schaltfläche) klicken.

Hot-Key-Treiber

Wenn Sie auf das Schließen-Symbol  klicken, starten Sie
die Datei aus dem Verzeichnis:
(C:\Program Files (x86)\Hotkey_Driver\Hotkey-
Driver.exe).
52 -  Hot-Key-Tasten & Tastatur
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Systemübersicht: Ansicht von vorne und Rückan-
sicht

Abb. 5 
 Ansicht von vorne 
und Rückansicht

1. LCD-Riegel
2. Line-Eingangsbuchse
3. Kopfhörer-Ausgangs-

buchse
4. Mikrofon-Eingangs-

buchse
5. S/PDIF-Ausgangs-

buchse
6. LED-Strom- und -Kom-

munikationsanzeigen
7. Infrarot-Empfänger/

CIR-Empfänger
8. Luftungsoffnung
9. S-Video-Ausgangs-

buchse
10. DVI-Ausgangsan-

schluss
11. 2 USB 2.0 Anschlüsse
12. DC-Eingangsbuchse
13. Serielle Schnittstelle

1 1

2 3 4 5
6

8
9

7

Vorderseite

Rückseite

8
10 11 12 13

Überhitzung

ZZum Schutz vor Überhitzung Ihres Computers dürfen die Luftungsoffnung(en) nicht während das
Notebook in Betrieb ist verdeckt werden.

USB Anschlüsse

Beachten Sie, dass die Stecker nur in einer Richtung an die USB-Anschlüsse passen. Drücken Sie
sie nicht mit Gewalt hinein.
Systemübersicht: Ansicht von vorne und Rückansicht - 53
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Systemübersicht: Ansichten von rechts und linksAbb. 6
Ansichten von 

rechts und links

1. ExpressCard/
54(34)-Steckplatz

2. 7-in-1 Kartenleser
3. 2 USB 2.0 

Anschlüsse
4. Mini-IEEE 1394 

Anschluss 
5. RJ-11-Telefon-

buchse
6. RJ-45 LAN-Buchse
7. Kabelantennen-

buchse (CATV) (nur 
mit TV-Tuner akti-
viert)

8. Lautsprecher
9. Sicherheitsschloß-

Buchse
10. Schacht für opti-

sches Laufwerk (für 
CD/DVD-Geräte)

11. Notauswurfloch

1
2 3 4

5 6 7
3 8

CD/DVD-Notauswurf

Wenn eine CD/DVD manuell entnommen wer-
den muß (z.B. wegen eines Stromausfalls)
können Sie mit dem Ende einer geradegebo-
genen Büroklammer in das Notauswurfloch
drükken. Verwenden Sie hierzu aber keinen
spitzen Bleistift oder ähnliche Objekte, die im
Loch abbrechen und darin stekkenbleiben
könnten. Entnehmen Sie keine CD/DVD,
wenn das System gerade darauf zugreift. Da-
durch könnte es zu einem “Systemzusam-
men-bruch” kommen.

Mini-IEEE 1394 Anschluss

Der Mini-IEEE 1394-Anschluss unter-
stützt nur SELBSTVERSORGTE
(SELF-POWERED)  IEEE 1394-Geräte.

ExpressCard-Steckplatz

Der ExpressCard-Steckplatz kann so-
wohl für ExpressCard/34 als auch Ex-
pressCard/54 verwendet werden.

Rechte Seite

1098 11

Linke Seite
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Systemübersicht: Ansicht von unten Abb. 7 
 Ansicht von unten

1. Luftungsoffnung
2. Akkufach
3. Riegel für optische 

Laufwerke
4. Komponentenschacht-

abdeckung 
5. Infrarot-Empfänger/

CIR-Empfänger 
6. Sub Woofer

Hinweis zum Akku

Ein neuer Akku sollte bei seiner ersten Verwendung zuerst einmal vollständig entladen und dann
komplett wieder geladen werden. Entladen und laden Sie den Akku mindestens einmal im Monat
oder nach etwa 20 Teilentladungen einmal vollständig. 

1
2

34

5

1

6

1
1

1

3
1

Garantie

Die CPU darf nicht vom Anwen-
der repariert werden. Jeglicher
Zugriff auf die CPU führt zum
Verlust der Garantieansprüche.

Überhitzung

Zum Schutz vor Überhitzung Ih-
res Computers dürfen die
Luftungsoffnung(en) nicht wäh-
rend das Notebook in Betrieb ist
verdeckt werden.
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Windows Vista Startmenü und Systemsteuerung
Die meisten Einstellfenster, Utilitys und Programme erreichen Sie in Windows Vista (und bei den meisten anderen Ver-
sionen von Windows) über das Start-Menü. Wenn Sie Programme und Utilitys installieren, werden diese auf der Festplatte
installiert. Eine Verknüpfung davon wird in das Start-Menü und/oder auf dem Desktop erstellt. Klicken Sie mit der rechten
Maustaste auf das Startmenü-Symbol , und wählen Sie die Option Eigenschaften, um das Erscheinungsbild des Start-
menüs zu ändern.

In diesem Benutzerhandbuch finden Sie wiederholt die Aufforderung, die Systemsteuerung zu öffnen. Zur Systemsteue-
rung gelangen Sie über das Start-Menü. In der Systemsteuerung können Sie die Einstellungen für die meisten wichtigen
Windows-Funktionen (z.B. Strom, Video, Netzwerk, Audio) vornehmen. Windows Vista bietet für viele dieser Funktionen
Einstellfenster, wobei viele neue Fenster bereits hinzugefügt werden (oder die bestehenden verbessert werden), wenn Sie
die in Tabelle 5 auf Seite 61 aufgeführten Treiber installieren. Es kann sinnvoll sein, die klassische Ansicht des Startmenüs
einzustellen.

 
Klicken Sie hier, um in die Klassi-
sche Ansicht zu wechseln

Abb. 8 - Startmenü und Systemsteuerung
56 -  Windows Vista Startmenü und Systemsteuerung
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Grafikfunktionen
Wenn der Grafiktreiber installiert ist, können Sie bei Windows Vista im Einstellfenster Anzeigeeinstellungen die Anzei-
gegeräte wechseln und Anzeigeoptionen konfigurieren.

So öffnen Sie in Windows das Dialogfeld Anzeigeeinstellungen:
1. Klicken Sie Start (Menü) und klicken Sie Systemsteuerung (oder zeigen auf Einstellungen und klicken Systemsteuerung).
2. Klicken Sie im Menü Darstellung und Anpassung auf Bildschirmauflösung anpassen (oder doppelklicken Sie auf Anpassung > 

Anzeige).
3. Verschieben Sie den Regler auf die gewünschte Einstellung für die Auflösung  (siehe Abb. 9 auf Seite 58).
4. Klicken Sie auf den Pfeil, und wählen Sie die gewünschte Einstellung für die Farbtiefe  (siehe Abb. 9 auf Seite 58).
5. Klicken Sie auf Erweiterte Einstellungen (Schaltfläche)  (siehe Abb. 9 auf Seite 58), um das Einstellfenster Erweiterte 

Eigenschaften aufzurufen.
6. Klicken Sie auf GeForce..... (Registerkarte).
7. Klicken Sie auf NVIDIA Systemsteuerung starten  (siehe Abb. 9 auf Seite 58), um das Einstellfenster zu öffnen.
8. Sie können die NVIDIA Systemsteuerung auch aufrufen, indem Sie mit der rechten Maustaste auf den Desktop klicken und in dem 

Menü NVIDIA Systemsteuerung wählen.

1
2

3

4

Videokarten-Unterstützung

Beachten Sie, dass Kartentypen, Spezifikationen und Treiber kontinuierlich aktualisiert und geändert werden. Bei Ihrem Service-Center
erhalten Sie die neuesten Informationen über unterstützte Videokarten.
Grafikfunktionen - 57
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Anzeigegeräte und -optionen
Neben dem integrierten LCD-Monitor können Sie auch einen externen VGA-Monitor/Flachbildschirm oder ein Fernseh-
gerät als Anzeigegerät anschließen. Ein VGA-Monitor/Flachbildschirm wird an den DVI-Ausgangsanschluss angeschlos-
sen, ein Fernsehgerät an die S-Video-Ausgangsbuchse.

Tabelle 4 - Anzeigemodi

Anzeigemodus Beschreibung

Einzelne Anzeige Einer der angeschlossenen Geräte wird als Anzeigegerät verwendet

Klonen Auf beiden angeschlossenen Geräten wird dasselbe Bild angezeigt

Dualanzeige (DualView) Die beiden angeschlossenen Geräte werden wie getrennte Geräte behandelt, sie arbeiten 
wie ein virtueller Desktop

1 2
3

4

Abb. 9 - Anzeigeeinstellungen
58 -  Grafikfunktionen
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Audiofunktionen
Die Audioeinstellungen können Sie bei Windows durch Anklicken des Soundsymbols  oder des Realtek HD Audio
Manager -Symbols /  in der Taskleiste/Systemsteuerung aufrufen (wenn Sie mit der rechten Maustaste auf das Ta-
skleistensymbol  klicken, wird das Audiomenü aufgerufen). Die Lautstärke können Sie durch Drücken der Tastenkom-
bination  Fn + F5/F6 ändern.

Lautstärkeeinstellung

Die Lautstärke wird mit den
Windows-Lautstärkereglern
(oder den Lautstärkereglern
am Notebook) eingestellt.
Überprüfen Sie die Einstel-
lung, indem Sie in der Tasklei-
ste auf das Lautstärke-
Symbol klicken.

Abb. 10 - Realtek HD Audio - Manager

Klicken Sie mit der
rechten Maustaste auf
das Symbol , um
das obige Menü auf-
zurufen.
Audiofunktionen - 59
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Energieverwaltungsfunktionen
Die Energieoptionen von Windows (siehe Seite 56) ermöglichen Ihnen die Konfiguration der Optionen für das Energiema-
nagement des Computers. Sie können Strom sparen, indem Sie Energiesparpläne erstellen, die Netzschalter-, Energie-
spartasten- und Zuklappeinstellung (beim Schließen des Deckels) konfigurieren und im linken Menü den Anzeige- und
Energiesparmodus festlegen. Beachten Sie, dass sich die Energiesparpläne (Energiesparmodus) auf die Computerlei-
stung auswirken.

Wählen Sie einen bestehenden Plan aus, oder klicken Sie im linken Menü auf Energiesparplan erstellen, und wählen Sie
die Optionen, um einen neuen Plan zu erstellen. Klicken Sie auf Energieplaneinstellungen ändern, und klicken Sie auf
Erweiterte Energieeinstellungen ändern, um weitere Optionen für die Konfiguration aufzurufen.

Abb. 11 - Energieoptionen

Hinweis: Bei Windows Vista ist die Standardeinstellung Energie sparen
60 -  Energieverwaltungsfunktionen
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Installation der Treiber
Die DVD-ROM "Device Drivers & Utilities + User's Ma-
nual" enthält die Treiber und Hilfsprogramme, die für das
einwandfreie Funktionieren des Notebooks notwendig sind.
Legen Sie die mitgelieferte DVD-ROM und klicken Sie auf
Install Drivers (Schaltfläche), oder klicken Sie auf Optio-
nal (Schaltfläche), um das optionale Treibermenü aufzuru-
fen.
Installieren Sie die Treiber in der in Tabelle 5 angegebenen
Reihenfolge. Nachdem ein Treiber installiert wurde, wird er
grau dargestellt (wenn einer dieser Treiber ein weiteres Mal
installiert werden soll, klicken Sie auf die Schaltfläche Un-
lock).

Manuelle Treiber-Installation
Klicken Sie in der Anwendung Drivers Installer auf die
Schaltfläche Browse CD (CD durchsuchen) und navigieren
Sie zu der ausführbaren Datei in dem Ordner für Ihren Trei-
ber.

Windows Update
Nachdem Sie alle Treiber installiert haben, sollten Sie die
Funktion Windows Update aktualisieren, um immer die
neuesten Sicherheits-Updates usw. zu erhalten (die Updates
enthalten die neuesten Fehlerbehebungen von Microsoft).

Tabelle 5 - Installationsvorgang

Treiber (Windows Vista) Seite #

Chipsatz Seite 62

Video Seite 62

Audio Seite 62

Modem Seite 62

ExpressCard / Kartenleser Seite 62

Network (LAN) Seite 62

TouchPad Seite 62

Hot-Key Seite 62

Wireless-LAN (Option) Seite 63

Bluetooth (Option) Seite 64

PC-Kamera (Option) Seite 65

Fingerabdruckleser (Option) Seite 68

CIR (Option) Seite 71

TV-Tuner (Option) Seite 71

Intel Turbo Memory (Option) Seite 73

Windows Update aktivieren (siehe links)
Installation der Treiber - 61
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Chipsatz
1. Klicken Sie auf Install Drivers.
2. Klicken Sie auf 1.Install Chipset Driver > Ja.
3. Klicken Sie auf Weiter > Ja > Weiter > Weiter.
4. Klicken Sie auf Fertig stellen, um das Notebook neu zu 

starten.

Video
1. Klicken Sie auf Install Drivers.
2. Klicken Sie auf 2.Install Video Driver > Ja.
3. Klicken Sie auf Weiter.
4. Klicken Sie auf Fertig stellen, um das Notebook neu zu 

starten.

Audio
1. Klicken Sie auf Install Drivers.
2. Klicken Sie auf 3.Install Audio Driver > Ja.
3. Klicken Sie auf Weiter.
4. Klicken Sie auf Fertig stellen, um das Notebook neu zu 

starten.

Modem
1. Klicken Sie auf Install Drivers.
2. Klicken Sie auf 4.Install Modem Driver > Ja.
3. Klicken Sie auf OK.
4. Ihr Modem ist nun bereit zur Konfiguration.

ExpressCard / Kartenleser
1. Klicken Sie auf Install Drivers.
2. Klicken Sie auf 5.Install CardReader Driver > Ja.
3. Klicken Sie auf Weiter > Weiter.
4. Klicken Sie auf Fertig stellen, um das Notebook neu zu 

starten.

LAN
1. Klicken Sie auf Install Drivers.
2. Klicken Sie auf 6.Install LAN Driver > Ja.
3. Klicken Sie auf Weiter  > Installieren.
4. Klicken Sie auf Fertig stellen.

TouchPad
1. Klicken Sie auf Install Drivers.
2. Klicken Sie auf 7.Install Touch Pad Driver > Ja.
3. Klicken Sie auf Weiter > Weiter > Weiter.
4. Klicken Sie auf Fertigstellen, um das Notebook neu zu 

starten.

Hot-Key
1. Klicken Sie auf Install Drivers.
2. Klicken Sie auf 8.Install Hotkey Driver > Ja.
3. Klicken Sie auf Next  > Install.
4. Klicken Sie auf Finish > Finish, um das Notebook neu zu 

starten.
62 -  Installation der Treiber
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Wireless LAN

Installieren des Wireless-LAN-Treibers
1. Schalten Sie das Modul ein.
2. Klicken Sie auf Optional (Schaltfläche).
3. Klicken Sie auf 1.Install Intel WLan driver > Ja.
4. Klicken Sie auf Software installieren.
5. Klicken Sie auf die Schaltfläche Ich akzeptiere die 

Bedingungen der Lizenzvereinbarung, und dann auf 
Weiter.

6. Klicken Sie auf Weiter > OK.

Hinweis: Das Betriebssystem ist die Standardeinstellung
für die Steuerung des Wireless LAN bei Windows Vista.

Anschließen an ein Drahtlosnetzwerk
Stellen Sie sicher, dass das Wireless-LAN-Modul aktiviert ist.

1. Klicken Sie auf das Wireless-Symbol  in der Taskleiste, 
und klicken Sie dann auf Verbindung mit einem Netz-
werk herstellen (oder klicken Sie mit der rechten Mausta-
ste auf das Symbol , und klicken Sie dann auf 
Verbindung mit einem Netzwerk herstellen).

2. Klicken Sie in der Liste Anzeigen aus dem Dropdown-
Menü die Option Drahtlosnetzwerke.

3. Eine Liste der verfügbaren Netzwerke wird angezeigt.
4. Klicken Sie auf ein Netzwerk und dann auf Verbinden.
5. Wenn das gewünschte Netzwerk nicht angezeigt wird, 

klicken Sie auf Eine Verbindung oder ein Netzwerk 
einrichten (eine Liste der Optionen wird angezeigt, die 
eine manuelle Suche und Einstellung eines neuen 
Netzwerks ermöglichen).

6. Schieben Sie den Cursor über das Taskleistensymbol , 
um den Verbindungsstatus aufzurufen.

7. Wenn Sie die Verbindung zum Wireless-Netzwerk trennen 
möchten, klicken Sie in der Taskleiste auf das Wireless-
Symbol , und wählen Sie dann die Option Verbindung 
herstellen oder Trennen, um das Netzwerkmenü aufzuru-
fen. Klicken Sie dann auf Trennen (oder klicken Sie mit 
der rechten Maustaste auf das Symbol , und klicken Sie 
dann auf Verbindung trennen von).

Ein- und Ausschalten des Wireless-LAN-Moduls

Das Wireless-LAN-Modul wird durch Drücken der Tastenkom-
bination (Fn + F11) eingeschaltet. Wenn das Wireless-LAN-
Modul eingeschaltet ist, leuchtet die LED  grün und er-
scheint kurz die Anzeige .
Wireless LAN - 63
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Bluetooth

Installieren des Bluetooth-Treibers
1. Schalten Sie das Modul ein.
2. Klicken Sie auf Optional (Schaltfläche).
3. Klicken Sie auf 2.Install BlueTooth driver > Ja.
4. Wählen Sie eine Sprache und klicken auf OK > Weiter.
5. Klicken Sie auf die Schaltfläche Ich akzeptiere die 

Bedingungen der Lizenzvereinbarung, und dann auf 
Weiter.

6. Um fortzufahren, klicken Sie Weiter > Installieren.
7. Klicken Sie auf Fertigstellen > Ja, um das Notebook neu 

zu starten.

Bluetooth-Local-Area-Verbindung
Sie können den Bluetooth-Verbindungsstatus im Network-
und Freigabecenter prüfen:

1. Benutzen Sie die Tastenkombination Fn + F12, um das Blue-
tooth-Modul zu aktivieren.

2. Starten Sie das Programm IVT Corporation BlueSoleil über 
das Start-Menü oder indem Sie auf das Desktop-Symbol 
klicken.

3. Klicken Sie Start (Menü) und klicken Sie Systemsteuerung 
(oder zeigen auf Einstellungen und klicken 
Systemsteuerung).

4. Klicken Sie doppelt auf Network- und Freigabecenter 
(Netzwerk und Internet).

5. Klicken Sie auf Netzwerkverbindungen verwalten.
6. In der Systemsteuerung wird dann der Bluetooth-

Verbindungsstatus angezeigt.
7. Um die Verbindung zu trennen, klicken Sie im IVT 

Corporation BlueSoleil Hauptmenü auf Datei, und wählen 
Sie dann Beenden (die Local-Area-Verbindung zeigt dann 
"Network cable unplugged" an).

8. Der richtige Verbindungsstatus wird nur angezeigt, wenn Sie 
auf Datei > Beenden klicken. Er wird nicht angezeigt, wenn 
Sie die Schließen-Taste  oder die Tastenkombination Fn + 
F12 verwenden.

9. Schalten Sie mit der Tastenkombination Fn + F12 das 
Bluetooth-Modul aus (prüfen Sie die LED-Anzeige des 
Stromstatus des Bluetooth-Moduls).

Ein- und Ausschalten des Bluetooth-Moduls

Das Bluetooth-Modul wird durch Drücken der Tastenkombina-
tion (Fn + F12) eingeschaltet. Wenn das Bluetooth-Modul ein-
geschaltet ist, leuchtet die LED  orange und erscheint kurz
die Anzeige .
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PC-Kamera
Dieses Notebook verfügt über zwei Kameraoptionen. Das
1,3M-Pixel-Kamera-Modul verwendet für die Aufnahme
von Videodateien die Anwendung BisonCap. Das 2,0M-
Pixel-Kamera-Modul verwendet für die Aufnahme von
Videodateien VideoView.

Installieren des PC-Kamera-Treibers
Für 1,3M-Pixel-PC-Kamera-Modul:
1. Schalten Sie das Modul mit der Tastenkombination Fn + 

F10 ein (wenn das Modul eingeschaltet wird, erscheint 
kurz die Anzeige ). 

2. Klicken Sie auf Optional (Schaltfläche).
3. Klicken Sie auf 3.PC Camera, Web cam > Ja.
4. Wählen Sie eine Sprache und klicken auf Weiter.
5. Klicken Sie auf Weiter > Fertig stellen, um  das 

Computer neu zu starten.
6. Die BisonCap-Software wird über die Verknüpfung auf 

dem Desktop oder über den Eintrag BisonCam im Menü 
Start > Programme/Alle Programme gestartet (wenn 
die Hardware ausgeschaltet wurde, können Sie sie mit der 
Tastenkombination Fn + F10 wieder einschalten).

Für 2,0M-Pixel-PC-Kamera-Modul:
1. Schalten Sie das Modul mit der Tastenkombination Fn + 

F10 ein (wenn das Modul eingeschaltet wird, erscheint 
kurz die Anzeige ). 

2. Klicken Sie auf Optional (Schaltfläche).
3. Klicken Sie auf 3.PC Camera, Web cam > Ja.
4. Klicken Sie auf Installieren.
5. Wählen Sie als Antwort auf die Frage zum Stromsystem 

Ja oder Nein.
6. Klicken Sie auf Fertig stellen > Fertig stellen, um das 

Notebook neu zu starten.
7. Die VideoView-Software wird über die Verknüpfung auf 

dem Desktop oder über den Eintrag USB2.0 PC Camera 
im Menü Start > Programme/Alle Programme gestartet 
(wenn die Hardware ausgeschaltet wurde, können Sie sie 
mit der Tastenkombination Fn + F10 wieder einschalten).
PC-Kamera - 65
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Audio-Setup für die PC-Kamera
Wenn Sie mit der Kamera Video- und Audio-Daten aufneh-
men möchten, müssen Sie bei Windows die Optionen für die
Audio-Aufnahme einstellen.

1. Klicken Sie Start (Menü) und klicken Sie Systemsteuerung 
(oder zeigen auf Einstellungen und klicken Systemsteue-
rung).

2. Klicken Sie auf Sound  (Hardware und Sound).
3. Klicken Sie auf Aufnahme (Registerkarte).
4. Klicken Sie mit der rechten Maustaste auf Mikrofon (High 

Definition Audio-Gerät) und stellen Sie sicher, dass die 
Funktion nicht deaktiviert ist.

5. Klicken sie doppelt auf Mikrofon (oder wählen Sie aus dem 
Rechtsklick-Menü die Option Eigenschaften).

6. Klicken Sie auf Pegel (Registerkarte), und regeln Sie die 
Einstellungen von Mikrofon and Mikrofonverstärkung.

7. Klicken Sie auf OK und schließen Sie alle Fenster.
8. Starten Sie das Programm BisonCap/VideoView aus dem 

Menü Start > Programme/Alle Programme > BisonCam/
USB2.0 PC Camera.

9. Rufen Sie das Menü Geräte/Devices auf, und wählen Sie 
Mikrofon (Realtek....) (es sollte mit einem Häkchen 
gekennzeichnet sein).

10. Rufen Sie das Menü Aufnahme/Capture auf, und wählen Sie 
Audio aufnehmen/Capture Audio (es sollte mit einem 
Häkchen gekennzeichnet sein).

BisonCap/VideoView
Die Anwendungen BisonCap (für 1,3-Megapixel-
Kameras) und VideoView (für 2,0 Megapixel -Kameras)
sind Video-Viewer-Programme für die allgemeine
Videowiedergabe und -prüfung. Die Videodateien werden
im Format .avi aufgenommen.

1. Starten Sie das Programm BisonCap/VideoView aus dem 
Menü Start > Programme/Alle Programme > BisonCam/
USB2.0 PC Camera (es wird empfohlen, vor der Aufnahme 
die Aufnahmedatei einzustellen - siehe "Einstellen der 
Aufnahmedatei" weiter unten).

2. Gehen Sie zum Menü Aufnahme/Capture (wenn Sie Ton 
aufnehmen möchten, markieren Sie die Option "Audio-Setup 
für die PC-Kamera") und wählen Sie dann Aufnahme 
starten/Start Capture.

3. Klicken Sie auf OK (der Speicherort der Datei wird im Pop-up-
Fenster angezeigt), um die Aufzeichnung zu starten, und auf 
Esc, um sie zu stoppen (Die Datei können Sie sich dann mit 
Windows Media Player ansehen).

Einstellen der Aufnahmedatei
Vor dem Aufnehmen von Videodateien können Sie im Menü
Datei/File die Option Aufnahmedatei einst./Set Capture
File wählen und den Dateinamen und den Speicherort für die
aufgenommene Datei festlegen (dadurch können Sie vermei-
den, dass andere Dateien versehentlich überschrieben werden).
Wählen Sie den Namen und den Speicherort, und klicken Sie
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auf Öffnen. Legen Sie dann bei "Capture file size:" die Größe
der Aufnahmedatei fest, und klicken Sie auf OK. Nun können
Sie den Aufnahmevorgang wie oben beschrieben starten.

Zoom 
Mit den Programmen BisonCap und VideoView können
Sie das Kamerabild verkleinern und vergrößern.

Für BisonCap:
1. Starten Sie das Programm BisonCap.
2. Gehen Sie zum Menü Zoom und wählen Sie dann 

Vergrößern/Verkleinern.

Für VideoView:
1. Starten Sie das Programm VideoView.
2. Gehen Sie zum Menü Options und wählen Sie dann Setting 

(verwenden Sie den Schieberegler zu Einstellen  der 
Vergrößerung, und klicken Sie auf OK, um die Einstellung zu 
speichern).

Fotografieren
Mit den Programmen BisonCap und VideoView können
Sie auch fotografieren.

1. Starten Sie das Programm BisonCap/VideoView.
2. (BisonCap) Gehen Sie zum Menü Optionen und wählen Sie 

dann Fotografieren.                                                                 
oder                                                                                            

(VideoView) Gehen Sie zum Menü Capture und wählen Sie 
dann SnapShot.

3. Das Bild (im Format JPEG) wird im Desktopordner Snapshot 
 gespeichert (der Ordner darf nicht verschoben oder 

umbenannt werden).

Bildschirmflimmern beseitigen
Wenn das Videobild bei der Wiedergabe mit dem Pro-
gramm BisonCap/VideoView flimmern sollte, können Sie
bei den Optionen des Video Aufnahme Filters/Video
Capture Filters die Einstellung vornehmen.

Für BisonCap:
1. Starten Sie das Programm BisonCap.
2. Gehen Sie zu Optionen und wählen Sie "Video Aufnahme 

Filter....
3. Wählen Sie aus dem Feld Frequenz in der Registerkarte 

Eigenschaftenseite entweder 50Hz oder 60Hz.

Für VideoView:
1. Starten Sie das Programm VideoView.
2. Gehen Sie zu Options und wählen Sie "Video Capture 

Filter...".
3. Wählen Sie aus dem Feld Flickering Reduction in der 

Registerkarte Image entweder 50Hz oder 60Hz.
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Fingerabdruckleser
Wenn das von Ihnen erworbene Gerät über einen Fingerab-
druckleser verfügt müssen Sie den Treiber entsprechend der
folgenden Anweisung installieren. 

Für einen vollen Schutz müssen Sie für den Computer Admi-
nistratorrechte und ein Windows-Kennwort aktiviert haben. 

Bevor Sie mit der Registrierung beginnen, sollten Sie das
Lernprogramm zum Fingerabdruckleser durchgehen. Um
das Lernprogramm zu starten, klicken Sie auf Start > Pro-
gramme/ Alle Programme > Protector Suite QL > Fin-
gerprint Tutorial (Fingerabdruck-Lernprogramm).

Installieren des Fingerabdruckleser-
Treibers
1. Klicken Sie auf Optional (Schaltfläche).
2. Klicken Sie auf 4.Install FingerPrint Driver > Ja.
3. Klicken Sie auf Softwareinstallation.
4. Klicken Sie auf Weiter > Weiter > Weiter.
5. Klicken Sie auf Fertig stellen  > Ja, um das Notebook neu 

zu starten.

Benutzerregistrierung
1. Klicken Sie auf Start > Programme/ Alle Programme > Pro-

tector Suite QL > Benutzerregistrierung, oder doppelklik-
ken Sie in der Taskleiste auf das Symbol .

2. Wenn das Programm das erste Mal gestartet wird, werden Sie 
gefragt, ob Sie die Lizenzvereinbarung annehmen möchten. 
Klicken Sie dann auf OK.

3. Klicken Sie auf Weiter und wählen Sie "Registrierung auf 
der Festpllate", und klicken Sie auf Fertig stellen.

Hilfe & Handbuch

Klicken Sie mit der rechten Maustaste auf das Taskleistensym-
bol  und wählen Sie aus dem Menü die Option Help (Hilfe).

Legen Sie die mitgelieferte DVD-ROM Device Drivers & Utilities
+ User's Manual ein und klicken Sie auf Optional (Schaltflä-
che). klicken Sie auf Unlock (Schaltfläche) und dann klicken
Sie auf 4.Install FingerPrint Driver > Ja.

Klicken Sie auf Documentation um den Ordner zu öffnen, in
dem Sich das Benutzerhandbuch im .pdf-Format befindet.

Um die Adobe Acrobat Reader-Software zu installieren, die Sie
benötigen, um die Datei lesen zu können, legen Sie die DVD-
ROM Device Drivers & Utilities + User’s Manual in das CD/
DVD-Laufwerk ein, und klicken sie auf User’s Manual (Schalt-
fläche) und dann auf  Install Acrobat Reader (Schaltfläche).
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4. Wenn Sie kein Windows-Kennwort eingerichtet haben, 
werden Sie dazu aufgefordert (Hinweis: Wenn kein Kennwort 
festgelegt wurde, kann Protector Suite QL nicht den Zugriff 
auf den Computer sichern).

5. Wenn Sie auf Weiter klicken, werden Sie aufgefordert, Ihr 
Windows-Kennwort einzugeben.

6. Klicken Sie auf Weiter > Weiter (Markieren Sie das 
Kontrollfeld bei "Interaktives Lernprogramm ausführen", 
um das Fingerabdruck-Lernprogramm durchzugehen).

7. Klicken Sie bei jedem Fenster des Lernprogramms auf Weiter 
(sie können jederzeit auch auf die Schaltfläche 
"Lernprogramm überspringen" klicken).

8. Klicken Sie auf eine der Tasten über einem beliebigen Finger, 
um mit der Registrierung dieses Fingers zu beginnen.

9. Tippen Sie dreimal mit dem Finger auf, um diesen Finger zu 
registrieren.

10. Wiederholen Sie diesen Vorgang für alle Finger, die registriert 
werden sollen, und dann klicken Sie auf Weiter.

11. Klicken Sie auf Fertig stellen.
12. Klicken Sie auf einen der Einträge unter "Weitere 

Informationen zu:", um weitere Informationen über dieses 
Thema zu erhalten.

13. Klicken Sie auf Schließen.
14. Starten Sie das Notebook neu.
15. Klicken Sie mit der rechten Maustaste auf das 

Taskleistensymbol  um das Menü mit den Optionen zu 
starten, mit denen Sie Fingerabdrücke bearbeiten, auf das 
Control Center zugreifen, die Hilfe aufrufen können. Sie 

können das Control Center usw. auch über den Eintrag 
Protector Suite QL im Menü Start > Programme/Alle 
Programme starten. 

16. Eine ausführliche Beschreibung finden Sie unter “Hilfe & 
Handbuch” auf Seite 68.

17. Wenn Sie mit dem Finger auf den Fingerabdruckleser tippen, 
können Sie auf das Biomenü zugreifen, um den Computer 
zu sperren, Websites zu registrieren, das Control Center 
zu öffnen und das Hilfe-Menü aufzurufen.

18. Im Control Center können Sie die Einstellungen und 
Fingerabdrücke bearbeiten, und hier erhalten Sie auch Hilfe 
dazu.

Abb. 12 -  Control Center & Biomenü 

Fingerabdruckregistrierung

Beachten Sie, dass es für den Fall einer Verletzung o. ä.
sinnvoll ist, mehr als einen Finger zu registrieren.
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USB TV-Tuner-Modul
Wenn das von Ihnen erworbene Modell das optionale USB TV-Tuner-Modul enthält, haben
Sie auch eine CD mit Treibern, Software und dem Benutzerhandbuch  erhalten. Auf der
DVD-ROM Device Drivers & Utilities + User's Manual befindet sich zusätzlich ein Treiber
für die Fernbedienung des TV-Tuners.

Im Lieferumfang sind dann außerdem eine Fernbedienung, eine geeignete Antenne sowie
Zubehör für das USB TV-Tuner-Modul enthalten.

Mit dem optionalen TV-Tuner können Sie fernsehen, Musik-CDs wiedergeben, Videokon-
ferenzen abhalten sowie Fotos und Videos auf dem PC aufzeichnen. 

Die Kabelantennenbuchse (CATV) ist nur dann aktiviert, wenn das TV-Tuner-Modul
installiert ist. Installieren Sie zuerst die gesamte Software, bevor Sie die TV-Antenne
anschließen.

TV-Antenne

Die mit den TV-Tunermo-
dulen mitgelieferte TV-
Antenne ist nur für die
Verwendung in Räumen
vorgesehen. Verwenden
Sie das TV-Tunermodul
nicht im Freien.

TV-Tuner-Fernbedienung

Richten Sie die Fernbedie-
nung auf den CIR-Empfän-
ger, um z. B. das
Programm zu wechseln.

Abb. 13
Anschlüsse/Buchsen 

der TV-Tuner

1. Infrarot-Empfänger/CIR-
Empfänger 

2. Kabelantennenbuchse 
(CATV) 2

1
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Installieren des CIR-Treibers
1. Klicken Sie auf Optional (Schaltfläche).
2. Klicken Sie auf 5.Install ITE CIR Driver > Ja.
3. Klicken Sie auf Next > Yes > Next > Finish.

Installieren des TV-Tuner-Treibers
1. Legen Sie die TV-Tuner Treiber CD in das CD/DVD-

Laufwerk.
2. Klicken Sie auf MC770A Driver V2.3.3.3 Setup for XP/

Vista.
3. Klicken Sie auf Install > OK.
4. Klicken Sie auf S/W Encoder V1.0.70807 Setup for 

Vista um den Softwareencoder zu installieren.
5. Klicken Sie auf Weiter.
6. Klicken Sie auf die Schaltfläche Ich akzeptiere die  

Lizenzvereinbarung, und dann auf Weiter.
7. Klicken Sie auf Weiter > Weiter > Weiter > Beenden.
8. Klicken Sie auf AP V2.0.1810.70802 Setup for XP/Vista 

um die Software zu installieren.
9. Klicken Sie auf Weiter.
10. Klicken Sie auf die Schaltfläche Ich akzeptiere die  

Lizenzvereinbarung, und dann auf Weiter.
11. Klicken Sie auf Weiter (geben Sie einen Benutzer- und 

Firmennamen ein).
12. Geben Sie den vorgegebenen CD-Schlüssel ein, und dann 

auf Weiter.

13. Wählen Sie eine Sprache und klicken auf Weiter.
14.Klicken Sie auf Weiter > Next > Weiter.
15. Klicken Sie auf die Schaltfläche, um das Notebook neu zu 

starten, und dann auf Weiter.
16.Klicken Sie auf Beenden, um das Notebook neu zu 

starten.
17. Die Hybrid DTV-Software wird über die Verknüpfung 

auf dem Desktop oder über den Eintrag DTVplayer im 
Menü Start > Programme/Alle Programme > Hybrid 
DTV gestartet.
Oder  

18. Starten Sie Windows Media Center direkt über das 
Start-Menü (Start > Programme/ AlleProgramme > 
Windows Media Center).

19. Windows Hilfe und Support stellt Informationen zu den 
Funktionen von Windows Media Center zur Verfügung. 
Klicken Sie auf Start , und wählen Sie Hilfe und 
Support. Geben Sie dann in das Suchfeld"Media Center" 
ein, und klicken Sie auf das Lupensymbol , um die 
Suche zu starten.

Windows Media Center

Beachten Sie, dass das Programm Windows Media Center nur
in Windows Vista Home Premium und Ultimate enthalten ist. 
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Digitales TV-Sendesignal
Die Antenne ist der wichtigste Faktor beim Empfang eines
klaren digitalen terrestrischen TV-Sendesignals. Die mitge-
lieferte passive Antenne kann, wenn sie an einem  Fenster
steht, ein klares Signal liefern. Wenn das Signal nicht klar
ist, können Sie eine aktive Antenne verwenden (auch diese
sollte am Fenster stehen), um das Signal zu verbessern.
Versuchen Sie außerdem Informationen über den Sendebe-
reich für digitale terrestrische TV-Sendesignale in Ihrem
Bereich zu erhalten. Beachten Sie, dass auf dem Fernseh-
bildschirm bei einem schwachen digitalen Signalempfang
(anders als bei herkömmlichem analogen Fernsehen) kein
Bild zu sehen ist.

TV-Aufnahmen und Energieoptionen
Wenn Sie den optionalen TV-Tuner für die Aufnahme von
Fernsehsendungen verwenden möchten, rufen Sie die En-
ergieoptionen auf, um ein Energieschema zu erstellen, bei
dem sich die Stromsparoptionen nicht an die Computerlei-
stung angleichen.

Fernbedienung 
Mit der Fernbedienung können Sie das System ferngesteu-
ert in einen Stromsparmodus versetzen, Windows Media
Center starten, in den Menüs von Media Center navigieren
usw. Zudem haben Sie mit der Fernbedienung die volle
Kontrolle über alle Fernseh- und Videofunktionen.

CATV-Kabelsicherheit

Stellen Sie sicher, dass beim Installieren des CATV-Sy-
stems die Koaxialkabelabschirmung so nah wie möglich am
Kabeleintrittspunkt angeschlossen wurde.

Beim Installieren des Kabelfernsehsystems muss Artikel
820-93 der NEC-Vorschrift (Abschnitt 54, Teil I des "Cana-
dian Electrical Code") beachtet werden.
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Intel Turbo Memory-Modul
Wenn Ihr Modell über ein Intel Turbo Memory (Robson) NAND-Speicherkartenmodul ver-
fügt, müssen Sie die Option im BIOS aktivieren, BEVOR Sie das Windows Vista-Betriebs-
system installieren (aktivieren Sie diese Option nicht bei Windows XP oder Windows Vista,
wenn das Betriebssystem ohne aktivierte Option installiert wurde).

Die Intel Turbo Memory-Technologie (auch bekannt als Robson-Flash-Speicher) ist eine
Intel-Technologie, mit der die Zeit zum Hochfahren des Computers, Laden von Programmen
und Schreiben von Daten auf die Festplatte verkürzt wird. Die Intel Turbo Memory-Tech-
nologie wird nur von Windows Vista unterstützt (es unterstützt auch Windows Vista-Funk-
tionen wie ReadyBoost, ReadyDrive und Superfetch).

Einrichten von Intel Turbo Memory und Installieren des Trei-
bers
1. Starten Sie das Notebook und drücken Sie auf die Taste F2, um in das BIOS zu gelangen.
2. Gehen Sie zum Menü Advanced.
3. Wählen Sie Advanced Chipset Control und und drücken auf Enter.
4. Drücken Sie auf die Leertaste, um die Option Intel Robson zu markieren (Enabled).
5. Gehen Sie zum Menü Boot.
6. Legen Sie im Menü Boot priority order das CD/DVD-ROM-Laufwerk (stellen Sie sicher, 

dass die Betriebssystem-CD für Microsoft Windows Vista eingelegt ist) als das in der 
Bootreihenfolge erste Gerät fest.

7. Wählen Sie Exit Saving Changes aus dem Menü Exit (oder drücken auf F10 und Enter) 
und drücken auf Enter um das BIOS zu verlassen und den Computer neu zu starten.

8. Wenn die Meldung "Press any key to boot from CD or DVD" erscheint, drücken Sie eine Taste.

Problem mit ReadyBoost 

Wenn Intel® Turbo Me-
mory Console unmittelbar
nach dem Einschalten des
Systems geöffnet wird, ist
Windows ReadyBoost
unter Umständen deakti-
viert.

Das ist normal. Während
Microsoft die Windows
ReadyBoost-Datei gene-
riert, erscheint der Status
als deaktiviert. Sobald die
Datei generiert ist, wird der
Status wieder als aktiviert
angezeigt.

Die neuesten aktualisierten
Informationen zu diesem
Problem finden Sie auf der
Intel-Website (http://sup-
port.intel.com/ support/
chipsets/itm/sb/CS-
025852.htm).
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9. Die Systemsoftware leitet Sie durch den Installationsvorgang (die Anleitung zur Installation des Windows-Betriebssystems 
finden Sie in der Windows Vista- Dokumentation).

10. Installieren Sie die Treiber entsprechend der Anleitung unter “Installation der Treiber” auf Seite 61 (stellen Sie sicher, dass 
die Treiber in der in Tabelle 5 auf Seite 61 aufgeführten Reihenfolge installiert werden).

11. Legen Sie die DVD-ROM Device Drivers & Utilities + User's Manual in das CD/DVD-Laufwerk ein.
12. Klicken Sie auf Optional (Schaltfläche).
13. Klicken Sie auf 6.Install Robson Driver > Ja.
14. Klicken Sie auf Weiter > Ja > Weiter > Weiter.
15. Klicken Sie auf Fertig stellen, um das Notebook neu zu starten.
16. Nachdem der Computer die notwendigen Hardwareänderungen vorgenommen hat, und Sie den Computer neu gestartet 

haben, klicken Sie auf Jetzt neu starten, um die Installation abzuschließen.

Abb. 14 - Die BIOS-Menüs "Advanced" und "Advanced Chipset Control"

Main Advanced Security Boot Exit

F1 Help �� Select Item -/+ Change Values F9 Setup Defaults
Esc Exit �� Select Menu Enter Select �Sub-Menu F10 Save and Exit

Item Specific Help

Advanced

Select options for
Advanced Chipset
features.

Phoenix TrustedCore(tm) Setup Utility

�Advanced Chipset Control
Reset Configuration Data: [No]
Local Bus IDE adapter: [Both]

Boot-time Diagnostic Screen: [Enabled]
Legacy USB Support: [Enabled]
USB 2.0 Enable: [Enabled]
POST Beep Sound [Disabled]
Battery Low Alarm Beep: [Disabled]

F1 Help �� Select Item -/+ Change Values F9 Setup Defaults
Esc Exit �� Select Menu Enter Select �Sub-Menu F10 Save and Exit

Item Specific Help

Advanced

Phoenix TrustedCore(tm) Setup Utility

Intel Turbo Memory
Technology

Advanced Chipset Control

Intel Robson [Enabled]
SATA - Device 31, Function 2: [Enhanced]
AHCI Configuration Enabled]
DFOROM(Robson) Support: [Enabled]
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Fehlerbehebung
Problem Mögliche Ursache - Lösung

Ich kann die Regionscodes mit 
dem DVD-Hilfsprogramm nicht 
mehr ändern.

Der Regionscode wurde schon 5mal geändert.  Die DVD-Regionserkennung hängt vom Gerät, 
nicht vom Betriebssystem ab. Sie können den Regionalcode für Ihr Modul 5mal  wählen. Die 
fünfte Wahl ist nicht mehr änderbar. Sie kann auch bei Wechsel des Betriebssystems oder bei 
Verwendung des Moduls in einem anderen Computer verändert werden.

Das TouchPad funktioniert nicht. Das TouchPad wurde deaktiviert. Drücken Sie auf die Tastenkombination (Fn + F1), um das 
TouchPad zu aktivieren (stellen Sie sicher, dass der TouchPad-Treiber installiert ist).

Die Module Wireless-LAN/
Bluetooth können nicht erkannt 
werden.

Das/Die Modul(e) ist/sind ausgeschaltet. Stellen Sie anhand der Anzeige-LED  fest, ob das 
Modul an- oder ausgeschaltet ist (siehe “LED-Anzeigen” auf Seite 49). Wenn die Anzeige-
LED nicht leuchtet, drücken Sie die Tastenkombination, um das Modul zu aktivieren (siehe 
“Funktionstasten und visuelle Anzeigen” auf Seite 51).

Bei der PC-Kamera-Software 
erscheint beim Start der PC-
Kamera-Software ein schwarzer 
Bildschirm.

Die Software verwendet das falsche Gerät. Wenn Sie sowohl über das optionale PC-Kamera- 
und TV-Tuner-Modul verfügen, gehen Sie im Programm BisonCap/VideoView in das Menü 
Geräte/Devices und wählen als Gerät BisonCam, NB Pro/USB2.0 2M WebCam (PC-
Kamera).

Die mit der PC-Kamera 
aufgenommenen Dateien 
benötigen zu viel Speicherplatz.

Videodateien, die mit hoher Auflösung aufgenommen werden, erfordern sehr viel 
Speicherplatz.

Beachten Sie, dass das Betriebssystem Windows Vista mindestens 15 GB freien Speicher im 
Laufwerk C: der Systempartition benötigt. Es wird empfohlen, die aufgenommenen 
Videodateien in einem anderen Laufwerk als C: zu speichern, die Dateigröße der 
Aufnahmedateien zu beschränken oder die Auflösung der Videos zu verringern (Optionen/
Options > Video Aufnahme konfigurieren.../Video Capture Pin... > Ausgabegröße).
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Bildschirmauflösungs-Fehler
Wenn nach der Wiederaufnahme aus dem Schlafmodus (nur in Windows Vista)  entweder die Bildschirmauflösung
geringer ist oder der Bildschirm flimmert, führen Sie die folgenden Schritte aus, um dieses Problem zu beheben. Dieser
Fehler tritt im Zusammenhang mit Windows Vista auf, welches beim Schließen des Notebooks (S3) TMM (Transient Mul-
timon Manager) auslöst. TMM trennt den LCD-Bildschirm vom Betriebssystem und verbindet ihn wieder, wenn das No-
tebook geöffnet wird. Dieser Vorgang kann dazu führen, dass TMM veranlasst wird, eine alte Bildschirmeinstellung
wiederherzustellen, die dann zum Bildschirmflimmern führt oder eine Änderung der Auflösung zur Folge hat.
1. Klicken Sie Start (Menü), klicken Sie Systemsteuerung (oder zeigen auf Einstellungen und klicken Systemsteuerung) 

und doppelklicken Sie auf Verwaltung (System und Wartung).
2. Doppelklicken Sie auf Aufgabenplanung (Aufgaben planen).
3. Doppelklicken Sie auf Aufgabenplanungbibliot > Microsoft > Windows, und klicken Sie auf MobilePC um die 

Systemsteuerung  zu öffnen.
4. Klicken Sie mit der rechten Maustaste auf TMM und wählen Sie Deaktivieren, und schließen dan Sie alle 

Systemsteuerungen.

Abb. 15 - System und Wartung (Systemsteuerung)
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Technische Daten

Funktion Technische Daten

Prozessor 
Typen

Intel Core 2 Duo Prozessor 
Micro-FCPGA-Paket (478-pin)
T7100

(65nm) 65 Nanometer-Prozesstechnologie 
2 MB L2 Cache & 800-MHz-Systembus (FSB) 
1,80 GHz

Intel Core 2 Duo Prozessor 
Micro-FCPGA-Paket (478-pin)
T7300/ T7500/ T7700 

(65nm) 65 Nanometer-Prozesstechnologie 
4 MB L2 Cache & 800-MHz-Systembus (FSB) 
2,0/ 2,2/ 2,4 GHz

Core Logic Intel(R) PM965 + ICH8M Chipsatz

Speicher Zwei 200-Pin SODIMM-Sokkel, Unterstützung von DDRII (DDR2) 533/ 667 Speicher
Speicher auf bis zu 4 GB erweiterbar

Sicherheit Öffnung für Sicherheitsschloß (Typ Kensington)
Fingerabdruckleser (Werkseitige Option)

BIOS-Paßwort

BIOS 8Mb Flash-ROM Phoenix BIOS

Aktualität der technischen Daten

Die in diesem Anhang aufgeführten technischen Daten sind zum Zeitpunkt der Druckstellung richtig. Bestimmte Elemente (ins-
besondere Prozessortypen/-geschwindigkeiten) können im Rahmen des Entwicklungsplans des Herstellers zwischenzeitlich ge-
ändert oder aktualisiert werden. Detailinformationen erhalten Sie bei Ihrem Servicezentrum.
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LCD-Optionen Glare-Type TFT-Flachbildschirm, 17" WXGA 
(1280*800)
Entspiegelter TFT-Flachbildschirm, 17" WXGA 
(1280*800)

Glare-Type TFT-Flachbildschirm, 17" WSXGA+ 
(1600*1050)
Glare-Type TFT-Flachbildschirm, 17" WUXGA 
(1920*1200)

Videokarte-
Optionen

NVIDIA GeForce Go 7950 GTX PCI-E-Videokarte
MXM-IV
512MB GDDR3 Video-RAM On Board
Kompatibel mit MS DirectX 9

NVIDIA GeForce 8700M GT PCI-E-Videokarte
MXM-III
512MB GDDR3 Video-RAM On Board
Kompatibel mit MS DirectX 10
Unterstützt HDCP

NVIDIA GeForce 8800M GTX PCI-E-Videokarte
MXM-IV
512MB GDDR3 Video-RAM On Board
Kompatibel mit MS DirectX 10
Unterstützt HDCP

Speicher Ein Austauschbares optisches Laufwerk (12,7 mm Höhe) für CDs/DVDs (Laufwerksoptionen finden Sie unter 
“Optional” auf Seite 80)
Eine einfach auszuwechselnde SATA-2,5"-Festplatte (9,5 mm Höhe)

Kartenleser Festes 7-in-1 Kartenleser-Modul (MS/ MS Pro/ SD/ Mini SD/ MMC/ RS MMC/ MS Duo)
Hinweis: MS Duo/ Mini SD/ RS MMC Karte erfordert PC-Adapter

Funktion Technische Daten

Videokarte-Optionen

Beachten Sie, dass Kartentypen, Spezifikationen
und Treiber kontinuierlich aktualisiert und geän-
dert werden. Bei Ihrem Service-Center erhalten
Sie die neuesten Informationen über unterstützte
Videokarten. 
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Audio Intel High-Definition-Audio-kompatible Schnittstelle
3D Stereo-Soundsystem

 SRS WOW Surround Sound Technology Inside
Kompatibel mit Sound-Blaster PRO™

S/PDIF Digtalausgang
Eingebautes Mikrofon
2 eingebaute Lautsprecher (1,5W, 8Ω)

1 Sub-Woofer (2W, 8Ω)

Tastatur "Win Key"-Tastatur (mit Nummerntastatur) in Normalgröße

Zeigegerät Eingebautes TouchPad (integrierte Rolltastenfunktion)

ExpressCard-
Steckplatz ExpressCard/54(34)-Steckplatz

Schnittstellen Vier USB 2.0-Anschlüsse 
Ein DVI-Ausgangsanschluss
Eine Lautsprecher/Kopfhörer-Ausgangsbuchse
Eine Mikrofon-Eingangsbuchse
Eine S/PDIF-Ausgangsbuchse
Eine Line-Eingangsbuchse (Line-In) für Audioein-
gang
Eine serielle Schnittstelle
Ein Mini-IEEE 1394-Anschluss
Ein infrarot-Transceiver
Eine RJ-11 Buchse für Modem

Eine RJ-45-Buchse für LAN
Eine DC-Eingangsbuchse
Eine S-Video-Ausgangsbuchse für TV- und HDTV-
Ausgabe
Eine Kabelantennenbuchse (CATV) (analog/digital) 
(arbeitet mit dem optionalen TV-Tuner)
Ein CIR-Empfänger (arbeitet mit dem optionalen TV-
Tuner)
Ein Minikarten-Slot für TV Tuner oder Intel Turbos-
peichermodul
Ein Minikarten-Slot nur für WLAN

Energieverwal-
tung Unterstützt ACPI v3.0

Funktion Technische Daten
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Kommunikation 56K MDC-Modem (V.90- und V.92-kompatibel)
1 Gbit PCI-Express Fast-Ethernet-LAN
Intel Wireless Wi-Fi Link 4965AGN PCIe Wireless-
LAN Modul (Option)
USB TV-Tuner-Modul (Option)

USB Bluetooth 2.0 + EDR -Modul (Werkseitige 
Option)
1,3M oder 2,0M Pixel USB PC-Kamera-Modul (Werk-
seitige Option)

Stromversor-
gung

AC/DC-Adapter für den gesamten Spannungsbereich 
AC-Eingang: 100-240 V, 50-60 Hz
DC-Ausgang: 20V, 6,0A (120 W)

Leicht austauschbarer Smart Lithium-Ionen-Haupt-
akku mit 8 Zellen (4400 mAh)

Umgebungsbe-
dingungen

Temperatur
In Betrieb: 5ºC - 35ºC
Bei Aufbewahrung: -20ºC - 60ºC

Relative Luftfeuchtigkeit
In Betrieb: 20% - 80 %
Bei Aufbewahrung: 10% - 90 %

Abmessungen 
& Gewicht 397 (B) x 284 (T) x 22-44 (H) mm Ca. 3,95 kg (+/- 5%) mit Akku (8 Zellen)

Optional Optionen für optische Laufwerks-Module:
Kombiniertes-Laufwerk
DVD-Super-Multi-Laufwerk

Intel Wireless Wi-Fi Link 4965AGN PCIe Wireless-
LAN Modul
USB TV-Tuner-Modul
Intel Turbo Memory (Robson) NAND-Speicherkarten-
modul

1,3M oder 2,0M USB PC-Kamera-Modul (Werksei-
tige Option)
1,3M oder 2,0M Pixel USB PC-Kamera-Modul (Werk-
seitige Option)
Fingerabdruckleser (Werkseitige Option)

Funktion Technische Daten
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Avertissement
La compagnie se réserve le droit de revoir cette publication ou de modifier son contenu sans préavis. Les informations
qu’elle contient sont pour référence seulement et n’engagent pas la responsabilité du fabricant ou d’aucun distributeur. Ils
n’assument aucune responsabilité en cas d’erreurs ou d’imprécisions qui pourraient se trouver dans cette publication et ne
sont en aucun cas responsable d’aucunes pertes ou dommages résultant de l’utilisation (correcte ou incorrecte) de cette pu-
blication.

Cette publication et les logiciels qui l’accompagnent ne peuvent pas, dans leur intégrité ou en partie, être reproduits, tra-
duits, transmits ou convertis en format électronique sans l’autorisation préalable du vendeur, du fabricant ou des créateurs
de cette publication, à l’exception de copies conservées par l’utilisateur pour archive.
Les noms de marques ou de produits mentionnés dans cette publication peuvent ou pas être protégés et/ou être des marques
déposées par leur compagnies respectives. Ils sont mentionnés dans un but d’identification seulement et ne signifient pas
l’approbation de ce produit ou de son fabricant.

© Novembre 2007

Marques déposées
Ce produit incorpore une technologie de protection des droits d'auteur protégée par certains brevets américains et autres
droits sur la propriété intellectuelle appartenant à Macrovision Corporation et d’autres propriétaires légitimes. L’utilisation
de cette technologie de protection des droits d'auteur doit être autorisé par Macrovision Corporation, et n’est prévu que dans
un cadre privé ou limité, à moins d’obtenir l’autorisation de Macrovision Corporation. L'ingénierie inverse et le désassem-
blage sont interdits.

Intel et Intel Core sont des marques déposées ou enregistrées d’Intel Corporation déposées.
es una marca de SRS Labs, Inc.  

La tecnología WOW ha sido incorporada bajo la licencia de SRS Labs, Inc.
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A propos de ce Guide Utilisateur Concis
Ce guide rapide est une brève introduction à la mise en route de votre système. l s’agit d’un supplément, et non pas d’une
alternative au Manuel de l’Utilisateur en Anglais complet au format Adobe Acrobat sur le DVD-ROM Device Drivers &
Utilities + User's Manual fourni avec votre ordinateur. Ce DVD-ROM contient aussi les pilotes et utilitaires nécessaires
au fonctionnement correct de votre ordinateur portable. 

Certains ou tous les éléments de l’ordinateur peuvent avoir été déjà installés. Si ce n’est pas le cas, ou si vous avez l’inten-
tion de reconfigurer (ou réinstaller) des portions du système, reportez-vous au Manuel de l’Utilisateur complet. Le DVD-
ROM Device Drivers & Utilities + User’s Manual ne contient pas de système d’exploitation.

Informations de contrôle
Des mises en garde et informations de contrôle sont incluses dans le Manuel de l'Utilisateur complet qui se trouve sur le
DVD-ROM Device Drivers & Utilities +User’s Manual.

Utilisation des appareils sans fil à bord d'un avion

L'utilisation de tout appareil électronique de transmission est généralement interdite à bord d'un avion.
Assurez-vous que les modules sans fil sont éteints si vous utilisez l'ordinateur à bord d'un avi-
on.
82 -  A propos de ce Guide Utilisateur Concis



Guide Utilisateur Concis

Français
Instructions d’entretien et d’utilisation
L’ordinateur portable est robuste, mais il peut toutefois être endommagé. Afin d’éviter ceci, veuillez suivre ces
recommandations :
• Ne le laissez pastomber. Ne l’exposez à aucun choc ou vibration.  Si l’ordinateur tombe, le boîtier et d’autres éléments pour-

raient être endommagés.
• Gardez-le sec. Ne le laisser pas surchauffer. Tenez l’ordinateur et son alimentation externe à distance de toute source de chaleur. 

Il s’agit d’un appareil électrique. Si de l’eau ou tout autre liquide venait à pénétrer à l’intérieur de votre ordinateur, il pourrait être 
sérieusement endommagé.

• Evitez les interférences. Tenez l’ordinateur à distance de transformateurs à haute capacité, moteurs électriques, et autres appareils 
générateurs de champs magnétiques importants. Ceux-ci peuvent gêner ses performances normales et endommager vos données.

• Suivez les procédures appropriées d’utilisation de votre ordinateur. Arrêtez l’ordinateur correctement, et fermez tous vos pro-
grammes (n’oubliez pas d’enregistrer votre travail). N’oubliez pas d’enregistrer vos données régulièrement puisqu’elles peuvent 
être perdues si la batterie est vide.

• Soyez prudent lorsque vous utilisez des périphériques.

Révision
N’essayez pas de réaliser les opérations de révision de votre ordinateur par vous-même. Le faire pourrait annulez votre
garantie et vous exposez à des chocs électriques. Pour toute opération de révision, adressez-vous à des personnes agrées.
Débranchez votre ordinateur de toute source d’alimentation. Puis adressez-vous à des professionnels agréés si vous ren-
contrez l’une des situations suivantes :

• Si le cordon d’alimentation ou l’adaptateur CA/CC est endommagé, abimé ou effiloché.
• Si votre ordinateur a été exposé à la pluie ou tout autre liquide.
• Si votre ordinateur ne fonctionne pas normalement bien que vous ayez suivi les instructions de mise en marche à la lettre.
• Si votre ordinateur est tombé par terre ou a été endommagé de quelque manière que ce soit (ne touchez pas le liquide qui sortirait de 

l’écran LCD au cas où celui-ci serait cassé : il est très dangereux et contient des produits qui pourraient vous empoisonner).
• Si une odeur inhabituel, de la chaleur ou de la fumée apparaissait sortant de votre ordinateur.
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Sécurité electrique
Votre ordinateur possède des besoins en énergie propre :
• Utilisez uniquement un adaptateur CA/CC agréé avec votre ordinateur. 
• Votre adaptateur CA/CC peut avoir été conçu pour les voyages internationaux mais il lui faut tout de même une source de courant 

régulière et ininterrompue. Si vous n’êtes pas sûr des caractèristiques du réseau électrique local, consultez notre représentant de 
service ou la compagnie électrique locale.

• L’adaptateur CA/CC que vous utilisez, peut être à 2 broches ou à 3 broches, comprenant une prise de terre. Cette prise de terre est 
un des éléments de sécurité importants, ne vous en passez pas ! Si une prise murale compatible n’est pas disponible, demandez à un 
électricien qualifié de vous en installez une. 

• Quand vous voulez débrancher le cordon d’alimentation, ne tirez pas sur le fil, mais attrapez la tête de la prise. 
• Assurez-vous que la prise murale et la (les) rallonge(s) que vous utilisez peuvent supporter la consommation électrique de tous les 

appareils qui y sont reliées.
• Avant de nettoyez votre ordinateur, assurez-vous qu’il n’est relié à aucune source de courant.

Nettoyage
• N’appliquez pas de produit de nettoyage directement sur l’ordinateur, utilisez un bout de tissu propre et souple. 
• N’utilisez pas de produit de nettoyage volatil (des distillés pétrôle) ou abrasifs sur aucun des éléments de l’ordinateur.

Mise en garde pour le sécurité electrique

Avant d’entreprendre des procédures de mise à niveau, assurez-vous d’avoir éteint l’ordina-teur, et déconnecté tous les périphériques et
câ-bles (y compris les cor-dons téléphoniques). Il est également conseillé d’enlever la batterie afin d’éviter d’allumer l’ap-pareil par mégarde.

Eteignez avant de partir en voyage

Assurez-vous que votre notebook est complètement éteint avant de le mettre dans un sac de voyage (ou tout autre bagage similaire). Si
vous placez le notebook allumé dans un sac de voyage, cela peut obstruer la (les) ventilation(s). Pour éviter que votre ordinateur ne sur-
chauffe, assurez-vous que rien n'obstrue la (les) ventilation(s) quand l'ordinateur est en cours d'utilisation.
84 -  Instructions d’entretien et d’utilisation



Guide Utilisateur Concis

Français
Précautions à prendre pour la batterie
• Utilisez uniquement des batteries conçues pour votre ordinateur. Un mauvais type de batterie peut provoquer des explosions, des fuites et/

ou endommager votre ordinateur.
• Ne continuez pas d'utiliser une batterie qui est tombée, ou qui paraît endommagée (ex: tordue ou vrillée) d'une manière quelconque. Même 

si l'ordinateur continue de fonctionner avec la batterie en place, cela peut détériorer le circuit, pouvant déclencher un incendie.
• Rechargez les batteries en utilisant le système de l’ordinateur portable. Un rechargement incorrect peut provoquer l’explosion de la batte-

rie.
• N’essayez jamais de réparer la batterie. Au cas où votre batterie aurait besoin d’être réparée ou changée, veuillez vous adresser à votre 

représentant de service ou à des professionnels qualifiés.
• Gardez les batteries endommagées hors de portée des enfants et débarrassez-vous en le plus vite possible. Veuillez toujours jeter les batte-

ries avec précautions. Les batteries peuvent exploser ou se mettre à fuire si elles sont exposées au feu ou si elles sont manipulées ou jetées 
d’une façon non appropriée.

• Gardez la batterie loin des appareils métalliques.
• Placez un morceau de scotch sur les contacts de la batterie avant de la jeter.
• Ne touchez pas les contacts de la batterie avec les mains ou avec des objects en métal.

Elimination de la batterie & avertissement

Le produit que vous venez d’acheter contient une batterie rechargeable. Cette batterie est recyclable. Quand elle n’est plus utili-
sable, en fonction des lois locales des différents états et pays, il peut être illégal de s’en débarrasser en la jetant avec les ordures
ménagères normales. Vérifiez auprès du responsible local de l’élimination des déchets solides de votre quartier pour vous informer
des possibilités de recyclage ou de la manière appropriée de la mettre au rebut.

Il existe un danger d’explosion si la batterie est replacée de façon incorrecte. Remplacez-la uniquement par des batteries de même
type ou de type équivalent, recommendé par le fabricant. Eliminez les batteries usagées selon les instructions du fabricant.
Instructions d’entretien et d’utilisation - 85
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Guide de démarrage rapide
1. Enlevez tous les emballages.
2. Posez l’ordinateur sur une surface stable.
3. Connectez fermement les périphériques que vous souhaitez utiliser avec votre ordinateur 

portable (par ex. clavier et souris) à leurs ports respectifs.
4. Branchez l'adaptateur CA/CC à la prise d'entrée CC à l’arrière de l’ordinateur, branchez 

ensuite le cordon secteur à une prise murale, puis à l’adaptateur CA/CC.
5. Déplacez les loquets du LCD à l'avant de l'ordinateur vers l'extérieur en direction des côtés de 

l'ordinateur, et maintenez-les ainsi pour libérer le couvercle.
6. Inclinez le couvercle/écran LCD de façon à obtenir un angle de vision confortable. Pressez le 

bouton de mise en marche pour allumer.

Différences entre modèles
Cette série de notebooks comprend deux types de design différents, cependant seulement un
type de design est illustré dans ce guide.

Arrêt

Veuillez noter que vous de-
vriez toujours éteindre vo-
tre ordinateur en utilisant la
commande Arrêter du
menu du bouton de ver-
rouillage de Windows Vis-
ta. Cette précaution évite
des problèmes de disque
dur ou de système.

Figure  1
Adaptateur CA/CC 

branché
86 -  Guide de démarrage rapide
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Logiciel système
Votre ordinateur peut être livré avec un logiciel système
pré-installé. Si ce n’est pas le cas, ou si vous re-configurez
votre ordinateur pour un système différent, vous constaterez
que ce manuel fait référence au système d’exploitation Mi-
crosoft Windows Vista. De plus amples informations sur
l’installation des pilotes et utilitaires sont disponibles aux
Chapitres 4 & 7 du Manuel de l’Utilisateur sur le DVD-
ROM Device Drivers & Utilities + User’s Manual.

Systèmes d'exploitation pris en charge

*Pour les informations sur le système d'exploitation Win-
dows XP, consultez le DVD-ROM Device Drivers & Utili-
ties + User’s Manual.

Non inclus
Les Systèmes d’exploitation (par ex. Windows Vista/
Windows XP, etc.) ainsi que les applications (par ex.
programmes de traitement de texte, tableur et base de
données) ont leurs propres manuels, aussi veuillez consulter
les manuels appropriés.

Pilotes

Si vous installez/réinstallez un nouveau logiciel système,
vous devrez installer les pilotes appropriés. Il est très impor-
tant d'installer les pilotes dans l'ordre indiqué dans le Tableau
5 à la page 101.

Module Intel Turbo Memory

Si votre option d'achat comporte un module de carte mémoire
flash NAND Intel Turbo Memory (Robson), vous devrez alors
activer l'option dans le BIOS AVANT d'installer le système
d'exploitation Windows Vista (n'activez pas cette option dans
Windows XP ou dans un système d'exploitation Windows Vis-
ta installé sans l'option activée). Voir la page 113.

Système d’exploitation Remarque

*Windows XP (Home Edition ou 
Professional)

Windows Vista (64-bit) Home 
Basic Edition

Pour utiliser Windows 
Vista sans limitations ni 
baisse de performances, 
votre ordinateur doit com-
porter au minimum 1Go de 

mémoire vive (RAM).

Windows Vista (64-bit) 
Home Premium Edition/Busi-

ness Editon/Enterprise Editon/
Ultimate Editon
Logiciel système - 87
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Carte du système : Vue du dessus avec l’écran LCD 
ouvert

Figure 2
 Vue du dessus avec 
l’écran LCD ouvert

1. Caméra PC optionnelle
2. Écran LCD 
3. Boutons Hot-Key
4. Bouton de mise en 

marche
5. Clavier
6. Pavé tactile (TouchPad) 

et boutons
7. Lecteur d'empreintes 

digitales optionnelle
8. Indicateurs 

d’alimentation et de 
communication

9. Microphone

7

6

2

1

5

7 8

6

43

9

Utilisation des appareils 
sans fil à bord d'un avion

L'utilisation de tout appareil
électronique de transmission
est généralement interdite à
bord d'un avion. Assurez-
vous que ces modules
(WLAN/Bluetooth) sont
éteints si vous utilisez l'ordi-
nateur à bord d'un avion. 

Utilisez les combinaisons de
touches pour basculer l'ali-
mentation sur les modules
WLAN/Bluetooth (voir le Tab-
leau 3 à la page 91), et repor-
tez-vous à l'icône d'indicateur

 pour voir si les modules
sont allumés ou pas  (voir le
Tableau 1 à la page 89).
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Indicateurs LED
Les indicateurs LED sur votre ordinateur affichent des informations utiles sur l’état actuel de votre ordinateur.

Tableau 1 - Indicateurs LED

Icône Couleur Description Icône Couleur Description

Vert L’ordinateur est allumé Orange La batterie est en charge

Vert 
clignotant

Le système est dans le 
mode de Veille configuré

Orange
clignotant

La batterie a atteint le niveau bas criti-
que

Orange L'adaptateur CA/CC est 
branchée Vert La batterie est complètement chargée

Vert Verrouillage numérique 
(pavé numérique) activé Vert Le disque dur est en cours d'utilisation

Vert Verrouillage majuscule 
activé Orange Le module Bluetooth est allumé

Vert Verrouillage défilement 
activé Vert Le module LAN sans fil est allumé
Indicateurs LED - 89
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Boutons Hot-Key & clavier
Les boutons Hot-Key donnent un accès instantané au
navigateur Internet par défaut et au programme de
messagerie, et à l’application que vous auriez définie par
une pression rapide (reportez-vous à “Bouton Hot-Key
d'application” à la page 92).

Tableau 2 - Boutons Hot-Key

Le clavier comporte un pavé numérique (sur le côté droit du
clavier) permettant une entrée facile de données
numériques. Le fait d'appuyer sur le touche Verr Num
active ou désactive le pavé numérique. Il est également doté
de touches fonction pour vous permettre de changer
instantanément de mode opérationnel.

Figure 3 - Clavier

Bouton Hot-Key Fonction

Activer l’application définie par l’utilisa-
teur, par ex. Microsoft Word ou Excel

Active le programme d’e-mail par 
défaut

Active le navigateur Internet par 
défaut

Pavé numérique
Touche Fn

Touches Fonction

Touche Verr Num/ArrêtDét

Caractères Spéciaux 

Certaines applications permettent que les touches du pavé nu-
mérique soient utilisées avec Alt pour produire des caractères
spéciaux. Ces caractères spéciaux peuvent être produits unique-
ment en utilisant le pavé numérique. Les touches normales des
chiffres (sur la rangée supérieure du clavier) ne le permettent
pas. Assurez-vous que Verr Num (pavé numérique) soit allumé.
90 -  Boutons Hot-Key & clavier
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Touches fonction & indicateurs visuels
Les touches de fonctions (F1-F12 etc.) agiront comme touches de raccourci (hot-key) quand pressée en maintenant la
touche Fn appuyée. En plus des combinaisons des touches de fonction de base, les indicateurs visuels sont disponibles
quand le pilote de touches de raccourci (HotKey Driver) est installé (reportez-vous à “Hot-Key” à la page 102). Une fois
le pilote installé une icône  apparaîtra dans la barre des tâches.

Touches Fonction/indicateurs visuels Touches Fonction/indicateurs visuels

Fn + ~ Lecture/Pause (dans les programmes audio/vidéo) Fn + F8/F9
Diminution/Augmenta-
tion de la luminosité 
de l’écran LCD

Fn + F1 Activer/Désactiver le 
TouchPad Fn + F10 Activer/Désactiver le 

module Caméra PC

Fn + F2 Eteindre le rétroéclairage LCD (appuyez sur une 
touche ou utilisez le TouchPad pour allumer) Fn + F11 Activer/Désactiver le 

module LAN sans fil

Fn + F3 Allume/Éteind le son Fn + F12 Activer/Désactiver le 
module Bluetooth

Fn + F4 Permutation veille Verr Num Activer/Désactiver le verrouillage numérique

Fn + F5/F6 Diminution/Augmen-
tation du volume 

Fn +
ArrêtDét Activer/Désactiver l'arrêt défilement

Fn + F7 Alternance d'affichage
Tableau 3 - Touches de fonctions & indicateurs vi-

suels
Boutons Hot-Key & clavier - 91
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Bouton Hot-Key d'application
Pour configurer l'ouverture d'un programme lorsque vous
appuyez sur le bouton Hot-Key d'application  (le
programme par défaut est Windows Media Player) suivez
les instructions ci-dessous.

1. Double-cliquez sur l'icône du pilote Hot-Key  dans la 
barre des tâches.

2. Cliquez sur  Launch user specified application (bouton) 
.

3. Une boîte de dialogue Ouvrir apparaîtra sur l’écran. 
4. Naviguez jusqu’au répertoire où l’application .exe du 

programme désiré se trouve (voir au-dessous).
5. Double-Cliquez  sur le fichier du programme ou 

choisissez Ouvrir, et cliquez sur OK.
6. Appuyez sur le bouton Hot-Key d'application  pour 

ouvrir le programme (tant que le pilote de touche de 
raccourci est en cours d'exécution dans la barre des 
tâches).

Figure 4 - Pilote Hot-Key

Application.exe

Vous aurez besoin de localiser le fichier exécutable (.exe),
pas seulement un raccourci. Pour trouver l’application, faites
un clic droit sur son raccourci sur le bureau, puis cliquez sur
Propriétés. Cliquez sur l’onglet Raccourci et regardez ou le
fichier exécutable est situé en cliquant sur le bouton Ouvrir
l’emplacement du fichier.

Pilote Hot-Key

Si vous cliquez sur l'icône Fermer , exécutez le program-
me à partir de l'emplacement du fichier :
(C:\Program Files (x86)\Hotkey_Driver\HotkeyDri-
ver.exe).
92 -  Boutons Hot-Key & clavier
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Carte du système : Vues de face & arrière Figure 5 
 Vues de face & arrière

1. Loquets de l’ecran LCD
2. Prise d'entrée de Ligne
3. Prise de sortie haut-

parleurs/casque
4. Prise d'entrée de 

microphone
5. Prise de sortie S/PDIF
6. Indicateurs 

d’alimentation et de 
communication

7. Emetteur-récepteur 
infrarouge/Emetteur-
récepteur infrarouge 
consommateur

8. Ventilation
9. Prise de sortie S-Vidéo
10. Port de Sortie DVI
11. 2 Ports USB 2.0
12. Prise d’entrée CC
13. Port série

Surchauffe

Afin de ne pas causer une surchauffe de votre ordinateur, verifiez que rien ne bouche la
(les) ventilation(s) quand le systeme est allume.

Ports USB

Notez que les connexions des ports USB se connectent dans un sens bien défini, ne les
forcez pas.  

1 1

2 3 4 5
6

8
9

7

8
10 11 12 13

Partie avant

arrière
Carte du système : Vues de face & arrière - 93



Guide Utilisateur Concis

Fr
an

ca
is
Carte du système : Vues droite & gaucheFigure 6  
Vues droite & gauche 

1. Logement 
d'ExpressCard/
54(34)

2. Lecteur de carte 7-
en-1

3. Port USB 2.0
4. Port Mini-IEEE 1394
5. Prise téléphone RJ-

11
6. Prise réseau RJ-45
7. Prise d'antenne 

câblée (CATV) 
(Activée avec le tuner 
TV seulement)

8. Haut-parleur
9. Fente de verrouillage 

de sécurité
10. Baie de périphérique 

optique (pour lecteur 
CD/DVD)

11. Trou d’ejection 
d’urgence

Port Mini-IEEE 1394

Le port Mini-IEEE 1394 ne supporte que
des périphériques IEEE 1394 A ALIMEN-
TATION AUTONOME.

Logement d'ExpressCard

Le logement d'ExpressCard accepte les for-
mats ExpressCard/34 ou ExpressCard/
54.

1
2

3 4 5 6 7
3 8

Côté droit

Ejection d’urgence du CD/DVD

Si vous devez éjecter manuellement un CD ou
DVD (par ex. suite à une coupure de courant)
vous pouvez enfoncer l’extrémité d’un trombo-
ne redressé dans le trou d’ejection d’urgence.
N’utilisez pas la pointe d’un crayon, ou tout
autre objet similaire qui pourrait se casser et
rester coincé dans le trou.

N’essayer pas d’enlever un CD/DVD pendant
que le système est en train de la lire ou d’y écri-
re. Vous pourriez faire « planter » le système.

1098 11

Côté gauche
94 -  Carte du système : Vues droite & gauche
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Carte du système : Vue d’en dessous Figure 7 
 Vue d’en dessous

1. Ventilation
2. Batterie
3. Loquets du 

périphérique optique
4. Couvercle de baie de 

composant 
5. Emetteur-récepteur 

infrarouge/Emetteur-
récepteur infrarouge 
consommateur 

6. Caisson de basses

Informations batterie

Décharger puis rechargez toujours complètement une batterie neuve avant de l'utiliser. Déchargez
complètement puis rechargez la batterie au moins une fois tous les 30 jours ou après environ 20 dé-
charges partielles. 

1
2

3
4

5

1

6

1
1

1

3
1

CPU

Veuillez ne pas essayer
d’ouvrir ou de forcer le proces-
seur UC de votre ordinateur.
Le fait d'accéder au CPU de
quelque manière que ce soit
risque de violer la garantie.

Surchauffe

Afin de ne pas causer une sur-
chauffe de votre ordinateur,
verifiez que rien ne bouche la
(les) ventilation(s) quand le
systeme est allume.
Carte du système : Vue d’en dessous - 95
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Menu Démarrer & Panneau de configuration de Windows Vista 
Vous pouvez accéder à la plupart des panneaux de contrôle, utilitaires et programmes dans Windows Vista (et la plupart des
autres versions de Windows) à partir du menu Démarrer. Quand vous installez des programmes et utilitaires ils seront installés
sur votre disque dur, et un raccourci sera habituellement placé dans le menu Démarrer et/ou le bureau. Faites un clic droit sur
l'icône menu Démarrer , et sélectionnez Propriétés si vous voulez personnaliser l'apparence du menu Démarrer.

A de nombreuses reprises dans ce manuel vous verrez une instruction pour ouvrir le Panneau de configuration. Vous pou-
vez accéder au Panneau de configuration à partir du menu Démarrer. Le Panneau de configuration vous permet de con-
figurer les paramètres pour la plupart des fonctionnalités clés dans Windows (ex. alimentation, vidéo, réseau, audio etc.).
Windows Vista offre les panneaux de contrôles de base pour un grand nombre des fonctionnalités, cependant de nouveaux
panneaux de contrôles sont ajoutés (ou certains existants sont améliorés) quand vous installez les pilotes énumérés dans le
Tableau  à la page 101.  Pour voir tous les contrôles il peut s'avérer nécessaire de basculer vers l'affichage classique.

 

Figure 8 - Menu Démarrer & Panneau de configuration

Cliquez ici pour basculer vers l'affi-
chage classique
96 -  Menu Démarrer & Panneau de configuration de Windows Vista
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Caractéristiques vidéo
Vous pouvez permuter les périphériques d'affichage depuis le panneau de contrôle Paramètres d'affichage dans Windows,
à partir du moment où le pilote vidéo est installé.
Pour accéder aux Paramètres d'affichage dans Windows Vista:

1. Cliquez sur le menu Démarrer, et cliquez sur Panneau de configuration (ou pointez sur Paramètres et cliquez sur Panneau de 
configuration).

2. Cliquez sur Ajuster la résolution de l'écran dan le menu Apparence et personnalisation (ou double-cliquez sur 
Personnalisation > Paramètres d'affichage).

3. Déplacez le curseur sur le paramètre préféré dans Résolution:  (voir la Figure 9 à la page 98).
4. Cliquez sur la flèche et faites défiler jusqu’au paramètre préféré dans Couleurs:  (voir la Figure 9 à la page 98).
5. Cliquez sur Paramètres avancés  pour faire apparaître les onglets Paramètres avancés (voir la Figure 9 à la page 98).
6. Cliquez sur GeForce..... (onglet).
7. Cliquez sur Démarrer le Panneau de configuration NVIDIA  (voir la Figure 9 à la page 98) pour accéder au panneau de 

configuration.
8. Vous pouvez aussi accéder au Panneau de configuration NVIDIA en cliquant avec le bouton droit de la souris sur le bureau et en 

faisant défiler le menu vers le bas et en cliquant sur Panneau de configuration NVIDIA.

1
2

3

4

Prise en charge des cartes vidéo

Remarquez que les types de carte, les spécifications et les pilotes passent par des mises à jour et des modifications continues. Consultez
votre service clientèle pour les derniers détails concernant les cartes vidéo prises en charge.
Caractéristiques vidéo - 97
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Périphériques & options d’affichage
En plus du LCD intégré, vous pouvez aussi utiliser un moniteur VGA externe/écran plat ou TV comme périphérique
d'affichage. Un moniteur VGA externe/écran plat se connecte au port de sortie DVI, une TV à la prise de sortie S-Vidéo.
Les modes d'affichage suivants sont disponibles. 
 

Tableau 4 - Modes d’affichage

Mode d’affichage Description

Simple Un des affichages connectés est utilisé comme périphérique d'affichage

Clone Les deux moniteurs donnent la même image

Double affichage (DualView) Les deux affichages connectés sont traités comme des périphériques séparés, et agissent 
comme un bureau virtuel

1 2

3

4

Figure 9 - Paramètres d'affichage
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Caractéristiques audio
Vous pouvez configurer les options audio sur votre ordinateur à partir du panneau de configuration de Sons  dan
Windows, ou à partir de l'icône du Gestionnaire audio DD Realtek /  dans la barre des tâches/panneau de
configuration (cliquez avec le bouton droit sur l'icône  de la barre des tâches pour faire apparaître un menu audio). Le
volume peut aussi être réglé à l'aide de la combinaison de touches Fn + F5/F6.

Figure 10 - Gestionnaire audio DD Realtek

Réglages du Volume Sonore

Le niveau du volume sonore est
réglé à l'aide du contrôle de volu-
me dans Windows (et les tou-
ches de fonctions de volume sur
l'ordinateur). Cliquez sur l'icône
Volume dans la barre des tâch-
es pour vérifier le réglage. Cliquez avec le bou-

ton droit sur l'icône  
pour accéder au
menu ci-dessus.
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Caractéristiques de gestion de l’alimentation
Le panneau de configuration Options d'alimentation de votre système Windows (voir la page 96) vous permet de confi-
gurer la gestion d'alimentation de votre ordinateur. Vous pouvez économiser de l'énergie à l'aide de modes de gestion de
l'alimentation et configurer les options pour le bouton d'alimentation, bouton de veille, couvercle de l'ordinateur
(lorsqu'il est fermé), mode Affichage et Veille dans le menu de gauche. Remarquez que le mode de gestion d'économie
d'énergie peut avoir un impact sur les performances de l'ordinateur.

Cliquez pour sélectionner l'un des modes existants, ou cliquez sur Créer un mode de gestion d'alimentation dans le menu
gauche et sélectionnez les options pour créer un nouveau mode. Cliquez sur Modifier les paramètres du mode et cliquez
sur Modifier les paramètres d'alimentation avancés pour accéder à plus d'options  de configuration.

Figure 11 - Options d’alimentation
Remarque : Veille est l'état d'économie d'énergie par défaut dans Windows Vista  
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Installation du pilote
Le DVD-ROM Device Drivers & Utilities + User’s Manual
contient les pilotes et les utilitaires nécessaires pour un bon
fonctionnement de votre ordinateur. Insérez le DVD-ROM
et cliquez sur Install Drivers (bouton) ou cliquez sur
Optional (bouton) pour accéder au menu de pilote
optionnel.

Installez les pilotes en respectant l'ordre indiqué dans le
Tableau 5. Après avoir installé chaque pilote il apparaîtra
en grisé (si vous devez réinstaller un pilote, cliquez sur le
bouton Unlock).

Installation manuelle du pilote
Cliquez le bouton Browse CD (Parcourir le CD) dans
l'application Drivers Installer et naviguer jusqu'au fichier
exécutable dans le dossier de pilote approprié.

Windows Update
Après avoir installé tous les pilotes vérifiez que vous avez
activé Windows Update afin d'obtenir toutes les dernières
mises à jour de sécurité etc. (toutes les mises à jour
incluront les derniers correctifs de Microsoft).

Tableau 5 - Procédure d'Installation

Pilote (Windows Vista) Page #

Chipset page 102

Vidéo page 102

Son page 102

Modem page 102

Lecteur de carte/ ExpressCard page 102

Réseau page 102

Pavé tactile (TouchPad) page 102

Hot-Key page 102

LAN sans fil  (option) page 103

Bluetooth (option) page 104

Caméra PC (option) page 105

Lecteur d'empreintes digitales (option) page 108

Consommateur infrarouge (option) page 111

TV-Tuner (option) page 111

Intel Turbo Memory (option) page 113

Activer Windows Update (voir à gauche)
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Chipset
1. Cliquez sur Install Drivers.
2. Cliquez sur 1.Install Chipset Driver > Oui.
3. Cliquez sur Suivant > Oui > Suivant > Suivant.
4. Cliquez sur Terminer pour redémarrer votre ordinateur.

Vidéo
1. Cliquez sur Install Drivers.
2. Cliquez sur 2.Install Video Driver > Oui.
3. Cliquez sur Suivant.
4. Cliquez sur Terminer pour redémarrer votre ordinateur.

Son
1. Cliquez sur Install Drivers.
2. Cliquez sur 3.Install Audio Driver > Oui. 
3. Cliquez sur Suivant.
4. Cliquez sur Terminer pour redémarrer votre ordinateur.

Modem
1. Cliquez sur Install Drivers.
2. Cliquez sur 4.Install Modem Driver > Oui. 
3. Cliquez sur OK.
4. Le modem est prêt pour la configuration de connexion.

ExpressCard / Lecteur de carte
1. Cliquez sur Install Drivers.
2. Cliquez sur 5.Install CardReader Driver > Oui.
3. Cliquez sur Suivant > Suivant.
4. Cliquez sur Terminer pour redémarrer votre ordinateur.

Réseau
1. Cliquez sur Install Drivers.
2. Cliquez sur 6.Install LAN Driver > Oui.
3. Cliquez sur Suivant > Installer.
4. Cliquez sur Terminer.

Pavé tactile (TouchPad)
1. Cliquez sur Install Drivers.
2. Cliquez sur 7.Install Touch Pad Driver > Oui.
3. Cliquez sur Suivant > Suivant > Suivant.
4. Cliquez sur Terminer pour redémarrer votre ordinateur.

Hot-Key
1. Cliquez sur Install Drivers.
2. Cliquez sur 8.Install Hotkey Driver > Oui.
3. Cliquez sur Next > Install.
4. Cliquez sur Finish > Finish pour redémarrer votre 

ordinateur.
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LAN sans fil

Installation du pilote du LAN sans fil
1. Assurez-vous que le module est allumé.
2. Cliquez sur Optional (bouton).
3. Cliquez sur 1.Install Intel WLan driver > Oui.
4. Cliquez sur Installer le logiciel.
5. Cliquez sur le bouton J’accepte les termes de ce contrat 

de licence, puis cliquez sur Suivant. 
6. Cliquez sur Suivant > OK pour terminer l'installation.

Remarque: Le système d'exploitation est le paramètre par dé-
faut pour le contrôle LAN sans fil dans Windows Vista. 

Se connecter à un réseau sans fil
Assurez-vous que le module LAN sans fil est allumé.

1. Cliquez sur l'icône de  WLAN  dans la barre des tâches, et 
puis cliquez sur Connexion à  un réseau (ou cliquez avec le 
bouton droit de la souris sur l'icône , et puis cliquez sur 
Connexion à  un réseau).

2. Dans la liste Afficher, cliquez pour choisir Sans fil dans le 
menu déroulant.

3. Une liste des réseaux actuellement disponibles apparaîtra.
4. Cliquez sur un réseau, et cliquez ensuite sur Connecter.
5. Si vous ne voyez pas de réseau auquel vous voulez vous 

connecter, cliquez sur Configurer une connexion ou un 
réseau (une liste d'options apparaîtra permettant une 
recherche manuelle, et créant un nouveau réseau).

6. Déplacez le curseur sur l'icône  de la barre des tâches 
pour voir l'état de la connexion.

7. Pour vous déconnecter du réseau sans fil, vous pouvez 
cliquer sur l'icône , sans fil de la barre des tâches, et 
sélectionner ensuite Se connecter ou se déconnecter pour 
accéder au menu réseau, et cliquez sur Déconnecter (ou 
cliquez avec le bouton droit de la souris sur l'icône , et puis 
cliquez sur Déconnexion de).

Actionner l'alimentation pour le module LAN sans fil

Allumer le module LAN sans fil à l'aide de la combinaison de
touches (Fn + F11). Quand le module LAN sans fil est sous
tension, la LED   sera vert et l'indicateur  s'affichera
brièvement.
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Bluetooth

Installation du pilote Bluetooth
1. Assurez-vous que le module est allumé.
2. Cliquez sur Optional (bouton).
3. Cliquez sur 2.Install BlueTooth driver > Oui.
4. Choisissez la langue que vous préférez, et cliquez sur OK 

> Next.
5. Cliquez sur le bouton I accept the terms of the license 

agreement, puis cliquez sur Next. 
6. Cliquez sur Next > Installer.
7. Cliquez sur Finish > Yes pour redémarrer votre ordinateur.

Connexion de réseau local Bluetooth
Vous pouvez vérifier l'état de la connexion Bluetooth dans
le Centre Réseau et partage :

1. Utilisez la combinaison de touches Fn + F12 pour allumer 
le module Bluetooth.

2. Démarrez le programme IVT Corporation BlueSoleil 
depuis l'icône du bureau ou le menu Démarrer.

3. Cliquez sur le menu Démarrer, et cliquez sur Panneau de 
configuration (ou pointez sur Paramètres et cliquez sur 
Panneau de configuration).

4. Double-cliquez sur Centre Réseau et partage (Réseau et 
Internet).

5. Cliquez sur Gérer les connexions réseau.
6. L'état de la connexion Bluetooth sera alors affiché dans le 

panneau de configuration.
7. Pour déconnecter cliquez sur Fichier dans la IVT 

Corporation BlueSoleil - Fenêtre Principale, et 
sélectionnez Quitter (la connexion au réseau local 
affichera "câble réseau débranché").

8. Ne pas utiliser le bouton Fermer  ni la combinaison de 
touches Fn + F12 avant de cliquer sur Fichier > Quitter 
ou l'état correct ne sera pas affiché.

9. Vous pouvez utiliser la combinaison de touches Fn + F12 
pour éteindre le module Bluetooth (observez l'icône de 
LED pour l'état d'alimentation du module Bluetooth).

Actionner l'alimentation pour le module Bluetooth

Allumer le module Bluetooth à l'aide de la combinaison de
touches (Fn + F12). Quand le module Bluetooth est sous ten-
sion, la LED  sera orange et l'indicateur  s'affichera
brièvement.
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Caméra PC
Deux options de caméra sont disponibles pour cet ordina-
teur. Le module de caméra 1,3M pixels utilise l'application
BisonCap pour capturer les fichiers vidéo. Le module de
caméra 2,0M pixels utilise l'application VideoView pour
capturer les fichiers vidéo.

Installation du pilote de la caméra PC
Pour caméra PC 1,3M pixels:
1. Activez le module à l'aide de Fn + F10 (l'indicateur   

s'affichera brièvement lors de l'activation du module).
2. Cliquez sur Optional (bouton).
3. Cliquez sur 3.PC Camera, Web cam > Oui.
4. Choisissez la langue que vous préférez, et cliquez Suivant 

> Suivant.
5. Cliquez sur Terminer pour redémarrer votre ordinateur.
6. Exécutez le programme d'application BisonCap à partir 

du raccourci sur le bureau, ou à partir de l'élément 
BisonCam dans le menu Démarrer > Programmes/Tous 
les programmes (si le matériel est éteint utilisez la 
combinaison de touches Fn + F10 pour le rallumer).

Pour caméra PC 2,0M pixels:
1. Activez le module à l'aide de Fn + F10 (l'indicateur   

s'affichera brièvement lors de l'activation du module).
2. Cliquez sur Optional (bouton).
3. Cliquez sur 3.PC Camera, Web cam > Oui.
4. Cliquez sur Installer.
5. Cliquez sur sélectionner Oui ou Non pour répondre à la 

question sur le système d'alimentation.
6. Cliquez sur Terminer > Terminer pour redémarrer votre 

ordinateur.
7. Exécutez le programme d'application VideoView à partir 

du raccourci sur le bureau, ou à partir de l'élément USB2.0 
PC Camera dans le menu Démarrer > Programmes/
Tous les programmes (si le matériel est éteint utilisez la 
combinaison de touches Fn + F10 pour le rallumer).
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Paramétrage audio de caméra PC
Si vous souhaitez capturer de la vidéo et du son avec votre
caméra, il est nécessaire de régler les options d'enregistre-
ment du son dans Windows.

1. Cliquez sur le menu Démarrer, et cliquez sur Panneau de 
configuration (ou pointez sur Paramètres et cliquez sur 
Panneau de configuration).

2. Cliquez sur Son  (Matériel et audio).
3. Cliquez sur Enregistrement (onglet).
4. Cliquez avec le bouton droit de la souris sur Microphone 

(Realtek High Definition Audio) et vérifiez que l'élément n'est 
pas désactivé.

5. Double-cliquez sur Microphone (ou sélectionnez Propriétés 
dans le menu contextuel).

6. Cliquez sur Niveaux (onglet), et réglez les curseurs 
Microphone et Ampli microphone au niveau requis.

7. Cliquez sur OK et fermez les panneaux de contrôle.
8. Exécutez le programme d'application BisonCap/VideoView à 

partir de l'élément BisonCam/USB2.0 PC Camera dans le 
menu Démarrer > Programmes/Tous les programmes.

9. Allez aux en-têtes de menu des Périphériques/Devices et 
sélectionnez Microphone (Realtek....) (il devrait y avoir une 
marque sur le côté)

10. Allez aux en-têtes de menu des Capture et sélectionnez 
Capture Audio (il devrait y avoir une marque sur le côté).

BisonCap/VideoView
Les applications BisonCap (pour la caméra de 1,3M pixels) et
VideoView (pour la caméra de 2,0M pixels) sont des visionneu-
ses vidéo utiles pour les visualisations et les tests vidéo cou-
rants, et permettent de capturer des fichiers vidéo au format .avi.

1. Démarrez le programme BisonCap/VideoView  par le menu 
Démarrer > Programmes/Tous les Programmes  > Bison-
Cam/USB2.0 PC Camera (il est recommandé de Définir le 
fichier de capture avant la capture - voir "Définir le fichier 
de capture" ci-dessous).

2. Allez à l'en-tête du menu Capture (si vous désirez capturer de 
l'audio, consultez "Paramétrage audio de caméra PC") et 
sélectionnez Démarrer la capture/Start Capture.

3. Cliquez sur OK (l'emplacement du fichier s'affichera dans la 
fenêtre contextuelle) pour démarrer la capture, et appuyez sur 
Echap pour arrêter (vous pouvez visionner le fichier en 
utilisant Windows Media Player).

Définir le fichier de capture
Avant de capturer des fichiers vidéo vous pouvez sélectionner
l'option Définir le fichier de capture/Set Capture File dans
le menu Fichier/File et définir le nom et l'emplacement du fi-
chier avant de capturer (ceci permettra d'éviter d'écraser acci-
dentellement des fichiers). Définissez le nom et l'emplacement
puis cliquez sur Ouvrir, puis définissez la "Taille du fichier de
capture :" et cliquez sur OK. Vous pouvez alors lancer le pro-
cessus de capture comme ci-dessus.
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Zoom 
Les programmes BisonCap et VideoView vous permettent
de faire un zoom avant et arrière avec la caméra.
Pour BisonCap:
1. Exécutez le programme d'application BisonCap.
2. Allez à l'en-tête du menu Zoom et sélectionnez Zoom avant/ 

Zoom arrière.

Pour VideoView:
1. Exécutez le programme d'application VideoView.
2. Allez à l'en-tête du menu Options et sélectionnez Setting 

(utilisez le curseur pour ajuster le niveau du zoom, et cliquez 
sur OK pour enregistrer le paramètre).

Prendre des images fixes
Les programmes BisonCap et VideoView vous permettent
de prendre des images fixes.
1. Exécutez le programme d'application BisonCap/VideoView.
2. (BisonCap) Allez à l'en-tête du menu Options et 

sélectionnez Prendre une photo.                                              
ou
(VideoView) Allez à l'en-tête du menu Capture et 
sélectionnez SnapShot.

3. L'image (au format JPEG) sera placée dans le dossier Snaps-
hot  sur le bureau (ne pas déplacer ni renommer le dos-
sier).

Eliminer le scintillement d'écran
Si vous trouvez que l'écran vidéo dans le programme Bison-
Cap/VideoView scintille, vous pouvez essayer d'ajuster le
paramètre dans les options Video Capture Filter... (Filtre
de capture vidéo).

Pour BisonCap:
1. Exécutez le programme d'application BisonCap.
2. Allez à l'en-tête du menu Options et sélectionnez Video 

Capture Filter....
3. Cliquez sur 50Hz ou 60Hz sous Fréquence dans l’onglet  

Page de propriétés.

Pour VideoView:
1. Exécutez le programme d'application VideoView.
2. Allez à l'en-tête du menu Options et sélectionnez Video 

Capture Filter....
3. Cliquez sur 50Hz ou 60Hz sous Flickering Reduction dans 

l’onglet Image.
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Lecteur d'empreintes digitales
Si votre option d'achat comporte un lecteur d'empreintes di-
gitales vous devrez installer le pilote en vous reportant aux
instructions ci-dessous. 
Vérifiez que vous avez les droits d'administrateur sur votre
ordinateur, et que vous avez un mot de passe Windows
activé pour une protection totale.

Avant de commencer le processus d'enregistrement, il est
recommandé de prendre connaissance du didacticiel d'em-
preintes digitales. Pour lancer le didacticiel cliquez sur Dé-
marrer > Programmes/Tous les programmes >
Protector Suite QL > Didacticiel de Fingerprint.

Installation du pilote du lecteur 
d'empreintes digitales
1. Cliquez sur Optional (bouton).
2. Cliquez sur  4.Install FingerPrint Driver > Oui.
3. Cliquez sur  Installation du logiciel.
4. Cliquez sur  Suivant > Suivant > Suivant.
5. Cliquez sur Terminer > Qui pour terminer l'installation.

Enregistrement de l'utilisateur
1. Cliquez sur Démarrer > Programmes/Tous les program-

mes > Protector Suite QL > Enregistrement d’utilisateurs, 
ou double-cliquez sur l’icône  dans la barre des tâches. 

2. Lors du premier lancement du programme, vous serez invité à 
cliquer sur le bouton pour accepter la licence, et cliquer ensuite 
sur OK.

3. Cliquez sur Suivant et sélectionnez “Enregistrement sur le 
disque dur”, et cliquez sur Oui.

Aide & Manuel

Faites un clic droit sur l'icône  de la barre des tâches pour
faire apparaître le menu afin de sélectionner Aide.

Insérez le DVD-ROM Device Drivers & Utilities + User’s Ma-
nual et cliquez sur Optional (bouton). Cliquez sur Unlock
(bouton) et puis cliquez sur 4.Install FingerPrint Driver >
Oui.

Cliquez sur Documentation pour ouvrir le dossier contenant
le manuel au format .pdf.

Pour installer le logiciel Adobe Acrobat Reader pour lire le fi-
chier, insérez le DVD-ROM Device Drivers & Utilities + User's
Manual et cliquez sur User's Manual (bouton), et cliquez sur
Install Acrobat Reader (bouton).
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4. Si vous n'avez pas défini de mot de passe de Windows vous 
serez invité à le faire (remarque: Si vous n'avez pas défini de 
mot de passe, Protector Suite QL ne peut pas sécuriser 
l'accès à votre ordinateur).

5. Cliquez sur Suivant et vous serez invité à entrer votre mot de 
passe de Windows.

6. Cliquez sur Suivant > Suivant (cochez la case à cocher 
“Lancer le didacticiel interactif” pour prendre connaissance 
du didacticiel Fingerprint).

7. Cliquez sur Suivant pour chaque fenêtre du didacticiel (vous 
pouvez cliquer sur le bouton “Passer le didacticiel” à tout 
moment).

8. Cliquez sur le bouton au-dessus l'un des doigts pour lancer 
l'enregistrement de ce doigt.

9. Tapez trois fois le doigt pour enregistrer ce doigt.
10. Répétez le processus pour tous les doigts que vous voulez 

enregistrer, puis cliquez sur Suivant.
11. Cliquez sur Terminer.
12. Cliquez sur l'un des en-têtes “En savoir plus sur” pour 

obtenir plus d'informations sur tous les sujets.
13. Cliquez sur Fermer.
14. Redémarrez l'ordinateur.
15. Faites un clic droit sur l'icône  de la barre des tâches pour 

faire apparaître le menu vous permettant d'Modifier les 
empreintes digitales, Lancer le Centre de contrôle, accéder 
au menu Aide etc. Vous pouvez aussi exécuter le Centre de 
contrôle etc. à partir de l'élément Protector Suite QL dans le 
menu Démarrer > Programmes/Tous les programmes.

16. Reportez-vous à “Aide & Manuel” à la page 108 pour plus 
de détails.

17. Si vous passez votre doigt sur le lecteur, à tout moment, vous 
pouvez accéder au Biomenu pour Verrouiller l'ordinateur, 
Enregistrer des sites web, Déverrouiller Mon coffre, ouvrir 
le Centre de contrôle et accéder au menu Aide.

18. Le Centre de contrôle vous permet de modifier les 
Paramètres, enregistrement d'empreintes numériques et 
d'obtenir de l'Aide.

Figure 12 - Centre de contrôl & Biomenu

Enregistrement de l'empreinte digitalet

Il est fortement recommandé d'enregistrer plus d'un doigt
en cas de blessure etc.
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Module Tuner TV USB
Un CD contenant les pilotes, logiciels et un guide de l'utilisateur seront fournis si vous la
configuration que vous avez achetée inclus le module de Tuner TV USB optionnelle. De
plus, un pilote est fourni sur le DVD-ROM Device Drivers & Utilities + User's Manual pour
la télécommande fournie avec le Tuner TV.

Vous recevrez aussi une télécommande et une antenne appropriée s'adaptant au module
Tuner TV USB.

Avec le tuner TV installé vous pouvez regarder la TV, participer à des conférences vidéo et
capturer des images fixes et vidéo sur votre ordinateur.

La prise d'antenne câblée (CATV) sera disponible uniquement quand le module du
Tuner TV est installé. Prenez soi d'installer les logiciels avant de connecter l'antenne de
TV.

Antenne TV

L'antenne TV fournie avec
tout module Tuner TV est
destinée à une utilisation
intérieure seulement. N'uti-
lisez pas votre module Tu-
ner TV à l'EXTÉRIEUR.

Télécommande du tuner 
TV

Dirigez la télécommande
vers l'émetteur-récep-
teur infrarouge consom-
mateur du client pour
changer les chaînes etc.

Figure 13 
 Ports et prises du tuner 

TV

1. Emetteur-récepteur 
infrarouge/Emetteur-
récepteur infrarouge 
consommateur

2. Prise d'antenne câblée 
(CATV)

2

1
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Installation du pilote infrarouge client
1. Cliquez sur Optional (bouton).
2. Cliquez sur 5.Install ITE CIR Driver > Oui.
3. Cliquez sur Next > Yes > Next  > Finish.

Installation du pilote de tuner TV 
1. Insérez le CD du pilote de tuner TV dans le lecteur de CD/

DVD.
2. Cliquez sur MC770A Driver V2.3.3.3 Setup for XP/

Vista.
3. Cliquez sur Install > OK.
4. Cliquez sur S/W Encoder V1.0.70807 Setup for Vista 

pour installer l’encodeur logiciel.
5. Cliquez sur Suivant.
6. Cliquez sur le bouton J’accepte les termes de la licence, 

puis cliquez sur Suivant. 
7. Cliquez sur Suivant > Suivant > Suivant > Terminer.
8. Cliquez sur AP V2.0.1810.70802 Setup for XP/Vista 

pour installer l’application.
9. Cliquez sur Suivant.
10. Cliquez sur le bouton J’accepte les termes de la licence, 

puis cliquez sur Suivant. 
11. Cliquez sur Suivant (assurez-vous d'avoir entré un Nom 

d'utilisateur et de société).
12. Tapez la clé du CD fourni, et cliquez sur Suivant.

13. Choisissez la langue que vous préférez, et cliquez sur 
Suivant.

14. Cliquez sur Suivant > Suivant > Suivant.
15. Cliquez sur le bouton pour redémarrer votre ordinateur, et 

cliquez sur Suivant.
16. Cliquez sur Terminer pour redémarrer votre ordinateur.
17. Exécutez le programme d'application Hybrid DTV  à 

partir du raccourci sur le bureau, ou à partir de l'élément 
DTVplayer dans le menu Démarrer > Programmes/
Tous les programmes  > Hybrid DTV.
ou

18. Exécutez Windows Media Center directement à partir du 
menu Démarrer (Démarrer > Programmes/Tous les 
programmes > Windows Media Center).

19. Aide et support de Windows fournit des informations sur 
les fonctions de Windows Media Center. Cliquez sur 
Démarrer  et sélectionnez Aide et Support, et tapez 
ensuite "Media Center" dans la boîte  Recherche d'aide 
et cliquez sur l'icône d'une loupe  pour faire apparaître 
les résultats.

Windows Media Center

Remarquez que le logiciel Windows Media Center est inté-
gré dans les éditions Windows Vista Home Premium et Ul-
timate seulement. 
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Signal de diffusion TV numérique
L'antenne est le facteur le plus crucial pour la réception d'un
signal de diffusion TV terrestre numérique clair. L'antenne
passive fournie devrait donner un signal clair quand elle est
placée près d'une fenêtre. Si le signal n'est pas claire, vous
pouvez alors acheter une antenne active (elle doit aussi être
placée près d'une fenêtre) pour améliorer le signal. Vous
devez aussi consulter les sites web du gouvernement
fournissant des informations sur la couverture TV terrestre
numérique pour votre région.  Remarquez que
(contrairement à la TV analogique standard) si le signal
numérique est faible, aucune image n'apparaîtra sur l'écran
de TV.

Enregistrement TV et modes de gestion d'ali-
mentation
Si vous avez l'intension d'utiliser le Tuner TV optionnel
pour enregistrer la TV en direct, allez au panneau de
contrôle des Options d'alimentation  et créez un plan
unique pour empêcher les options d'économie d'énergie
d'ajuster le niveau de performances de l'ordinateur.

Télécommande
La télécommande vous permet de mettre en marche le
système et de le mettre dans un état d'économie d'énergie,
pour exécuter Windows Media Center et de naviguer dans
les menus de Media Center etc. La télécommande vous
donnera aussi un contrôle complet de toutes les TV et
fonctions de vidéo.

Sécurité du câble CATV

Vérifiez que votre installateur du système CATV a connecté
le blindage du câble coaxial au dispositif de mise à la terre du
bâtiment, aussi près du point d'entrée du câble que possible.

Ce rappel est destiné à attirer l'attention de l'installateur du
système CATV sur l'article 820-93 de la NEC (Section 54,
Partie I du Canadian Electrical Code - Code électrique cana-
dien).
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Module Intel Turbo Memory
Si votre option d'achat comporte un module de carte mémoire flash NAND Intel Turbo Me-
mory (Robson), vous devrez alors activer l'option dans le BIOS AVANT d'installer le sys-
tème d'exploitation Windows Vista (n'activez pas cette option dans Windows XP ou dans un
système d'exploitation Windows Vista installé sans l'option activée).

La technologie Intel Turbo Memory (aussi appelée Robson flash memory) est une tech-
nologie Intel réduisant le temps nécessaire à un ordinateur pour démarrer, charger des ap-
plications, et écrire des données sur le disque dur. La technologie Intel Turbo Memory est
supportée dans Windows Vista seulement (elle supporte aussi les fonctionnalités de Win-
dows Vista telles que ReadyBoost, ReadyDrive, et Superfetch).

Configuration d'Intel Turbo Memory et installation du pilote
1. Allumez l’ordinateur et appuyez sur F2 pour aller dans le BIOS.
2. Allez au menu Advanced.
3. Sélectionnez Advanced Chipset Control et appuyez sur Entrée.
4. Appuyez sur la barre d'espace pour vous assurer que Intel Robson est Activé (Enabled).
5. Allez au menu Boot.
6. Configurez le lecteur de CD-ROM/DVD-ROM (vérifiez que le CD Microsoft Windows 

Vista OS est inséré) comme premier périphérique dans l'ordre de boot dans le menu Boot 
priority order.

7. Sélectionnez Exit Saving Changes du menu Exit (ou appuyez sur F10 et Entrée) et 
appuyez sur Entrée pour sortir du BIOS et démarrer l'ordinateur.

8. Appuyez sur une touche quand vous voyez le message "Press any key to boot from CD or 
DVD".

Problème concernant 
ReadyBoost

Quand la  Console mé-
moire Intel® Turbo est
ouverte immédiatement
après avoir allumé le systè-
me, Windows Ready-
Boost peut apparaître
comme désactivé.

C’est un comportement
prévu. L’état apparaît com-
me étant désactivé alors
que Microsoft génère le fi-
chier Windows Ready-
Boost. Une fois que le
fichier a été généré, l’état
devrait à nouveau apparaî-
tre comme Activé.

Voir le site web d’Intel
(http://support.intel.com/
support/chipsets/itm/sb/
CS-025852.htm) pour les
dernières informations mi-
ses à jour concernant ce
problème.
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9. Le logiciel du système vous indiquera la marche à suivre tout au long de la procédure d'installation (voir votre 
documentation de Windows Vista pour plus de détails).

10. Installez les pilotes conformément aux instructions dans “Installation du pilote” à la page 101  (assurez-vous que les pilotes 
sont installés dans l'ordre indiqué dans le Tableau  à la page 101).

11. Insérez le DVD-ROM Device Drivers & Utilities + User’s Manual dans le lecteur de CD/DVD.
12. Cliquez sur Optional (bouton).
13. Cliquez sur 6.Install Robson Driver > Oui.
14. Cliquez sur Suivant > Qui > Suivant > Suivant.
15. Cliquez sur Terminer pour terminer l'installation.
16. Après avoir redémarré l'ordinateur, cliquez sur Redémarrer maintenant pour terminer la procédure d'installation une fois 

que l'ordinateur a effectué les modifications matérielles nécessaires.

Figure 14 - Menus Advanced & Advanced Chipset Control du BIOS

Main Advanced Security Boot Exit

F1 Help �� Select Item -/+ Change Values F9 Setup Defaults
Esc Exit �� Select Menu Enter Select �Sub-Menu F10 Save and Exit

Item Specific Help

Advanced

Select options for
Advanced Chipset
features.

Phoenix TrustedCore(tm) Setup Utility

�Advanced Chipset Control
Reset Configuration Data: [No]
Local Bus IDE adapter: [Both]

Boot-time Diagnostic Screen: [Enabled]
Legacy USB Support: [Enabled]
USB 2.0 Enable: [Enabled]
POST Beep Sound [Disabled]
Battery Low Alarm Beep: [Disabled]

F1 Help �� Select Item -/+ Change Values F9 Setup Defaults
Esc Exit �� Select Menu Enter Select �Sub-Menu F10 Save and Exit

Item Specific Help

Advanced

Phoenix TrustedCore(tm) Setup Utility

Intel Turbo Memory
Technology

Advanced Chipset Control

Intel Robson [Enabled]
SATA - Device 31, Function 2: [Enhanced]
AHCI Configuration Enabled]
DFOROM(Robson) Support: [Enabled]
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Dépannage
Problème Cause possible - résolution

Je ne peux plus changer les 
codes régionaux en passant 
par l’utilitaire DVD.

Le code a été modifié les 5 fois maximum. La détection de codes régionaux est liée à l'appareil, pas 
au système d’exploitation. Vous pouvez changer le code régional de votre module 5 fois. La 
cinquième sélection est permanente. Elle ne peut pas être changée même si vous changez votre 
système d’exploitation ou si vous utilisez le module dans un autre ordinateur.

Le TouchPad ne fonctionne 
pas.

Le TouchPad  a été désactivé. Appuyez sur la combinaison de touches (Fn + F1) (assurez-vous que 
vous avez installé le pilote du TouchPad).

Les modules LAN sans fil/ 
Bluetooth ne peuvent pas 
être détectés.

Le(s) module(s) est (sont) désactivé(s). Vérifiez l'indicateur LED  pour voir si le(s) module(s) est 
(sont) activé(s) ou désactivé(s) (reportez-vous à “Indicateurs LED” à la page 89). Si l'indicateur 
LED est désactivé, alors appuyez sur la combinaison de touches appropriée pour activer le module 
(reportez-vous à “Touches fonction & indicateurs visuels” à la page 91).

Le logiciel de la caméra PC 
affiche un écran noir quand 
le logiciel de la caméra PC 
est en cours d'exécution.

Le logiciel n'utilise pas le périphérique correct. Si vous avez les modules de caméra PC et de tuner 
TV optionnels présents, allez au menu  Périphériques/Devices dans le programme BisonCap/
VideoView et sélectionnez le périphérique de BisonCam, NB Pro/USB2.0 2M WebCam (caméra 
PC).

Les fichiers vidéo capturés 
depuis la caméra PC 
prennent trop de place sur 
le disque.

Notez que la capture de fichiers vidéo à haute résolution nécessite un espace substantiel sur le 
disque pour chaque fichier.

Notez que le système Windows Vista nécessite un minimum de 15Go d'espace libre sur la partition 
système du lecteur C:. Il vous est recommandé d'enregistrer le fichier vidéo capturé dans un autre 
emplacement que le lecteur C:, limitez la taille du fichier de la vidéo capturée ou réduisez la 
résolution vidéo (Options > Video Capture Pin... > Taille de sortie).
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Erreur de résolution d'écran
Si vous rencontrez une diminution de la résolution de l'écran, ou un scintillement de l'écran, après être sorti de l'état de
Veille dans Windows Vista seulement suivez alors les instructions ci-dessous pour résoudre ce problème. Cette erreur se
produit conformément à la stratégie de Windows Vista, qui déclenche TMM (Transient Multimon Manager) quand le
couvercle du notebook (S3) est fermé. TMM déconnecte l'affichage LCD de l'OS et rajoute ensuite l'affichage LCD quand
le couvercle est ouvert. Cela peut déclencher le rétablissement des paramètres d'un ancien affichage par TMM qui peut
entraîner le scintillement de l'écran ou d'un changement de résolution d'écran.

1. Cliquez sur le menu Démarrer, et cliquez sur Panneau de configuration (ou pointez sur Paramètres et cliquez sur Pan-
neau de configuration) et double-cliquez sur Outils d’administration (Système et maintenance).

2. Double-cliquez sur Planificateur de tâches (Tâches planifinées).
3. Double-cliquez sur Bibliothèque du Planificateur de tâches > Microsoft > Windows, et cliquez sur MobilePC pour 

ouvrir le panneau de configuration.
4. Cliquez avec le bouton droit de la souris sur TMM et sélectionnez Désactiver, et fermez tous les panneaux de contrôle.

Figure 15 - Système et maintenance (Panneau de configuration)
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Spécifications

Caractéristique Spécification

Types de 
processeurs

Processeur Intel Core 2 Duo
Micro-FCPGA package (478-broches)
T7100

(65nm) Procédé de gravure en 65 nm
Cache 2Mo L2 & Bus principal à 800MHz 
1,80 GHz

Processeur Intel Core 2 Duo
Micro-FCPGA package (478-broches)
T7300/ T7500/ T7700 

(65nm) Procédé de gravure en 65 nm
Cache 4Mo L2 & Bus principal à 800MHz 
2,0/ 2,2/ 2,4 GHz

Core logic Chipset Intel(R) PM965 + ICH8M

Mémoire Deux emplacements SODIMM 200 broches, supportant la mémoire DDRII 533/ 667
Mémoire extensible jusqu’à 4Go

Sécurité Fente de verrouillage de sécurité (type Kensington)
Lecteur d'empreintes digitales (Option d’usine)

Mot de Passe du BIOS

BIOS Phoenix BIOS (Flash ROM de 8Mo) Phoenix™ BIOS

Dernières informations de spécification

Les spécifications énumérées dans cet Appendice sont correctes à l'heure de la mise sous presse. Certains éléments (particu-
lièrement les types de processeur/vitesse unique) peuvent être modifiés ou mis à niveau en fonction du calendrier des parutions
du fabricant. Voyez auprès de votre service clientèle pour les détails.
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Options d’écrans 
LCD

17" WXGA (1280*800) Type Ecran Plat TFT Reflet
17" WXGA (1280*800) Type Ecran Plat TFT Anti-
Reflet

17" WSXGA+ (1600*1050) Type Ecran Plat TFT Reflet
17" WUXGA (1920*1200) Type Ecran Plat TFT Reflet

Options de cartes 
vidéo

Carte vidéo PCI-E NVIDIA GeForce Go 7950 
GTX
MXM-IV
RAM Vidéo interne GDDR3 512Mo
Compatible avec MS DirectX® 9

Carte vidéo PCI-E NVIDIA GeForce 8700M GT
MXM-III
RAM Vidéo interne GDDR3 512Mo
Compatible avec MS DirectX® 10
Prend en charge HDCP

Carte vidéo PCI-E NVIDIA GeForce 8800M GTX
MXM-IV
RAM Vidéo interne GDDR3 512Mo
Compatible avec MS DirectX® 10
Prend en charge HDCP

Stockage de 
données

Un lecteur de type unité optique (CD/DVD) 12,7mm(h) remplaçable  (reportez-vous à “Options” à la 
page 120 pour les options de lecteur)
Une disque dur SATA facilement échangeable de 2,5" 9,5 mm (H)

Lecteur de carte Lecteur de carte 7-en-1 (MS/ MS Pro/ SD/ Mini SD/ MMC/ RS MMC/ MS Duo)
Remarque : Cartes MS Duo/ Mini SD/ RS MMC nécessitent un PC adaptateur

Caractéristique Spécification

Options de cartes vidéo

Remarquez que les types de carte, les spécifica-
tions et les pilotes passent par des mises à jour
et des modifications continues. Consultez votre
service clientèle pour les derniers détails con-
cernant les cartes vidéo prises en charge.
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Son Interface conforme Intel HDA (Son Haute 
Définition)
Système sonore stéréo 3D amélioré

 Son contour SRS WOW 
Compatible avec Sound-Blaster PRO™

Sortie numérique S/PDIF
Microphone intégré
2 haut-parleurs intégrés (1,5W, 8Ω)
1 caisson de basses (2W, 8Ω)

Clavier Clavier "Win Key" Pleine taille (avec pavé numérique)

Dispositif de poin-
tage TouchPad intégré (avec fonction de défilement)

Logement 
d'ExpressCard Logement d'ExpressCard/54(34)

Interface Quatre ports USB 2.0
Un port de Sortie DVI
Une prise de sortie haut-parleurs/casque
Une prise d'entrée de microphone
Une prise de sortie S/PDIF
Une prise d'entrée de Ligne pour entrée audio
Un port Série
Un port Mini-IEEE 1394  
Un émetteur-récepteur infrarouge
Une prise RJ-11 pour modem
Une prise RJ-45 pour réseau

Une prise d’entrée en CC
Une prise de sortie S-Vidéo pour sortieTV & HDTV
Une prise d'antenne câblée (CATV) (analogue/digital) 
(fonctions avec le tuner TV optionnel)
Un émetteur-récepteur consommateur infrarouge 
(fonctions avec le tuner TV optionnel)
Un logement Mini Card pour tuner TV ou module 
mémoire turbo Intel
Un logement Mini Card pour WLAN seulement

Gestion de 
l’alimentation

Supporte ACPI v3.0

Caractéristique Spécification
Spécifications - 119



Guide Utilisateur Concis

Fr
an

ca
is
Communication MDC 56K Modem (conforme V.90 & V.92)
1Gbit réseau Ethernet intégré (PCI Express)
Module LAN sans fil PCIe Intel Wireless WiFi Link 
4965AGN (Option)
Module Tuner TV USB (Option)

Module Bluetooth 2.0 + EDR USB (Option d’usine)
1,3M ou 2,0M pixel caméra PC USB (Option d’usine)

Mise en marche Adaptateur CA/CC pleine bande 
Entrée c.a.: 100-240V, 50-60Hz 
Sortie c.c.: 20V, 6,0A (120W)

Batterie principale à 8 cellules Smart Lithium-Ion 
4400mAH facile à changer

Spécifications 
environnementales

Température
En fonction : 5°C - 35°C 
Eteint : -20°C - 60°C

Humidité relative
En fonction : 20% - 80%
Eteint : 10% - 90%

Dimensions 
physiques & Poids 397 (l) x 284 (p) x 22 - 44 (h) mm Environ 3,95 kg (+/- 5%) avec batterie (8 cellules)

Options Options de module de lecteur optique :
Lecteur combo
Lecteur DVD Super-Multi 

Module LAN sans fil PCIe Intel Wireless WiFi Link 
4965AGN
Module Tuner TV USB
Module de carte mémoire flash NAND Intel Turbo 
Memory (Robson)

Module Bluetooth 2.0 + EDR USB (Option d’usine)
1,3M ou 2,0M pixel caméra PC USB (Option d’usine)
Lecteur d'empreintes digitales (Option d’usine)

Caractéristique Spécification
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Aviso
La compañía se reserva el derecho a revisar esta publicación o cambiar su contenido sin previo aviso. La información
contenida aquí sirve sólo como referencia y no constituye ninguna obligación por parte del fabricante o cualquier vendedor.
No se asume responsabilidad o compromiso por cualquier error o inexactitud que pueda aparecer en esta publicación ni nos
hacemos responsables de cualquier pérdida o daño como resultado del uso (o mal uso) de esta publicación.
Esta publicación y cualquier software que la acompañe no puede, en parte o en su totalidad, ser reproducida, traducida,
transmitida o reducida a cualquier forma legible sin el previo consentimiento del vendedor, fabricante o creadores de esta
publicación, excepto para copias de seguridad guardadas por el propio usuario.
Los nombres de productos y marcas mencionados en esta publicación pueden ser o no marcas con derechos de copia y/o
marcas registradas de sus respectivas compañías. Se mencionan aquí sólo para propósitos de identificación y no como
apoyo a ese producto o su fabricante.

© Noviembre de 2007

Marcas registradas
Este producto incorpora tecnología de protección de derechos de autor amparada por las exigencias de ciertas patentes de
EE.UU. y otros derechos de propiedad intelectual pertenecientes a Macrovision Corporation y otros propietarios de
derechos. El uso de esta tecnología de protección de derechos de copia debe ser autorizado por Macrovision Corporation y
está limitado a uso exclusivo doméstico u otros usos de visualización limitados a menos que exista autorización previa de
Macrovision Corporation. Quedan prohibidas las modificaciones o el desmontaje.
Intel e Intel Core son marcas/marcas registradas de Intel Corporation.

es una marca de SRS Labs, Inc.  
La tecnología WOW ha sido incorporada bajo la licencia de SRS Labs, Inc.
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Acerca de esta Guía del Usuario Concisa
Esta guía rápida es una breve introducción para poner su sistema en funcionamiento. Es un suplemento y no un sustituto
del Manual del usuario completo en inglés en formato Adobe Acrobat del DVD-ROM Device Drivers & Utilities + User's
Manual suministrado con el ordenador. En este DVD-ROM también se encuentran los controladores y utilitarios necesarios
para utilizar el ordenador correctamente. 

Algunas o todas las características del ordenador pueden haberse configurado de antemano. Si no lo están, o si desea
reconfigurar (o reinstalar) partes del sistema, consulte el Manual del usuario completo. El DVD-ROM Device Drivers &
Utilities + User’s Manual no contiene un sistema operativo.

Información de regulación
Las notas de regulación e información están contenidas en el Manual del usuario completo en el DVD-ROM Device
Drivers & Utilities + User’s Manual.

Uso de dispositivos inalámbricos a bordo de un avión

Normalmente se prohibe el uso de cualquier dispositivo de transmisión electrónica a bordo de un avión.
Compruebe que los módulos inalámbricos estén DESCONECTADOS si va a utilizar el ordenador en
el avión.
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Instrucciones para el cuidado y funcionamiento
El ordenador portátil es muy robusto, pero puede dañarse. Para evitar esto, siga estas sugerencias:

• No lo deje caer ni lo exponga a golpes fuertes. Si el ordenador se cae, la carcasa y los componentes podrían dañarse.
• Manténgalo seco y no lo sobrecaliente. Mantenga el ordenador y fuente de alimentación alejados de cualquier tipo de fuente de 

calor. Esto es un aparato eléctrico. Si se derrama agua u otro líquido en su interior, el ordenador podría dañarse seriamente.
• Evite las interferencias. Mantenga el ordenador alejado de transformadores de alta capacidad, motores eléctricos y otros campos 

magnéticos fuertes. Éstos pueden dificultar el correcto funcionamiento y dañar los datos.
• Siga las instrucciones apropiadas de manejo del ordenador. Apague el ordenador correctamente y no olvide guardar su trabajo. 

Recuerde guardar periódicamente sus datos, pues los datos pueden perderse si la batería se descarga.
• Tenga cuidado cuando utilice dispositivos periféricos.

Servicio
No intente arreglar el ordenador por su cuenta. Si lo hace, puede violar la garantía y exponerse usted y el ordenador a
descarga eléctrica. Encargue las reparaciones a personal técnico autorizado. Desenchufe el ordenador de la fuente de
alimentación. Encargue las reparaciones a personal cualificado en los siguientes casos:

• Cuando el cable de alimentación esté dañado o pelado.
• Si el ordenador ha estado expuesto a la lluvia u otros líquidos.
• Si el ordenador no funciona con normalidad tras seguir las instrucciones de uso.
• Si el ordenador se ha caído o dañado (no toque el líquido venenoso si el panel LCD se rompe).
• Si hay un olor fuera de lo normal, calor o humo que sale del ordenador.
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Seguridad sobre la alimentación
El ordenador tiene unos requisitos de alimentación específicos:
• Utilice solamente un adaptador de alimentación aprobado para su uso con este ordenador.
• Su adaptador de CA/CC puede estar diseñado para viajes internacionales, pero puede que necesite una fuente de alimentación 

continuada. Si no está seguro de las especificaciones de alimentación locales, consulte con el servicio de asistencia o compañía de 
electricidad del lugar.

• El adaptador de alimentación puede tener un enchufe de 2 dientes o un enchufe con tierra de 3 dientes. El tercer diente es una caracte-
rística de seguridad; no lo elimine. Si no tiene acceso a un enchufe de pared compatible, haga que un electricista cualificado instale uno.

• Cuando desee desenchufar el cable de alimentación, asegúrese de desconectarlo por la cabeza del enchufe, no por su cable.
• Compruebe que la toma y cualquier alargadera que utilice puedan soportar la carga de corriente total de todos los dispositivos conectados.
• Antes de limpiar el ordenador, asegúrese de que esté desconectado de cualquier fuente de alimentación externa.

Limpieza
• No aplique limpiador directamente en el ordenador, utilice un trapo suave y limpio. 
• No utilice limpiadores volátiles (derivados del petróleo) o limpiadores abrasivos en ningún lugar del ordenador.

Aviso de seguridad sobre la corriente

Antes de llevar a cabo cualquier procedimiento de actualización, asegúrese de haber apagado la alimentación y desconectado todos los
periféricos y cables (incluyendo las líneas telefónicas). También es aconsejable quitar su batería para evitar que la máquina se encienda
por accidente.

Apáguelo antes de viajar

Compruebe que su portátil esté completamente apagado antes de introducirlo en una bolsa de viaje (o en cualquier funda). Si introduce
un portátil encendido en una bolsa de viaje, puede que la(s) rejilla(s) se bloquee(n). Para evitar que el ordenador se sobrecaliente,
asegúrese de que nada bloquea la(s) rejilla(s) con el ordenador encendido.
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Precauciones con la batería
• Utilice sólo baterías diseñadas para este ordenador. Una batería inadecuada podría explotar, perder o dañar el equipo.
• Nunca utilice una batería que se haya caído o que parezca dañada (p. ej. doblada o retorcida). Incluso si el ordenador sigue 

funcionando con una batería dañada, puede provocar daños en el circuito que podrían causar fuego.
• Recargue la batería con el sistema del ordenador. Una recarga incorrecta puede hacer que la batería explote.
• No intente reparar baterías. Solicite la reparación o la sustitución a su representante de servicio o a personal de servicio cualificado.
• Mantenga las baterías dañadas fuera del alcance de los niños y deséchelas inmediatamente. La eliminación de baterías debe 

efectuarse con cuidado. Las baterías pueden explotar o perder si se exponen al fuego o si se manipulan o desechan de manera 
inadecuada.

• Mantenga las baterías lejos de elementos metálicos.
• Cubra los contactos de la batería con cinta adhesiva antes de desecharla.
• No toque los contactos de la batería con las manos o con objetos metálicos.

Eliminación de la batería & Cuidado

El producto que usted ha comprado contiene una batería recargable. La batería es reciclable Terminada su vida útil, según las
leyes locales y estatales, puede ser ilegal desecharla junto con los residuos ordinarios. Verifique con las autoridades locales
responsables de los desechos sólidos cuáles son las opciones de eliminación y reciclado existentes en su zona.

Peligro de explosión si la batería está mal colocada. Sustitúyala con un tipo de batería igual o equivalente al recomendado por
el fabricante. Elimine la batería usada de conformidad con las instrucciones del fabricante.
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Guía rápida para empezar
1. Quite todos los materiales del embalaje.
2. Coloque el ordenador en una superficie estable.
3. Conecte en los puertos correspondientes los periféricos que desee utilizar con el ordenador 

portátil (p. ej. teclado y ratón)
4. Conecte el adaptador de CA/CC al conector de entrada de CC que está del lado posterior del 

ordenador, y luego conecte el cable de alimentación CA en un eschufe y al adaptador..
5. Mueva los pestillos del LCD en la parte frontal del ordenador hacia los laterales del ordenador 

y sosténgalos ahí para subir la tapa superior.
6. Abra la tapa/LCD  con un ángulo que le resulte cómodo para ver la pantalla. Presione el botón 

de encendido para “encender”.

Diferencias de modelos
Esta serie de portátiles incluye dos tipos de diseño distintos, sin embargo sólo un diseño se
muestra en esta guía.

Apagar

Por favor, tenga en cuenta
que debería siempre apa-
gar el ordenador eligiendo
la opción Apagar desde el
menú del botón Bloquear
en Windows Vista. Esto le
ayudará a evitar problemas
con el disco duro o el siste-
ma.

Figura  1
Adaptador de CA/

CC enchufado
126 -  Guía rápida para empezar
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Software de sistema
Puede ser que su ordenador tenga instalado un software de
sistema. Si no es el caso, o si desea reconfigurarlo con otro
sistema, este manual se refiere a  Microsoft Windows Vista.
Si desea más información sobre cómo instalar controlado-
res y utilitarios consulte los capítulos 4 y 7 del Manual del
usuario completo, que se encuentra en el DVD-ROM Devi-
ce Drivers & Utilities + User’s Manual.

Sistemas operativos suportados 

*Para información sobre el SO Windows XP consulte el
DVD-ROM Device Drivers & Utilities + User’s Manual.

No incluido
Sistemas operativos (p. ej. Windows Vista/Windows XP)
tienen sus propios manuales, al igual que las aplicaciones
(p. ej. procesadores de texto, planillas de cálculo y bases de
datos), por favor, consulte los manuales apropiados.

Controladores

Si va a instalar o reinstalar un nuevo sistema, necesitará ins-
talar los controladores apropiados. Es muy importante que ins-
tale los controladores en el orden listado en la Tabla 5 en la
página 141.

Módulo de memoria Intel Turbo

Si ha incluido una tarjeta de memoria flash Intel Turbo Memory
(Robson) NAND como opción de compra deberá activar la op-
ción en la BIOS ANTES de instalar el sistema operativo Win-
dows Vista (no active esta opción en Windows XP o en un
sistema operativo Windows Vista instalado sin la opción acti-
vada). Vea la página 153.

Sistema operativo Nota

*Windows XP (Home Edition o 
Professional)

Windows Vista (64-bit) Home 
Basic Editon Para ejecutar Windows 

Vista sin limitaciones ni 
menor rendimiento, su 
ordenador necesita un 

mínimo de 1GB de memo-
ria del sistema (RAM).

Windows Vista (64-bit) 
 Home Premium Editon/Busi-
ness Editon/Enterprise Editon/

Ultimate Editon
Software de sistema - 127
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128 -  Mapa del sistema:Vista superior con panel LCD abierto

Mapa del sistema:Vista superior con panel LCD 
abierto

Figura 2 
Vista superior con pa-

nel LCD abierto
1. Cámara PC (opcional)
2. Panel LCD
3. Botones Hot-Key
4. Botón de encendido
5. Teclado
6. TouchPad (almohadilla 

táctil) y botones
7. Lector de huellas digitales 

(opcional)
8. Indicadores LED de 

encendido y 
comunicación

9. Micrófono incorporado

7

6

Uso de dispositivos 
inalámbricos a bordo

El uso de dispositivos elec-
trónicos portátiles a bordo
de un avión suele estar pro-
hibido. Asegúrese de que
los módulos (WLAN/Blue-
tooth) estén apagados si
está utilizando el ordena-
dor a bordo de un avión. 
 
Utilice las combinaciones
de teclas (vea la Tabla 3 en
la página 131) para acti-
var/desactivar los módulos
WLAN/Bluetooth y haga
compruebe el icono indica-
dor de estado  para ver
si los módulos están encen-
didos o no (vea la Tabla 1
en la página 129).

2

1

5

7 8

6

43

9
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Indicadores LED
Los indicadores LED en su ordenador muestran una valiosa información sobre el estado actual del ordenador.

Tabla 1 - Indicadores LED

Icono Color Descripción Icono Color Descripción

Verde El ordenador está encen-
dido Naranja La batería se está cargando

Verde 
parpadeante

El ordenador está en modo 
Suspensión

Naranja parpa-
deante

La batería ha alcanzado el estado crí-
tico de poca energía

Naranja El adaptador de CA/CC 
está conectado Verde La batería está completamente car-

gada

Verde El teclado numérico 
(NumLk) está activado Verde El disco duro está en uso

Verde El bloqueo de mayúsculas 
está activado Naranja El módulo Bluetooth está activado

Verde El bloqueo de desplaza-
miento está activado Verde El módulo LAN Wireless está activado
Indicadores LED - 129
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Botones Hot-Key & teclado
Los botones Hot-Key ofrecen acceso instantáneo al
explorador de Internet y al programa de correo electrónico
y a una aplicación definida por el usuario (consulte “Botón
Hot-Key de aplicación” en la página 132), con una
pulsación rápida de un botón.

Tabla 2 - Botones Hot-Key

El teclado incluye un teclado numérico (en la parte derecha
del teclado) para una entrada fácil de datos numéricos. Al
presionar la tecla Bloq Num el teclado numérico se habilita
o inhabilita. También incluye las teclas de función para
permitirle cambiar las características operacionales al
instante.

Figura 3 - Teclado

Botón Hot-Key Función

Activar la aplicación especificada por 
el usuario, p. Ej. Microsoft Word o 
Excel

Activar el programa de correo electró-
nico predeterminado

Activar el buscador de Internet prede-
terminado

Teclado numéricoTecla Fn

Teclas de función

Tecla Bloq Num/BloqDespl

Caracteres especiales

Algunas aplicaciones de software le permiten usar las teclas
numéricas con Alt para producir caracteres especiales. Es-
tos caracteres especiales sólo pueden producirse utilizando
el teclado numérico. Las teclas numéricas normales (en la
fila superior del teclado) no funcionarán. Asegúrese de que
el teclado numérico (Bloq Num) esté activado.
130 -  Botones Hot-Key & teclado
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Teclas de función & indicadores visuales
Las teclas de función (F1 - F12 etc.) actuarán como teclas directas (Hot-Key) cuando se pulsan junto con la tecla Fn.
Además de las combinaciones de teclas de función básicas los indicadores visuales están disponibles cuando el controlador
de teclas directas (HotKey Driver) está instalado (consulte “Hot-Key” en la página 142). Después de instalar el controlador
aparecerá un icono  en la barra de tareas.

Teclas Función/indicadores visuales Teclas Función/indicadores visuales

Fn + ~ Reproducir/Pausar (en los programas Audio/Vídeo) Fn + F8/F9 Reducción/Aumento 
brillo LCD

Fn + F1 Activar/desactivar el 
TouchPad

Fn + F10 Activar/desactivar el 
módulo cámara PC

Fn + F2 
Apagar luz de fondo del LCD 
(presione una tecla o utilice el TouchPad para 
encenderlo)

Fn + F11 Activar/desactivar el 
módulo LAN Wireless

Fn + F3 Conmutación mudo Fn + F12 Activar/desactivar el 
módulo Bluetooth

Fn + F4 Conmutación dormir Bloq Num Activa/disactiva el teclado numérico (NumLk) 

Fn + F5/
F6 

Reducción/Aumento 
volumen de sonido

Fn +
BloqDespl

Cambiar el bloqueo de desplazamiento

Fn + F7 Conmutación pantalla Tabla 3 - Teclas de función & indicadores visuales
Botones Hot-Key & teclado - 131
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Botón Hot-Key de aplicación
Para configurar un programa para que se abra al pulsar el
botón Hot-Key de aplicación  (Windows Media Player
es el programa predeterminado) siga las instrucciones
siguientes.

1. Haga doble clic en el icono del controlador Hot-Key  en 
la barra de tareas.

2. Haga clic en Launch user specified application (botón) 
.

3. Aparecerá un cuadro de diálogo Abrir en la pantalla.
4. Busque el directorio donde está el programa de la 

aplicación.exe deseada (ver bajo).
5. Haga doble clic en el archivo del programa o elija Abrir, y 

haga clic en Aceptar.
6. Pulse el botón Hot-Key  para abrir el programa (si el 

controlador Hot-Key se está ejecutando en la barra de 
tareas).

Figura 4 - Controlador Hot-Key

Aplicación.exe

Necesitará localizar archivo ejecutable (.exe) de la aplica-
ción, y no sólo el acceso directo. Para encontrar la aplica-
ción, haga clic con el botón derecho en el acceso directo en
el escritorio y haga clic en Propiedades. Haga clic en Acce-
so directo (ficha) y vea dónde está el archivo ejecutable ha-
ciendo clic en Abrir ubicación (botón).

Controlador Hot-Key

Si hace clic en el icono cerrar , ejecute el programa desde
la ubicación del archivo:
(C:\Program Files (x86)\Hotkey_Driver\HotkeyDri-
ver.exe).
132 -  Botones Hot-Key & teclado
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Mapa del sistema: Vistas frontal y posterior Figura 5
Vistas frontal y poste-

rior
1. Pestillos del LCD
2. Conector de entrada de 

línea
3. Conector de salida de 

auriculares
4. Conector  de entrada para 

micrófono
5. Conector de salida S/

PDIF
6. Indicadores LED de 

encendido y 
comunicación

7. Transceptor de 
infrarrojos/transceptor de 
infrarrojos doméstico 
(CIR)

8. Rejilla
9. Conector de salida de S-

Vídeo 
10. Puerto de salida DVI
11. 2 Puertos USB 2.0
12. Conector de entrada de 

CC
13. Puerto serie

1 1

2 3 4 5
6

8
9

Recalentamiento

Para evitar que su ordenador se recaliente compruebe que nada bloquea la(s) rejilla(s) con el equipo
encendido.

Puertos USB

Tenga en cuenta que las conexiones a los puertos USB sólo coinciden de un modo, no los fuerce.

8
10 11 12 13

Parte frontal

Parte posterior

7

Mapa del sistema: Vistas frontal y posterior - 133
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Mapa del sistema: Vistas derecha y izquierdaFigura 6
 Vistas derecha y iz-

quierda 
1. Ranura ExpressCard/

54(34)
2. Lector de tarjetas 7 en 1
3. 2 Puertos USB 2.0
4. Puerto Mini-IEEE 1394 
5. Conector de teléfono RJ-

11
6. Conector LAN RJ-45
7. Conector de antena de 

cable (CATV) (Activado 
sólo con el sintonizador de 
TV)

8. Altavoz incorporado
9. Ranura del cierre de 

seguridad
10. Bahía de dispositivo 

óptico
11. Orificio de expulsión de 

emergencia

1
2 3 4 5 6 8

Puerto Mini-IEEE 1394

El puerto Mini-IEEE 1394 soporta sólo dis-
positivos IEEE 1394 AUTOALIMENTA-
DOS.

Ranura ExpressCard

La ranura ExpressCard acepta los forma-
tos ExpressCard/34 o ExpressCard/54.

3
7

Expulsión de emergencia de CD/DVD

Si necesita expulsar un CD/DVD manual-
mente (p. ej. por un corte de corriente ines-
perado) puede introducir la punta de un clip
en el orificio de expulsión de emergencia. No
utilice la punta de un lápiz u otros objetos
que puedan romperse y quedar atrapados
en el orificio.

No intente extraer un CD/DVD mientras el
sistema esté accediendo al mismo. Esto
puede causar un fallo.

Lateral derecho

1098 11

Lateral izquierdo
134 -  Mapa del sistema: Vistas derecha y izquierda
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Mapa del sistema: Vista inferior Figura 7 
Vista inferior

1. Rejilla
2. Batería
3. Pestillos de sujeción del 

dispositivo óptico
4. Tapa de la bahía 

componente
5. Transceptor de 

infrarrojos/transceptor de 
infrarrojos doméstico 
(CIR)

6. Sub Woofer

Información de la batería

Siempre complete la descarga de una batería nueva y luego cárguela por completo antes de usarla.
Descárguela por completo y vuelva a cargarla al menos una vez cada 30 días o tras unas 20 des-
cargas parciales.  

1
2

3
4

5

1

6

1
1

1

3
1

CPU

El usuario no debe manipular la
CPU. El acceso a la CPU de
cualquier modo puede anular
su garantía.

Recalentamiento

Para evitar que su ordenador se
recaliente compruebe que nada
bloquea la(s) rejilla(s) con el
equipo encendido.
Mapa del sistema: Vista inferior - 135
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Menú Inicio y Panel de control de Windows Vista
La mayoría de paneles de control, utilidades y programas en Windows Vista (y la mayoría de versiones de Windows)
pueden accederse a través del menú Inicio. Cuando instala programas y utilidades, se instalarán en su unidad de disco duro
y normalmente aparecerá un acceso directo en el menú Inicio y/o escritorio. Haga clic con el botón derecho en el icono del
menú Inicio , luego seleccione Propiedades si desea personalizar la apariencia del menú Inicio.

En muchos ejemplos a lo largo de este manual verá una ilustración para abrir Panel de control. El Panel de control se
accede desde el menú Inicio. El Panel de control le permite establecer la configuración de la mayoría de características
principales en Windows (p. ej. energía, vídeo, redes, audio, etc.). Windows Vista ofrece paneles de control básicos para
muchas de las características, sin embargo, se añaden muchos paneles de control nuevos (o mejoran los existentes) cuando
instale los controladores listados en la Tabla 5 en la página 141. Para ver todos los controles puede que sea necesario
activar la vista Clásica.

Figura 8 - Menú Inicio y Panel de control

Haga clic aquí para cambiar a la
vista clásica
136 -  Menú Inicio y Panel de control de Windows Vista
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Parámetros de vídeo
Puede cambiar los dispositivos de pantalla y configurar las opciones de pantalla desde el panel de control Configuración
de Pantalla (en Personalización) en Windows Vista. 

Para acceder a la Configuración de pantalla en Windows Vista:

1. Haga clic en Inicio (menú),  y haga clic en Panel de control (o vaya a Configuración y haga clic en Panel de control).
2. Haga clic en Ajustar resolución de pantalla en el menú Apariencia y personalización (o haga doble clic en Personalización > 

Configuración de pantalla).
3. En Resolución, mueva el control deslizante a la configuración preferida para resolución  (ver la Figura 9 en la página 138).
4. En Calidad de color, haga clic en la flecha y desplace hasta la configuración preferida para la profundidad del color  (ver la 

Figura 9 en la página 138).
5. Haga clic en Configuración avanzada... (botón)  (ver la Figura 9 en la página 138) para abrir las fichas de Configuración 

avanzada.
6. Haga clic en GeForce..... (ficha).
7. Haga clic en Iniciar el panel de control de NVIDIA  (ver la Figura 9 en la página 138) para acceder al panel de control.
8. También podrá acceder al Panel de control de NVIDIA haciendo clic con el botón derecho en el escritorio y haciendo clic en Panel 

de control de NVIDIA.

1
2

3

4

Tarjetas de vídeo soportadas

Tenga en cuenta que los tipos de tarjetas, especificaciones y controladores están sujetos a continuas actualizaciones y cambios. Con-
sulte con su centro de servicios los últimos detalles sobre las tarjetas de vídeo soportadas.
Parámetros de vídeo - 137
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Dispositivos y opciones de pantalla
Además del LCD incorporado, también puede utilizar un monitor VGA/pantalla plana o TV como dispositivo de pantalla.
Un monitor VGA/pantalla plana se conecta al puerto de salida DVI, un televisor al conector de salida de S-Vídeo. Los
siguientes modos de pantalla están disponibles.

Tabla 4 - Modos de pantalla

Modo de pantalla Descripción

Pantalla única Se utiliza un dispositivo de pantalla

Clonación Ambas pantallas conectadas muestran la misma vista

DualView Ambas pantallas conectadas son tratadas como un único dispositivo y actúan como escritorio virtual

1 2
3

4

Figura 9 - Configuración de pantalla
138 -  Parámetros de vídeo
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Características de audio
Puede configurar las opciones de audio de su ordenador en el panel de control de Sonido , o desde el icono de
Administrador de sonido Realtek HD /  en la barra de tareas o en el panel de control (haga clic en el icono de
la barra de tareas  para abrir el menú de audio). El volumen también puede ajustarse con la combinación de teclas Fn +
F5/F6.

Figura 10 - Administrador de sonido Realtek HD

Ajuste del volumen del sonido

El nivel del volumen del sonido
se ajusta utilizando el control
dentro de Windows (y las teclas
de función del volumen en el or-
denador). Haga clic en el icono
del Volumen de la barra de ta-
reas para comprobar la configu-
ración. Haga clic con el botón

derecho en el icono
para acceder al menú
de arriba.
Características de audio - 139
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Funciones de administración de energía
El panel de control de las opciones de energía (menú Hardware y sonido) de Windows (ver la página 136) permite
configurar las funciones de administración de energía del ordenador. Puede ahorrar energía con los planes de energía y
configurar las opciones para el botón de encendido, botón de suspensión, tapa del ordenador (al cerrarla), pantalla y
modo de suspensión en el menú de la izquierda. Tenga en cuenta que el plan economizador puede afectar al rendimiento
del ordenador.

Haga clic para seleccionar uno de los planes existentes o haga clic en Crear un plan de energía en el menú izquierdo y
seleccione las opciones para crear un plan nuevo. Haga clic en Cambiar la configuración del plan y haga clic en Cambiar
la configuración avanzada de energía para acceder a más opciones de configuración.

Figura 11 - Opciones de energía
Nota: Suspensión es el estado de ahorro de energía predeterminado en Windows Vista  
140 -  Funciones de administración de energía
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Instalación de controladores
El DVD-ROM Device Drivers & Utilities + User’s Manual
contiene los controladores y utilitarios necesarios para
utilizar el ordenador correctamente. Inserte el DVD-ROM y
haga clic en Install Drivers (botón), u Optional (botón)
para acceder al menú de controladores opcional.

Instale los controladores en el orden indicado en la Tabla 5.
Tras instalar cada controlador, quedará en gris (si necesita
volver a instalar un controlador, haga clic en el botón
Unlock). 

Instalación manual del controlador
Haga clic en el botón Browse CD en la aplicación Drivers
Installer y busque el archivo ejecutable en la carpeta de
controladores apropiada.

Windows Update
Tras instalar todos los controladores asegúrese de haber
habilitado Windows Update para obtener las últimas
actualizaciones de seguridad, etc. (todas las actualizaciones
incluirán los últimos parches de Microsoft).

Tabla 5 - Procedimiento de instalación

Controlador (Windows Vista) Página #
Chipset página 142

Vídeo página 142

Sonido página 142

Módem página 142

Lector de tarjetas/ExpressCard página 142

Red (LAN) página 142

TouchPad (almohadilla táctil) página 142

Hot-Key página 142

LAN Wireless (opción) página 143

Bluetooth (opción) página 144

Cámara PC (opción) página 145

Lector de huellas digitales (opción) página 148

CIR (opción) página 151

Sintonizador de TV (opción) página 151

Intel Turbo Memory (opción) página 153

Activar Windows Update (ver a la izquierda)
Instalación de controladores - 141
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Chipset
1. Haga clic en Install Drivers.
2. Haga clic en 1.Install Chipset Driver > Sí.
3. Haga clic en Siguiente > Sí > Siguiente > Siguiente.
4. Haga clic en Finalizar para reiniciar el sistema.

Vídeo
1. Haga clic en Install Drivers.
2. Haga clic en 2.Install Video Driver > Sí.
3. Haga clic en Siguiente.
4. Haga clic en Finalizar para reiniciar el sistema.

Sonido
1. Haga clic en Install Drivers.
2. Haga clic en 3.Install Audio Driver > Sí.
3. Haga clic en Siguiente.
4. Haga clic en Finalizar para reiniciar el sistema.

Modem
1. Haga clic en Install Drivers.
2. Haga clic en 4.Install Modem Driver > Sí.
3. Haga clic en Aceptar.
4. El módem está listo para la configuración del acceso 

telefónico.

ExpressCard / Lector de tarjetas
1. Haga clic en Install Drivers.
2. Haga clic en 5.Install CardReader Driver > Sí.
3. Haga clic en Siguiente > Siguiente.
4. Haga clic en Terminar para reiniciar el sistema.

Red (LAN)
1. Haga clic en Install Drivers.
2. Haga clic en 6.Install LAN Driver > Sí.
3. Haga clic en Siguiente > Instalar.
4. Haga clic en Finalizar.

TouchPad
1. Haga clic en Install Drivers.
2. Haga clic en 7.Install Touch Pad Driver > Sí.
3. Haga clic en Siguiente > Siguiente > Siguiente.
4. Haga clic en Finalizar para reiniciar el sistema.

Hot-Key
1. Haga clic en Install Drivers.
2. Haga clic en 8.Install Hotkey Driver > Sí.
3. Haga clic en Next > Install.
4. Haga clic en Finish > Finish para reiniciar el sistema.
142 -  Instalación de controladores
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LAN Wireless

Instalación del controlador del 
módulo WLAN
1. Compruebe que el módulo esté activado.
2. Haga clic en Optional (botón).
3. Haga clic en 1.Install Intel WLan driver > Sí.
4. Haga clic en Instalar software.
5. Haga clic en el botón Acepto los términos del contrato 

de licencia, luego haga clic en Siguiente.
6. Haga clic en Siguiente > Aceptar.

Nota: El sistema operativo es la configuración
predeterminada para el control de LAN inalámbrica en
Windows Vista.

Conectar a una red inalámbrica
Compruebe que el módulo WLAN esté activado.

1. Haga clic en el icono WLAN  en la barra de tareas, y luego 
haga clic en Conectarse a una red (o haga clic con el botón 
derecho en el icono , y luego haga clic en Conectarse a 
una red).

2. En la lista Mostrar, haga clic en Inalámbrico en el menú 
desplegable.

3. Aparecerá una lista con las redes disponibles.
4. Haga clic en una red y luego en Conectar.
5. Si no ve la red a la que quiere conectarse, haga clic en 

Configurar una conexión o red (aparecerá una lista con 
opciones permitiendo la búsqueda manual y creando una 
nueva red).

6. Mueva el cursor sobre el icono  de la barra de tareas para 
ver el estado de la conexión.

7. Para desconectarse de la red inalámbrica puede hacer clic en el 
icono  inalámbrico de la barra de tareas y luego seleccionar 
Conectar o desconectar para acceder al menú de la red y 
hacer clic en Desconectar (o haga clic con el botón derecho 
en el icono , y luego haga clic en Desconectar de).

Botón de encendido para el módulo WLAN

Active la alimentación al módulo WLAN utilizando la combina-
ción de teclas (Fn + F11). Cuando el módulo WLAN está en-
cendido, el LED  estará en verde y el indicador 
aparecerá brevemente.
LAN Wireless - 143
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Bluetooth

Instalación del controlador del 
módulo Bluetooth
1. Compruebe que el módulo esté activado.
2. Haga clic en Optional (botón).
3. Haga clic en 2.Install BlueTooth driver > Sí.
4. Elija el idioma que prefiera y haga clic en OK > Next.
5. Haga clic en el botón I accept the terms of the license 

agreement, luego haga clic en Next.
6. Haga clic en Next > Install.
7. Haga clic en Finish > Yes para reiniciar el sistema.

Conexión de área local Bluetooth
Puede comprobar el estado de la conexión Bluetooth en el
Centro de redes y recursos compartidos:

1. Utilice la combinación (Fn + F12) para activar el módulo 
Bluetooth.

2. Ejecute el programa IVT Corporation BlueSoleil desde 
el icono del escritorio o en el menú Inicio.

3. Haga clic en Inicio (menú),  y haga clic en Panel de 
control (o vaya a Configuración y haga clic en Panel de 
control).

4. Haga doble clic en Centro de redes y recursos 
compartidos (Redes e Internet).

5. Haga clic en Administrar conexiones de red.
6. El estado de la conexión Bluetooth aparecerá en el panel 

de control.
7.  Para desconectar haga clic en Archivo en la IVT 

Corporation BlueSoleil Ventana principal y seleccione 
Salir (entonces la conexión de área local mostrará "Cable 
de red desconectado").

8. No utilice el botón Cerrar  o la combinación de teclas 
Fn + F12 antes de hacer clic en Archivo > Salir o no 
aparecerá el estado actual correcto.

9. Puede utilizar la combinación de teclas Fn + F12 para 
apagar el módulo Bluetooth (compruebe el icono LED 
para el estado de alimentación del módulo Bluetooth).

Botón de encendido para el módulo Bluetooth

Active la alimentación al módulo Bluetooth utilizando la combi-
nación de teclas (Fn + F12). Cuando el módulo Bluetooth está
encendido, el LED  estará en naranja y el indicador 
aparecerá brevemente.
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Cámara PC
Hay 2 opciones de cámara disponibles para este ordenador.
El módulo cámara de 1,3M píxeles utiliza la aplicación
BisonCap para capturar archivos de vídeo. El módulo
cámara de 2,0M píxeles utiliza la aplicación VideoView
para capturar archivos de vídeo.

Instalación del controlador de la 
cámara PC
Para módulo de cámara PC 1,3M píxeles:
1. Encienda el módulo utilizando Fn + F10 (el indicador 

 aparecerá brevemente cuando se encienda el 
módulo).

2. Haga clic en Optional (botón).
3. Haga clic en 3.PC Camera, Web cam > Sí.
4. Elija el idioma que prefiera y haga clic en Siguiente.
5. Haga clic en Siguiente.
6. Haga clic en Finalizar para reiniciar el sistema.
7. Ejecute el programa de la aplicación BisonCap desde el 

acceso directo (BisonCam) en el escritorio o desde la 
opción BisonCam en el menú Inicio > Programas/Todos 
los programas (si el hardware está apagado utilice la 
combinación de teclas Fn + F10 para volver a 
encenderlo).

Para módulo de cámara PC 2,0M píxeles:
1. Encienda el módulo utilizando Fn + F10 (el indicador 

 aparecerá brevemente cuando se encienda el 
módulo).

2. Haga clic en Optional (botón).
3. Haga clic en 3.PC Camera, Web cam > Sí.
4. Haga clic en Installer.
5. Haga clic para seleccionar Sí o No para responder a la 

pregunta de energía del sistema.
6. Haga clic en Finalizar > Finalizar para reiniciar el 

sistema.
7. Ejecute el programa de la aplicación VideoView desde el 

acceso directo (VideoView) en el escritorio o desde la 
opción  USB2.0 PC Camera en el menú Inicio > 
Programas/Todos los programas (si el hardware está 
apagado utilice la combinación de teclas Fn + F10 para 
volver a encenderlo).
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Configuración del audio de la cámara 
PC
Configure las opciones de grabación de audio en Windows
para capturar vídeo & audio con su cámara.

1. Haga clic en Inicio (menú), y haga clic en Panel de control 
(o vaya a Configuración y haga clic en Panel de control).

2. Haga clic en Sonido  (Hardware y sonido).
3. Haga clic en Grabar (ficha).
4. Haga clic con el botón derecho en Micrófono (Realtek High 

Definition Audio) y compruebe que el ítem esté 
deshabilitado.

5. Haga doble clic en Micrófono (o seleccione Propiedades en 
el menú contextual).

6. Haga clic en Niveles (ficha) y ajuste los controles deslizantes 
de Micrófono y Amplificación de micrófono hasta el nivel 
deseado.

7. Haga clic en Aceptar y cierre los paneles de control.
8. Ejecute el programa BisonCap/VideoView en el menú Inicio 

> Programas/Todos los programas > BisonCam/USB2.0 
PC Camera.

9. Vaya al menú Devices (Dispositivos) y seleccione Micrófono 
(Realtek....) (debería tener una marca al lado).

10. Vaya al menú Capture (Capturar) y seleccione Capture 
Audio (debería tener una marca al lado).

BisonCap/VideoView
Las aplicaciones BisonCap (para la cámara de 1,3M píxeles)
y VideoView (para la cámara de 2,0M píxeles) son visores de
vídeo útiles para el propósito general de visualización y
comprobación de vídeo y pueden capturar archivos de vídeo en
formato .avi.
1. Ejecute el programa BisonCap/VideoView en el menú Inicio 

> Programas/Todos los programas > BisonCam/USB2.0 
PC Camera (se recomienda que Ajuste el archivo de 
captura antes del proceso de captura - ver “Ajustar archivo 
de captura” a continuación).

2. Vaya al menú de Capture (Capturar) (si desea capturar audio 
consulte “Configuración del audio de la cámara PC”) y 
seleccione Start Capture (Iniciar captura).

3. Haga clic en OK (Aceptar) (la ubicación del archivo aparecerá 
en el cuadro emergente) para iniciar la captura y pulse Esc 
para detenerla  (puede ver el archivo usando Windows 
Media Player).

Ajustar archivo de captura
Antes de capturar archivos de vídeo puede seleccionar la
opción Set Capture File... (Ajustar archivo de captura...) en el
menú File (Archivo) y ajuste el nombre del archivo y la
ubicación antes de capturar (esto ayudará a evitar sobrescribir
archivos accidentalmente). Ajuste el nombre y la ubicación y
luego haga clic en Abrir, luego ajuste el "Tamaño del archivo
de captura": y haga clic en OK (Aceptar). Luego podrá iniciar
el proceso de captura como arriba.
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Zoom 
Los programas BisonCap y VideoView le permiten acercar
y alejar con la cámara.

Para BisonCap:
1. Ejecute el programa BisonCap.
2. Vaya al menú de Zoom y seleccione ZoomOut/Zoom In.

Para VideoView:
1. Ejecute el programa VideoView.
2. Vaya al menú de Options y seleccione Setting (utilice el 

control deslizante para ajustar el nivel del zoom y haga clic en 
OK para guardar la configuración).

Tomar imágenes instantáneas
Los programas BisonCap y VideoView le permiten tomar
fotos instantáneas.

1. Ejecute el programa BisonCap/VideoView.
2. (BisonCap) Vaya al menú de Options y seleccione Take 

Picture.                                                                                                    
o                                                                                            
(VideoView) Vaya al menú de Capture y seleccione 
SnapShot.

3. La imagen (en formato JPEG) será colocada en la carpeta 
Snapshot  en el escritorio (no mueva ni cambie el 
nombre de la carpeta).

Eliminar el parpadeo de pantalla
Si la pantalla de vídeo del programa BisonCap/ VideoView
parpadea, puede intentar ajustar la configuración en las
opciones Video Capture Filter.

Para BisonCap:
1. Ejecute el programa BisonCap.
2. Vaya al menú de Options y seleccione Video Capture 

Filter....
3. Haga clic en 50Hz o 60Hz bajo Frecuencia en Página de 

propiedades (ficha).

Para VideoView:
1. Ejecute el programa VideoView.
2. Vaya al menú de Options y seleccione Video Capture 

Filter....
3. Haga clic en 50Hz o 60Hz bajo Flickering Reduction en 

Image (ficha).
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Lector de huellas digitales
Si su opción de compra incluye un lector de huellas digita-
les necesitará instalar el controlador como se indica a con-
tinuación. 
Asegúrese de tener derechos de administrador en su ordena-
dor y de tener una contraseña Windows habilitada para una
protección de seguridad completa.
Antes de comenzar el proceso de inscripción, se
recomienda que siga el tutorial de huellas digitales. Para
ejecutar el tutorial, haga clic en Inicio > Programas/Todos
los programas > Protector Suite QL > Tutorial de
huellas digitales.

Instalación del controlador para 
huellas digitales
1. Haga clic en Optional (button).
2. Haga clic en 4.Install FingerPrint Driver > Sí.
3. Haga clic en Instalación del software.
4. Haga clic en Siguiente > Siguiente > Siguiente.
5. Haga clic en Finalizar > Sí para reiniciar el sistema.

Inclusión de usuarios
1. Haga clic en Inicio > Programas/Todos los programas > 

Protector Suite QL > Inclusión de usuario, o haga doble 
clic en el icono  en la barra de tareas.

2. La primera vez que ejecute el programa se le pedirá que haga 
clic en el botón para aceptar la licencia, luego haga clic en 
Aceptar.

3. Haga clic en Siguiente y seleccione “Registro en el disco 
duro”, y haga clic en Finalizar.

Ayuda & Manual

Haga clic con el botón derecho en el icono de la barra de
tareas  para abrir el menú y seleccionar Ayuda.

Inserte el DVD-ROM Device Drivers & Utilities + User’s
Manual y haga clic en Optional (botón). Haga clic en Un-
lock (botón) y luego haga clic en 4.Install FingerPrint
Driver > Sí.

Haga clic en Documentación para abrir la carpeta que
contiene el manual en formato .pdf.

Para instalar el Adobe Acrobat Reader para leer el archivo, in-
serte el DVD-ROM Device Drivers & Utilities + User’s Ma-
nual y haga clic en User’s Manual (botón) y haga clic en
Install Acrobat Reader (botón).
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4. Si no ha configurado una contraseña de Windows se le 
pedirá que lo haga (nota: Si no ha configurado una 
contraseña Protector Suite QL no puede asegurar el acceso 
a su ordenador).

5. Haga clic en Siguiente y se le pedirá que escriba su 
contraseña de Windows.

6. Haga clic en Siguiente > Siguiente (puntee en el cuadro 
“Ejecute el tutorial interactivo” para ejecutar el Tutorial de 
huellas digitales).

7. Haga clic en Siguiente en cada ventana del tutorial (puede 
hacer clic en el botón “Omitir el tutorial” en cualquier 
momento).

8. Haga clic en el botón sobre cualquiera de las huellas digitales 
para iniciar el proceso de inclusión de ese dedo.

9. Coloque el dedo tres veces para incluirlo.
10. Repita el proceso para todos los dedos que desee incluir, y 

luego haga clic en Siguiente.
11. Haga clic en Finalizar.
12. Haga clic en cualquiera de los títulos en “Obtener más 

información:” para obtener más información sobre un tema.
13. Haga clic en Cerrar.
14. Reinicie el ordenador.
15. Haga clic con el botón derecho en el icono  de la barra de 

tareas para abrir el menú que le permitirá Editar huellas 
digitales, iniciar el Centro de control, acceder al menú 
Ayuda, etc. También puede ejecutar el Centro de control 
etc. desde la opción Protector Suite QL en el menú Inicio > 
Programas/Todos los programas.

16. Consulte “Ayuda & Manual” en la página 148 para más 
detallas.

17. Si coloca su dedo sobre el lector en cualquier momento, 
podrá acceder al Biomenú para bloquear el ordenador, 
registrar sitios de la web, Desbloquear Mi seguridad, abrir 
el Centro de control y acceder al menú Ayuda.

18. El Centro de control le permite cambiar la Configuración, 
registrar huellas digitales y obtener Ayuda.

Figura 12 - Centro de control & Biomenú 

Inclusión de huellas digitales

Tenga en cuenta que se recomienda encarecidamente que
incluya más de un dedo en caso de lesión, etc.
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Módulo sintonizador de TV USB
Se incluirán un CD con controladores, software y una guía del usuario si su opción de compra
incluye el módulo sintonizador de TV USB opcional. Se incluye además un controlador en
el DVD-ROM Device Drivers & Utilities + User's Manual para el mando a distancia
incluido con el sintonizador de TV.

Además se incluye un mando a distancia y la antena y accesorios necesarios para el módulo
sintonizador de TV USB.

Con el sintonizador de TV instalado, podrá ver la televisión, realizar videoconferencia y cap-
turar imágenes instantáneas y vídeo en el ordenador.

El conector de antena de cable (CATV) sólo estará activado si el módulo sintonizador
de TV está instalado. Asegúrese de instalar el software necesario antes de conectar la
antena de TV.

Antena TV

La antena de TV suminis-
trada con cualquier módulo
sintonizador de TV sirve
sólo para uso en interiores.
No utilice su módulo sintoni-
zador de TV en exteriores.

Mando a distancia del 
sintonizador de TV

Apunte con el mando al
transceptor CIR para cam-
biar de canal, etc.

Figura 13 
Puertos y conectores 
del sintonizador de TV
1. Transceptor de 

infrarrojos/transceptor de 
infrarrojos doméstico 
(CIR)

2. Conector de antena de 
cable (CATV)

2

1
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Instalación del controlador de 
infrarrojos (CIR)
1. Haga clic en Optional (botón).
2. Haga clic en 5.Install ITE CIR Driver > Sí.
3. Haga clic en Next > Yes > Next > Finish.

Instalación del controlador de 
sintonizador de TV 
1. Inserte el CD del controlador de sintonizador de TV en la 

unidad de CD/DVD.
2. Haga clic en MC770A Driver V2.3.3.3 Setup for XP/Vista.
3. Haga clic en Install > OK.
4. Haga clic en S/W Encoder V1.0.70807 Setup for Vista 

para instalar el encoder software.
5. Haga clic en Siguiente.
6. Haga clic en el botón Acepto los términos del contrato 

de licencia, luego haga clic en Siguiente.
7. Haga clic en Siguiente > Siguiente > Siguiente > Finalizar.
8. Haga clic en AP V2.0.1810.70802 Setup for XP/Vista 

para instalar la aplicación.
9. Haga clic en Siguiente.
10. Haga clic en el botón Acepto los términos del contrato 

de licencia, luego haga clic en Siguiente.
11. Haga clic en Siguiente (cerciorarte de que entraras a 

usuario y nombre de compañía).
12. Escriba la llave del CD proporcionada,  y haga clic en Siguiente.

13. Elija el idioma que prefiera y haga clic en Siguiente.
14. Haga clic en Siguiente > Siguiente > Siguiente.
15. Haga clic en el botón para reiniciar el sistema., y haga clic 

en Siguiente.
16. Haga clic en Finalizar para reiniciar el sistema.
17. Ejecute el programa de la aplicación Hybrid DTV desde 

el acceso directo (DTVplayer) en el escritorio o desde la 
opción DTVplayer en el menú Inicio > Programas/
Todos los programas > Hybrid DTV.
o

18. Ejecute Windows Media Center directamente desde el 
menú Inicio (Inicio > Programas/Todos los programas 
> Windows Media Center).

19. La Ayuda y soporte de Windows ofrece información sobre 
las funciones de Windows Media Center. Haga clic en 
Inicio  y seleccione Ayuda y soporte, luego escriba 
"Media Center" en la casilla Buscar ayuda y haga clic en 
el icono de la lupa  para mostrar los resultados.

Windows Media Center

Tenga en cuenta que el software Windows Media Center
viene incluido solamente en las ediciones Windows Vis-
ta Home Premium y Ultimate. 
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Señal de emisión de TV digital
La antena es el factor más importante para la recepción de
una señal de emisión de televisión digital terrestre. La
antena pasiva incluida debería ofrecer una señal clara
colocándose junto a una ventana. Si la señal no es clara
puede comprar una antena activa (también debería
colocarse junto a una ventana) para mejorar la señal.
También debería consultar un sitio web gubernamental con
información sobre la cobertura en su área de la televisión
digital terrestre. Tenga en cuenta que (a diferencia de la
televisión analógica estándar) si la señal digital es débil, no
aparecerá ninguna imagen en el televisor.

Grabación de TV y Planes de energía
Si va a utilizar el sintonizador de TV opcional para grabar
TV en vivo, vaya al panel Opciones de energía y cree un
plan de energía para evitar que las opciones de ahorro de
energía ajusten el nivel de rendimiento del ordenador.

Mando a distancia
El mando a distancia le permite de forma remota iniciar y
poner el sistema en estado de ahorro de energía, iniciar
Windows Media Center, navegar por los menús de Media
Center, etc. El mando a distancia también ofrece un control
total sobre todas las funciones de TV y vídeo.

Seguridad del cable CATV

Compruebe si su instalador del sistema CATV ha conecta-
do la protección del cable Coaxial al sistema de tierra del
edificio, lo más cerca posible del punto de entrada del ca-
ble.

Este recordatorio se proporciona para llamar la atención de
CATV del instalador del sistema al artículo 820-93 del NEC
(Sección 54, parte I del código eléctrico canadiense).
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Módulo de memoria Intel Turbo
Si ha incluido una tarjeta de memoria flash Intel Turbo Memory (Robson) NAND como
opción de compra deberá activar la opción en la BIOS ANTES de instalar el sistema
operativo Windows Vista (no active esta opción en Windows XP o en un sistema operativo
Windows Vista instalado sin la opción activada).

Intel Turbo Memory Technology (también conocida como memoria flash Robson) es una
tecnología de Intel que reduce el tiempo de arranque de un ordenador, de carga de
aplicaciones y de escritura de datos en el disco duro. Intel Turbo Memory Technology es
soportado solamente en Windows Vista (también soporta características de Windows Vista
como ReadyBoost, ReadyDrive y Superfetch).

Configuración de la memoria Intel Turbo e instalación del 
controlador
1. Inicie su ordenador y pulse F2 para entrar en la BIOS.
2. Vaya al menú Advanced.
3. Seleccione Advanced Chipset Control y pulse Entrar.
4. Pulse la barra de espacio para asegurarse de que Intel Robson está Activado (Enabled).
5. Vaya al menú Boot.
6. Seleccione CD/DVD-ROM Drive (asegúrese de que Microsoft Windows Vista OS CD está 

insertado) como 1st Boot Device en el menú Boot priority order.
7. Seleccione Save and Exit en el menú Exit (o pulse F10 y Entrar) y pulse Entrar para salir 

de la BIOS y reiniciar el ordenador.
8. Presione cualquier tecla cuando vea el mensaje "Press any key to boot from CD or DVD".

Problema con 
ReadyBoost

Cuando Intel® Turbo
Memory Console se abre
junto tras encender el
sistema, Windows
ReadyBoost puede
parecer estar desactivado.

Este comportamiento es
normal. El estado parece
desactivado mientras
Microsoft genera el archivo
Windows ReadyBoost.
Una vez generado el
archivo, el estado debería
aparecer Activado de
nuevo.

Visite el sitio web de Intel
(http://support.intel.com/
support/chipsets/itm/sb/
CS-025852.htm) para la
última información acerca
de este tema.
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9. El software del sistema le guiará a través del proceso de instalación (consulte su documentación de Windows Vista para más 
detalles).

10. Instale los controladores según las instrucciones en “Instalación de controladores” en la página 141 (asegúrese de que los 
controladores están instalados en el orden indicado en la Tabla 5 en la página 141).

11. Inserte el DVD-ROM Device Drivers & Utilities + User’s Manual en la unidad de CD/DVD.
12. Haga clic en Optional (button).
13. Haga clic en 6.Install Robson Driver > Sí.
14. Haga clic en Siguiente > Sí > Siguiente > Siguiente.
15. Haga clic en Finalizar para reiniciar el sistema.
16. Tras reiniciarse el ordenador, haga clic en Reiniciar ahora para completar el proceso de instalación después de que el 

ordenador haya realizado los cambios de hardware necesarios.

Figura 14 - Menús Advanced y Advanced Chipset Control de BIOS

Main Advanced Security Boot Exit

F1 Help �� Select Item -/+ Change Values F9 Setup Defaults
Esc Exit �� Select Menu Enter Select �Sub-Menu F10 Save and Exit

Item Specific Help

Advanced

Select options for
Advanced Chipset
features.

Phoenix TrustedCore(tm) Setup Utility

�Advanced Chipset Control
Reset Configuration Data: [No]
Local Bus IDE adapter: [Both]

Boot-time Diagnostic Screen: [Enabled]
Legacy USB Support: [Enabled]
USB 2.0 Enable: [Enabled]
POST Beep Sound [Disabled]
Battery Low Alarm Beep: [Disabled]

F1 Help �� Select Item -/+ Change Values F9 Setup Defaults
Esc Exit �� Select Menu Enter Select �Sub-Menu F10 Save and Exit

Item Specific Help

Advanced

Phoenix TrustedCore(tm) Setup Utility

Intel Turbo Memory
Technology

Advanced Chipset Control

Intel Robson [Enabled]
SATA - Device 31, Function 2: [Enhanced]
AHCI Configuration Enabled]
DFOROM(Robson) Support: [Enabled]
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Solución de problemas
Problema Posible causa - Solución

El código regional de DVD 
no puede volver a 
cambiarse.

El código se ha cambiado 5 veces, que es el máximo. La detección del código regional de DVD 
depende del dispositivo y no del sistema operativo. Es posible seleccionar el código regional 5 
veces. La quinta selección es permanente. No se puede alterar por más que se cambie de sistema 
operativo o el módulo se utilice en otro ordenador.

TouchPad no funciona. TouchPad ha sido desactivado. Pulse la combinación de teclas (Fn + F1) para activar TouchPad 
(asegúrese de haber instalado el controlador TouchPad).

Los módulos WLAN/
Bluetooth no pueden 
detectarse.

El (Los) módulo(s) está(n) desactivado(s). Compruebe el indicador LED apropiado  para ver si el 
módulo está activado o desactivado (consulte “Indicadores LED” en la página 129). Si el indicador 
LED está apagado, entonces pulse la combinación de teclas apropiada para activar el módulo 
(consulte “Teclas de función & indicadores visuales” en la página 131).

La cámara PC muestra una 
pantalla negra cuando se 
ejecuta el software de la 
cámara PC.

El software está usando el dispositivo incorrecto. Si tiene los módulos cámara PC (opcional) y 
sintonizador de TV (opcional) presentes, vaya al menú Devices (Dispositivos) en el programa 
BisonCap/VideoView y seleccione el dispositivo BisonCam, NB Pro/USB2.0 2M WebCam 
(cámara PC).

Los archivos de vídeo 
capturados de la cámara PC 
ocupan demasiado espacio 
en el disco.

Tenga en cuenta que capturar archivos de vídeo de alta resolución requiere una cantidad sustancial 
de espacio en el disco para cada archivo.

Tenga en cuenta que el sistema Windows Vista requiere un mínimo de 15GB de espacio libre en la 
partición del sistema unidad C:. Se recomienda que guarde el archivo de vídeo capturado en una 
ubicación distinta a la unidad C:, limite el tamaño de archivo del vídeo capturado o reduzca la 
resolución del vídeo (Options > Video Capture Pin... > Tamaño de salida).
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Error de resolución de pantalla
Si experimenta una reducción de la resolución en pantalla o si la pantalla parpadea tras reiniciar desde el estado de
Suspensión en Windows Vista solamente, siga estas instrucciones para solucionar el problema. Este error surge por el
funcionamiento interno de Windows Vista, que activa TMM (Transient Multimon Manager) cuando la tapa del portátil
(S3) se cierra. TMM desconecta la pantalla LCD del SO y luego vuelve a encenderla cuando la tapa se abre. Esto puede
hacer que TMM cambie a una configuración de pantalla antigua y puede provocar que la pantalla parpadee o un cambio
en la resolución.
1. Haga clic en Inicio (menú),  y haga clic en Panel de control (o vaya a Configuración y haga clic en Panel de control) y haga 

doble clic en Herramientas administrativas (Sistema y Mantenimiento).
2. Haga doble clic en Programador de tareas (Programar tareas).
3. Haga doble clic en Biblioteca del Programador de tareas > Microsoft > Windows, y haga clic en MobilePC para abrir el panel de 

control.
4. Haga clic con el botón derecho en TMM y seleccione Deshabilitar, y luego cierre todos los paneles de control.

Figura 15 - Sistema y Mantenimiento (Panel de control)
156 -  Solución de problemas
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Especificaciones

Característica Especificación

Tipos de 
procesadores

Procesador Intel Core 2 Duo
Micro-FCPGA package (478 contactos)
T7100

(65nm) tecnología de proceso de 65 nm
Caché de nivel 2 de 2MB & bus de sistema de 800MHz 
1,80 GHz

Procesador Intel Core 2 Duo
Micro-FCPGA package (478 contactos)
T7300/ T7500/ T7700

(65nm) tecnología de proceso de 65 nm
Caché de nivel 2 de 4MB & bus de sistema de 800MHz 
2,0/ 2,2/ 2,4 GHz

Núcleo Logic Chipset Intel(R) PM965 + ICH8M

Memoria Dos bases de 200 contactos SODIMM, para memoria  DDRII (DDR2) 533/ 667
Memoria expansible hasta 4GB

Seguridad Ranura para cierre de seguridad (tipo Kensington®) Contraseña de BIOS
Módulo lector de huellas digitales (opción de fábrica)

BIOS Un Flash ROM de 8Mb Phoenix BIOS

Información actualizada de especificaciones

Las especificaciones listadas en este Apéndice son correctas en el momento de publicación. Ciertas opciones (particularmente
tipos/velocidades de procesadores) pueden cambiar o actualizarse según la fecha de lanzamiento del fabricante. Diríjase a su
centro de servicios para más detalles.
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Dispositivos de 
almacenamiento

Una unidad de dispositivo óptico (CD/DVD) de 12,7mm(h) intercambiable (consulte “Opciones” en la 
página 160 para las opciones del módulo de unidad óptica)
Un HDD SATA fácil de cambiar de 2,5" 9,5 mm (h)

Opciones de LCD Pantalla plana TFT tipo brillo, 17" WXGA (1280*800) 
Pantalla plana tipo TFT sin reflejos, 17" WXGA 
(1280*800) 

Pantalla plana TFT tipo brillo,17" WSXGA+ 
(1600*1050) 
Pantalla plana TFT tipo brillo,17" WUXGA (1920*1200) 

Opciones de 
tarjetas de vídeo

Tarjeta de vídeo NVIDIA GeForce Go 7950 GTX 
PCI-E 
MXM-IV
512MB de RAM de vídeo GDDR3
Compatible con DirectX® 9

Tarjeta de vídeo NVIDIA GeForce 8700M GT PCI-E
MXM-III
512MB de RAM de vídeo GDDR3
Compatible con DirectX® 10
Soporta HDCP

Tarjeta de vídeo NVIDIA GeForce 8800M GTX PCI-E 
MXM-IV
512MB de RAM de vídeo GDDR3
Compatible con DirectX® 10
Soporta HDCP

Lector de tarjetas Módulo lector de tarjetas 7 en 1 (MS/ MS Pro/ SD/ Mini SD/ MMC/ RS MMC/ MS Duo)
Nota: Tarjetas MS Duo/ Mini SD/ RS MMC requieren PC adaptador

Característica Especificación

Tarjetas de vídeo soportadas

Tenga en cuenta que los tipos de tarjetas, especi-
ficaciones y controladores están sujetos a conti-
nuas actualizaciones y cambios. Consulte con su
centro de servicios los últimos detalles sobre las
tarjetas de vídeo soportadas.
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Audio Interfaz compatible Intel HDA (Sonido Intel de alta 
definición)
Sistema de sonido estéreo 3D

 Sonido SRS WOW Surround
Compatible con Sound-Blaster PRO™

Emissione digitale S/PDIF 
Micrófono incorporado
2 altavoces incorporados (1,5W, 8Ω)

1 Sub-Woofer (2W, 8Ω)

Teclado Teclado "Win Key" de tamaño completo (con teclado numérico)

Dispositivo 
puntero

TouchPad incorporado (funcionalidad de tecla de desplazamiento integrada)

Ranura 
ExpressCard Ranura ExpressCard/54(34)

Interfaz Cuatro puertos USB 2.0
Un puerto de salida DVI
Un conector de salida de altavoces/auriculares
Un conector de entrada para micrófono
Un conector de salida S/PDIF
Un conector de entrada de línea para entrada de 
audio
Un puerto serie
Un puerto Mini-IEEE 1394
Un transceptor de infrarrojos
Un conector RJ-11 para módem

Un conector RJ-45 para LAN
Un conector de entrada de CC
Un conector de salida de S-Vídeo para salida de TV y 
HDTV
Un conector de antena de cable (CATV) (analógico/
digital) (funciona con el sintonizador de TV opcional)
Un transceptor de infrarrojos doméstico (CIR) (fun-
ciona con el sintonizador de TV opcional)
Una ranura Mini Card para sintonizador de TV o 
módulo Intel Turbo Memory
Una ranura Mini Card para WLAN solamente

Administración 
de energía

Soporta ACPI v3.0

Característica Especificación
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Comunicaciones Fax/Módem de 56K (compatible con V.90 y V.92) 
LAN Ethernet de 1Gbit PCI-Express incorporada

Módulo sintonizador de TV USB  (opción)
Módulo WLAN PCIe Intel Wireless Wi-Fi Link 
4965AGN (opción)

Módulo Bluetooth USB + EDR - V2.0 (opción de 
fábrica)
Módulo cámara PC USB de 1,3M o 2,0M píxeles   
(opción de fábrica)

Alimentación Adaptador de CA/CC autodetector de corriente
Entrada CA: 100~240V, 50~60Hz
Salida CC: 20V, 6,0A (120W) 

Batería principal fácilmente intercambiable de 8 ele-
mentos Smart Lithium-Ion de 4400mAH 

Especificaciones 
del ambiente

Temperatura
En funcionamiento: 5°C - 35°C 
Apagado: -20°C - 60°C

Humedad relativa
En funcionamiento: 20% - 80%
Apagado: 10% - 90%

Dimensiones & 
Peso 397 (a) x 284 (l) x 22 - 44 (h) mm Alrededor de 3,95 kgs (+/- 5%) con batería (8 pilas)

Opciones Opciones del módulo de unidad óptica:
Unidad combinada 
Unidad de DVD Super-Multi 

Módulo WLAN PCIe Intel Wireless Wi-Fi Link 
4965AGN
Módulo sintonizador de TV USB
Tarjeta de memoria flash Intel Turbo Memory (Rob-
son) NAND

Módulo Bluetooth USB + EDR  - V2.0 (opción de 
fábrica)
Módulo cámara PC USB de 1,3M o 2,0M píxeles   
(opción de fábrica)
Módulo lector de huellas digitales (opción de fábrica)

Característica Especificación
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Avviso
La società si riserva il diritto di revisionare la presente pubblicazione o di modificarne il contenuto senza preavviso. Le
informazioni qui contenute sono per solo riferimento e non costituiscono obbligo sulle parti del produttore o di qualsiasi
venditore successivo. Essi non si assumono alcuna responsabilità o obbligo per qualsiasi errore o imprecisione presente in
questa pubblicazione, né sono responsabili per qualsiasi perdita o danno risultante dall'uso (o cattivo uso) della presente
pubblicazione.
Questa pubblicazione e ogni software fornito a corredo non può, in parte o per intero, essere riprodotta, tradotta, trasmessa
o ridotta in una forma leggibile da macchine senza previo consenso dei venditori, produttori e creatori della pubblicazione
stessa, eccetto per le copie tenute dall'utente a scopo di backup.
I marchi e i nomi dei prodotti menzionati in questa pubblicazione possono o meno costituire copyright e/o marchi registrati
delle rispettive società. Essi sono menzionati per solo scopo identificativo e non sono intesi come avallo di tale prodotto o
del suo produttore.

© Novembre del 2007

Marchi registrati
Il presente prodotto incorpora una tecnologia di protezione di copyright protetta dalle rivendicazioni di metodo di alcuni
brevetti degli Stati Uniti o di altri diritti di proprietà intellettuale posseduti da Macrovision Corporation e altri possessori
di diritti. L'uso di questa tecnologia di protezione di copyright deve essere autorizzata da Macrovision Corporation, ed è
intesa per l'uso domestico o altri usi di visualizzazione limitata solo se non diversamente autorizzato da Macrovision
Corporation. La decodifica, la decompilazione e il disassemblaggio sono proibiti.
Intel ed Intel Core sono marchi/marchi registrati della Intel Corporation.

 è un marchio di fabbrica di SRS Labs, Inc. 
La tecnologia WOW è incorporata sotto licenza concessa da SRS Labs, Inc.
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Informazioni sulla Guida Rapida per l'Utente
Questo manuale rappresenta un’introduzione rapida all’avvio del sistema. Si tratta di un supplemento e non di una
sostituzione del Manuale per l'utente completo in lingua inglese nel formato Adobe Acrobat, memorizzato sul DVD-ROM
Device Drivers & Utilities + User's Manual fornito a corredo del computer. Inoltre, questo DVD-ROM contiene i driver e
le utilità necessari per il corretto uso del computer.

È possibile che alcune o tutte le funzionalità del computer siano già state configurate. In caso contrario, o se si sta
pianificando di riconfigurare (o reinstallare) componenti del sistema, fare riferimento al Manuale utente completo. Il DVD-
ROM Device Drivers & Utilities + User’s Manual non contiene il sistema operativo.

Informazioni di regolamentazione
Le informazioni e le comunicazioni di regolamentazione sono contenute nel Manuale utente completo memorizzato sul
DVD-ROM Device Drivers & Utilities + User’s Manual.

Funzionamento delle periferiche wireless in aereo

In genere, l'utilizzo di dispositivi di trasmissione elettronici portatili è proibito a bordo degli aerei.
Accertarsi che i moduli wireless siano spenti quando si utilizza il computer in aereo.
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Istruzioni per la custodia e il funzionamento
Il computer notebook è abbastanza rigido, ma è possibile che possa essere danneggiato. Per evitare qualsiasi danno,
attenersi ai seguenti suggerimenti:

• Non lasciarlo cadere ed evitare urti. Se il computer cade, è possibile che il telaio e i componenti possano esserne danneggiati.
• Tenerlo all'asciutto e non provocarne il surriscaldamento. Tenere il computer e l'alimentazione lontani da ogni tipo di impianto 

di riscaldamento. Si tratta di un apparato elettrico. Se acqua o altri liquidi dovessero penetrarvi, esso potrebbe risultarne 
seriamente danneggiato.

• Evitare le interferenze. Tenere il computer lontano da trasformatori ad alta capacità, motori elettrici e altri intensi campi 
magnetici. Ciò ne può impedire il corretto funzionamento e danneggiare i dati.

• Attenersi alle corrette procedure di lavoro con il computer. Spegnere il computer correttamente e non dimenticare di salvare il 
proprio lavoro. Ricordare di salvare frequentemente i propri dati poiché essi potrebbero essere persi nel caso in cui la batteria si 
esaurisse.

• Porre particolare cura nell'utilizzo delle periferiche.

Assistenza
Non provare a riparare il computer da soli. Una tale azione invaliderebbe la garanzia ed esporrebbe l'utente del computer
al pericolo di una scossa elettrica. Fare riferimento al personale dell'assistenza autorizzata. Scollegare il computer
dall'alimentazione. Fare riferimento all'assistenza di personale qualificato nei seguenti casi:

• Quando il cavo di alimentazione è danneggiato o logorato.
• Se il computer è stato esposto alla pioggia o ad altri liquidi.
• Se il computer non funziona normalmente dopo aver seguito correttamente le istruzioni operative.
• Se il computer è caduto o si è danneggiato (non toccare il liquido velenoso in caso di rottura dello schermo LCD).
• Se c'è un odore non usuale, calore o fumo che fuoriesce dal computer.
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Sicurezza relativa all'alimentazione
Il computer presenta specifici requisiti di alimentazione:
• Utilizzare esclusivamente un adattatore approvato per l'utilizzo di questo computer.
• L'adattatore CA/CC potrebbe essere stato progettato per viaggi all'estero, ma richiede ugualmente un'alimentazione stabile e 

continua. Se non si è certi delle specifiche elettriche locali, consultare l'assistenza tecnica o la società locale di fornitura elettrica.
• L'adattatore di alimentazione deve avere una spina dotata di messa a terra a due o tre poli. Il terzo polo costituisce un'importante 

funzionalità di sicurezza. Non rinunciare al suo impiego. Se non è disponibile una presa compatibile, farne installare una da un 
elettricista qualificato.

• Quando si desidera scollegare il cavo dell'alimentazione, accertarsi di scollegarlo toccando la testa della spina, non il suo cavo.
• Accertarsi che la presa e ogni prolunga utilizzata siano in grado di supportare il carico di corrente totale risultante da tutte le 

periferiche collegate.
• Prima di pulire il computer, assicurarsi di scollegarlo da qualsiasi sorgente di alimentazione esterna.

Pulizia
• Non applicare alcun detergente direttamente sul computer, utilizzare solo un panno morbido e pulito. 
• Non utilizzare detergenti volatili (distillati di petrolio) o abrasivi su qualsiasi parte del computer.

Avviso Sicurezza Alimentazione

Prima di effettuare qualsiasi procedura di aggiornamento, accertarsi di aver spento il computer e di aver scollegato tutti i cavi e le
periferiche (incluse le linee telefoniche). È inoltre consigliabile rimuovere la batteria al fine di evitare l'accensione accidentale del computer.

Spegnimento prima di un viaggio

Assicurarsi che il notebook sia completamente spento prima di inserirlo in una borsa da viaggio (o in un contenitore simile). Inserendo un
computer ancora acceso in una borsa da viaggio, la (le) ventola (ventole) ne saranno ostruite. Per evitare il surriscaldamento del computer,
accertarsi di non ostruire la (le) ventola (ventole) quando il computer è in uso.
164 -  Istruzioni per la custodia e il funzionamento
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Precauzioni relative alla batteria
• Utilizza unicamente batterie progettate per questo computer. Un tipo di batteria errato potrebbe esplodere, avere perdite o 

danneggiare il computer.
• Non continuare a usare in alcun modo una batteria che sia caduta in terra o che sembri danneggiata (es. piegata o torta). 

Anche se il computer continua a funzionare con una batteria danneggiata, questa può provocare danni ai circuiti risultanti in 
pericolo di incendio.

• Ricaricare le batterie utilizzando il sistema del notebook. Un'operazione di ricarica non corretta può far esplodere la batteria.
• Non provare a riparare il pacco batteria. Fare riferimento sempre all'assistenza tecnica o a personale qualificato per la riparazione 

o la sostituzione del pacco batteria.
• Tenere i bambini lontani da una batteria danneggiata e provvedere tempestivamente al suo smaltimento. Smaltire sempre con cura 

le batterie. Le batterie possono esplodere o presentare perdite se esposte a fuoco oppure se manipolate o smaltite impropriamente.
• Tenere la batteria lontana da qualsiasi apparecchio di metallo.
• Apporre del nastro adesivo sui contatti della batteria prima di smaltirla.
• Non toccare i contatti della batteria con le mani o con oggetti metallici.

Smaltimento della batteria & Attenzione

Il prodotto acquistato contiene una batteria ricaricabile. La batteria è riciclabile. Al termine della durata di uso, in base alle diverse
leggi locali e statali, può essere illegale smaltire questa batteria insieme ai rifiuti comuni. Controllare i requisiti previsti nella propria
zona consultando i funzionari locali addetti allo smaltimento dei rifiuti solidi per le opzioni di riciclo o lo smaltimento corretto.

Pericolo di esplosione in caso sostituzione errata della batteria. Sostituire solamente con lo stesso tipo o con uno analogo
raccomandato dal produttore. Eliminare la batteria usata seguendo le istruzioni del produttore.
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Guida di avvio rapido
1. Eliminare tutti i materiali di imballo.
2. Appoggiare il computer su una superficie stabile.
3. Collegare bene le periferiche che si desidera usare con il notebook (per esempio tastiera e 

mouse) alle porte corrispondenti.
4. Collegare l'adattatore CA/CC al jack di ingresso CC situato alla destra del computer, quindi 

inserire il cavo di alimentazione CA in una presa e collegare il cavo di alimentazione CA 
all'adattatore CA/CC.

5. Spostare i dispositivi a scatto LCD sulla parte anteriore del computer verso l'esterno, in 
direzione dei lati del computer e tenerli in posizione per rilasciare la copertura superiore.

6. Sollevare il coperchio/LCD ad una angolazione comoda per la visualizzazione. Premere il 
pulsante di alimentazione per accendere.

Differenze dei modelli
Questa serie di notebook comprende due stili di design differenti, ma nella guida viene
illustrato uno solo di essi.

Spegnimento

È importante tenere pre-
sente che è sempre neces-
sario spegnere il computer
scegliendo il comando Ar-
resta il sistema disponibile
dal menu del pulsante
Blocca di Windows Vista.
In questo modo si evitano
problemi al sistema o al di-
sco rigido.

Figura 1
Adattatore CA/CC 

inserito
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Software del sistema
È possibile che il software sia già pre-installato sul
computer. In caso contrario, oppure in casi di
riconfigurazione del computer per un sistema diverso,
questo manuale si riferisce al sistema operativo Microsoft
Windows Vista. Ulteriori informazioni sull’installazione di
driver e utilità sono disponibili nei Capitoli 4 & 7 del
Manuale per l’utente esteso oppure nel DVD-ROM Device
Drivers & Utilities + User’s Manual.

Sistemi operativi supportati

*Per informazioni sul SO Windows XP consultare il DVD-
ROM Device Drivers & Utilities + User’s Manual.

Non incluso
I sistemi operativi (per esempio Windows Vista/Windows
XP) sono dotati di manuali propri, come pure le
applicazioni (per esempio, programmi di elaborazione
testo, fogli di calcolo e database), quindi consultare i
manuali specifici.

Driver

Se si sta installando/disinstallando un nuovo software di siste-
ma, sarà necessario installare i driver appropriati. È molto im-
portante installare i driver nell'ordine elencato nella Tabella 5 a
pagina 181.

Modulo Intel Turbo Memory

Se nell'opzione di acquisto è stato incluso il modulo scheda di
memoria NAND Intel Turbo Memory (Robson), sarà necessario
abilitare l'opzione nel BIOS PRIMA di installare il sistema ope-
rativo Windows Vista (non abilitare questa opzione in Windows
XP oppure su un sistema operativo Windows Vista che è stato
installato senza l'opzione abilitata). Vedere la pagina 193.

Sistema operativo Nota

*Windows XP (Home Edition o Pro-
fessional)

Windows Vista (64-bit) Home Basic 
Editon

Per avviare Windows 
Vista senza limitazioni 
o prestazioni inferiori, è 
necessario che il com-
puter disponga di 
almeno 1GB di memo-
ria di sistema (RAM).

Windows Vista (64-bit) 
Home Premium Editon/Business 

Edition/Enterprise Edition/Ultimate 
Editon
Software del sistema - 167
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Descrizione del sistema: Vista superiore con 
pannello LCD aperto

Figura 2
Vista superiore con 
pannello LCD aperto

1. Camera PC (opzionale)
2. Schermo LCD
3. Pulsanti Hot-Key
4. Pulsante di 

alimentazione
5. Tastiera
6. TouchPad e pulsanti
7. Lettore d’impronte 

digitali (opzionale)
8. Indicatori LED 

alimentazione e 
comunicazione

9. Microfono incorporato

6

7

Funzionamento del 
dispositivo senza fili a 

bordo di un aereo

Solitamente l’uso di
qualsiasi dispositivo di
trasmissione elettronica è
proibito a bordo di un aereo.
Verificare che i moduli
(WLAN/Bluetooth) siano
spenti (OFF) se state
usando il computer a
bordo di un aereo.
 
Utilizzare la combinazione di
tasti appropriata (vedere la
Tabella 3 a pagina 171) per
disattivare i moduli WLAN/
Bluetooth e verificare
l'indicatore di stato  per
accertarsi che i moduli siano
spenti  (vedere la Tabella 1
a pagina 169).

2

1

5

7 8

6

43

9
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Indicatori LED
Gli indicatori LED sul computer segnalano importanti informazioni relative allo stato corrente del computer.

Tabella 1 - Indicatori LED

Icona Colore Descrizione Icona Colore Descrizione

Verde Il computer è acceso Arancione Batteria in ricarica

Verde lampeg-
giante

Il computer è in modalità 
Sospensione

Arancione lampeg-
giante

La batteria ha raggiunto lo stato 
critico di carica bassa

Arancione L'alimentatore è collegato Verde Batteria completamente carica

Verde La funzione Blocco nume-
rico è attivata Verde Il disco rigido è in uso

Verde Bloc Maiusc è attivato Arancione Il modulo Bluetooth è attivo

Verde Bloc Scorr è attivato Verde Il modulo LAN Wireless è attivo
Indicatori LED - 169
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Pulsanti Hot-Key & tastiera
I pulsanti Hot-Key forniscono accesso immediato al
browser Internet predefinito e al programma di posta
elettronica, oltre che a un'applicazione definita dall'utente
(vedere “Pulsante Hot-Key dell'applicazione” a
pagina 172), con una rapida pressione del pulsante.

Tabella 2 - Pulsanti Hot-Key

La tastiera è dotata di un tastierino numerico (sul lato destro
della tastiera) per facilitare l'immissione di dati numerici.
Premere il tasto Bloc Num per commutare l’attivazione e la
disattivazione della tastiera numerica. Dispone anche di
tasti funzione che consentono di cambiare
istantaneamente le funzionalità operative.

Figura 3 -  Tastiera

Pulsante Hot-Key Funzione

Attivare il browser Internet predefinito

Attivare il programma di posta elettro-
nica predefinito

Attivare l'applicazione specificata 
dall'utente (ad esempio Microsoft 
Word o Excel)

Numeric 

Tastierino numerico
Tasto Fn 

Tasti funzione

Tasto Bloc Num/Bloc Scorr

Caratteri speciali

Alcune applicazioni software consentono di utilizzare i tasti
numerici insieme al tasto Alt per produrre caratteri speciali.
Tali caratteri speciali possono essere riprodotti solo utiliz-
zando il tastierino numerico. I tasti numerici regolari (nella
riga superiore della tastiera) non funzionano. Accertarsi che
sia attivo il Bloc Num (tastierino numerico).
170 -  Pulsanti Hot-Key & tastiera
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Tasti funzione/indicatori visivi
I tasti funzione (da F1 a F12) agiscono come Hot-Key quando premuti tenendo premuto il tasto Fn. In aggiunta alle
combinazioni di tasti funzione base, quando è installato il driver hot key (HotKey Driver) sono disponibili gli indicatori
visivi (vedere “Hot-Key” a pagina 182). Dopo aver installato il driver, nella barra delle applicazioni appare l'icona .

Tasti Funzione/indicatori visivi Tasti Funzione/indicatori visivi

Fn + ~ Play/pausa (nei programmi Audio/Video) Fn + F8/F9 Riduzione/Aumento 
luminosità LCD

Fn + F1 Attiva/disattiva Tou-
chPad Fn + F10 Attiva/disattiva 

Camera PC

Fn + F2
Spegne la retroilluminazione dello schermo LCD 
(premere un tasto o utilizzare il TouchPad per 
ripristinare lo schermo)

Fn + F11 Attiva/disattiva LAN 
Wireless

Fn + F3 Commutazione 
Mute Fn + F12 Attiva/disattiva 

Bluetooth

Fn + F4 Commutazione Sospendi Bloc Num Attiva/disattiva blocco numerico (tastierino nume-
rico) 

Fn + F5/
F6

Riduzione/Aumento 
volume audio

Fn + Bloc 
Scorr

Attiva/disattiva il blocco dello scorrimento

Fn + F7 Commutazione Display Tabella 3 - Tasti funzione e indicatori visivi
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Pulsante Hot-Key dell'applicazione
Per configurare un programma in modo che si apra alla
pressione dell'hot key  dell'applicazione (il programma
predefinito è Windows Media Player), attenersi alle
istruzioni seguenti.

1. Fare doppio clic sull'icon  del driver delle Hot-Key 
nell'area di notifica.

2. Fare clic su Launch user specified application  
(pulsante) .

3. Comparirà la finestra di dialogo Apri.
4. Selezionare la cartella contenente l'applicazione exe del 

programma desiderato (vedere sotto).
5. Fare doppio clic sul file del programma o scegliere Apri,  

e fare clic su  OK (pulsante).
6. Premere il pulsante Hot-Key dell'applicazione  per 

aprire il programma (purché nell'area di notifica sia in 
esecuzione il driver delle Hot-Key).

Figura 4 - Driver delle Hot-Key

Application.exe

È necessario localizzare il file eseguibile dell'applicazione
in uso (exe) e non semplicemente il collegamento. Per ritro-
vare l'applicazione, fare clic con il tasto destro sul relativo col-
legamento sul desktop e fare clic su Proprietà. Fare clic sulla
scheda Collegamento e verificare dove si trova il file esegui-
bile facendo clic sul pulsante Apri percorso file.

Driver delle Hot-Key

Facendo clic sull'icona Chiudi , eseguire il programma dal
percorso del file:
(C:\Program Files (x86)\Hotkey_Driver\HotkeyDri-
ver.exe).
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Descrizione del sistema: Vista anteriore e 
posteriore

Figura 5
Vista anteriore e poste-

riore

1. Blocchi LCD
2. Jack di ingresso di linea
3. Jack uscita delle cuffie
4. Jack ingresso del 

microfono
5. Jack uscita S/PDIF 
6. Indicatori LED 

alimentazione e 
comunicazione

7. Ricetrasmettitore ad 
infrarossi/ricetrasmettitore 
CIR

8. Ventola
9. Jack dell'uscita S-Video
10. Porta uscita DVI
11. 2 Porte USB 2.0
12. Jack di ingresso CC
13. Porta seriale

1 1

2 3 4 5
6

8 9

Lato anteriore

Lato posteriore

7

8 11 12 1310

Surriscaldamento

Per prevenire il surriscaldamento del computer, accertarsi che non vi sia nulla che ostruisca la (le)
ventola (ventole) durante l’uso del computer.

 Porte USB

Si noti che i collegamenti alle porte USB sono possibili inserendo il connettore in una sola direzione,
senza forzarlo.
Descrizione del sistema: Vista anteriore e posteriore - 173



Guida Rapida per l'Utente

Ita
lia

no
Descrizione del sistema: Vista destra e sinistraFigura 6
Vista destra e sinistra

1. Slot ExpressCard/
54(34)

2. Lettore di schede 7-in-1 
3. 2 Porte USB 2.0 
4. Porta Mini-IEEE 1394
5. Jack telefonico tipo RJ-

11
6. Jack di rete tipo RJ-45
7. Jack dell'antenna a cavo 

(CATV) (abilitato solo 
con il sintonizzatore TV)

8. Altoparlante incorporato
9. Slot blocco di sicurezza
10. Bay unità ottica (per 

periferiche CD/ DVD)
11. Foro di espulsione di 

emergenza

1

2 3 4 5 6 7

Porta Mini-IEEE 1394

La porta Mini-IEEE 1394 supporta 
solamente dispositivi IEEE 1394 

AUTOALIMENTATI.

Slot ExpressCard

Lo slot ExpressCard accetta il formato 
ExpressCard/34 oppure il formato 

ExpressCard/54.

3 8

Lato destro

Espulsione di emergenza CD/DVD

Se si desidera estrarre manualmente un CD/
DVD (per esempio a causa di un'inaspettata
interruzione dell'alimentazione) è possibile
spingere l'estremità di una graffetta per carta
raddrizzata nel foro di espulsione di
emergenza. Non usare una matita appuntita o
un oggetto analogo che potrebbe rompersi
oppure rimanere incastrato nel foro. Non
cercare di estrarre un CD/DVD durante
l’accesso del sistema. Ciò può provocare un
arresto del sistema.

1098 11

Lato sinistro
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Descrizione del sistema: Vista inferiore Figura 7
Vista inferiore

1. Ventola
2. Batteria
3. Dispositivi di apertura 

dell'unità ottica
4. Copertura bay 

component
5. Ricetrasmettitore ad 

infrarossi/
ricetrasmettitore CIR

6. Subwoofer

Informazioni sulla batteria

Prima di utilizzare una batteria nuova, scaricarla prima completamente, quindi caricarla al massimo.
Scaricare completamente e caricare la batteria almeno una volta ogni 30 giorni oppure dopo una
ventina di cariche parziali.

1
2

3
4

5

1

6

1
1

1

3
1

CPU

La CPU non è un componente
che necessita assistenza da
parte dell’utente. Accedere alla
CPU in qualsiasi modo implica
una violazione della garanzia.

Surriscaldamento

Per prevenire il
surriscaldamento del
computer, accertarsi che non vi
sia nulla che ostruisca la (le)
ventola (ventole) durante l’uso
del computer.
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Menu Start e Pannello di controllo di Windows Vista
La maggior parte dei pannelli di controllo, utilità e programmi che compongono Windows Vista (e la maggior parte delle
versioni di Windows) sono accessibili tramite il menu Start. Quando si installano programmi e utilità, essi vengono
installati sul disco rigido, mentre un collegamentoche punta ad essi viene inserito nel menu Start e/o sul desktop. Fare clic
con il tasto destro sull'icona  , del menu Start quindi selezionare Proprietà per personalizzare l'aspetto del Menu Start.

In molte sezioni del presente manuale l'utente avrà modo di notare riferimenti al Pannello di controllo. Al Pannello di
controllo è possibile accedere attraverso il menu Start. Il Pannello di controllo consente di configurare le impostazioni
per la maggior parte delle funzionalità principali presenti in Windows (ad es. alimentazione, video, rete, audio, ecc.). Win-
dows Vista fornisce pannelli di controllo di base per molte delle funzionalità, tuttavia molti altri pannelli di controlli ven-
gono aggiunti (o quelli esistenti migliorati) quando si installano i driver elencati nella Tabella 5 a pagina 181. Per
visualizzare tutti i controlli potrebbe essere necessario attivare la visualizzazione classica.

Figura 8 - Menu Start & Pannello di controllo

 
Fare clic qui per passare alla Visualiz-
zazione classica 
176 -  Menu Start e Pannello di controllo di Windows Vista
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Funzioni video
È possibile modificare le Impostazioni di visualizzazione dal pannello di controllo Impostazioni schermo (in
Personalizzazione) in ambiente Windows Vista.

Per accedere alle Impostazioni schermo in Window Vista:

1. Fare clic su Start, e fare clic su Pannello di controllo (oppure scegliere Impostazioni e fare clic su Pannello di controllo). 
2. Fare clic su Modifica risoluzione dello schermo nel menu Aspetto e personalizzazione menu (o fare doppio clic su  

personalizzazione > Impostazioni schermo).
3. Scorrere l'indicatore nella posizione desiderata in  Risoluzione  (vedere la Figura 9 a pagina 178).
4. Fare clic sulla freccia e selezionare l'impostazione desiderata in Colori  (vedere la Figura 9 a pagina 178).
5. Fare clic su Impostazioni avanzate...  (vedere la Figura 9 a pagina 178) per visualizzare le schede delle Impostazioni 

avanzate.
6. Fare clic su GeForce..... (scheda).
7. Fare clic su Avvia Pannello di controllo NVIDIA  (vedere la Figura 9 a pagina 178) per accedere al pannello di controllo.
8. È possibile accedere al Pannello di controllo NVIDIA anche facendo clic con il pulsante destro del mouse sul desktop e scegliendo 

Pannello di controllo NVIDIA.

1
2

3

4

Supporto della scheda video

Si noti che i tipi di scheda, le specifiche tecniche e i driver sono soggetti a continue modifiche e aggiornamenti. Richiedere al centro as-
sistenza locale i dettagli più recenti relativi alle schede video supportate.
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Opzioni dello schermo
Oltre allo schermo LCD integrato, è possibile utilizzare un monitor VGA/LCD a schermo piatto o una TV come periferica
di visualizzazione. Un monitor VGA/LCD a schermo piatto si collega alla porta uscita DVI. Una TV si collega al jack uscita
S-Video. Sono disponibili le seguenti modalità di visualizzazione.

Tabella 4 - Modalità di visualizzazione

Modalità di visualizzazione Descrizione

Singola (Schermo singolo) È utilizzato uno schermo

Clone Entrambi gli schermi collegati visualizzano la stessa immagine

DualView (Vista doppia) Entrambi gli schermi collegati vengono trattati come una singola periferica e agiscono come un 
desktop virtuale

1 2

3

4

Figura 9 -  Impostazioni schermo
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Funzionalità audio
È possibile configurare le opzioni audio del computer dal pannello di controllo Audio  di Windows, oppure dall'icona
Gestione Audio Realtek HD /  nell'area di notifica/pannello di controllo (fare clic con il pulsante destro del mouse
sull'icona   per aprire un menu audio). Il volume può essere regolato anche con la combinazione di tasti Fn + F5/F6.

Figura 10 - Gestione Audio Realtek HD

Regolazione del volume 
audio

Il livello del volume del suono
viene impostato utilizzando il
comando di regolazione volume
di Windows (e i tasti funzione
volume sul computer). Fare clic
sull'icona Volume nella barra
delle applicazioni per controlla-
re l'impostazione.

Fare clic con il 
pulsante destro del 
mouse sull'icona  
per accedere al 
menu sopra.
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Funzioni di risparmio energetico
Il pannello di controllo delle Opzioni risparmio energia (menu Hardware e suoni) di Windows (vedere la pagina 176)
consente la configurazione delle funzioni di risparmio energetico del computer. Selezionando Risparmio di energia è
possibile attivare questa funzione e configurare le opzioni relative al pulsante di alimentazione, pulsante di sospensione,
coperchio del computer (chiuso), schermo e modalità sospensione. Nota: la funzione Risparmio di energia può influire
sulle prestazioni del computer.

Fare clic su una delle combinazioni esistenti o su Crea combinazione per il risparmio di energia sul menu di sinistra e
personalizzarla per creare una nuova combinazione. Fare clic su Modifica impostazioni combinazione, quindi su Cambia
impostazioni avanzate risparmio energia per accedere a ulteriori opzioni di configurazione.

Figura 11 - Opzioni risparmio energia

Nota: Sospensione è lo stato di risparmio di energia predefinito per Window Vista
180 -  Funzioni di risparmio energetico
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Installazione driver
Il DVD-ROM Device Drivers & Utilities + User’s Manual
contiene i driver e le utilità necessari per il corretto
funzionamento del computer. Inserire il DVD-ROM e fare
clic su Install Drivers (pulsante), oppure il pulsante
Optional per accedere al menu del driver opzionale.

Installare i driver attenendosi all'ordine indicato nella
Tabella 5. Dopo l'installazione di ciascun driver, lo stesso
viene oscurato (se occorre reinstallare uno dei driver, fare
clic sul pulsante Unlock).

Installazione manuale dei driver
Fare clic sul pulsante Browse CD (Sfoglia CD)
nell'applicazione Drivers Installer e selezionare il file
eseguibile nella cartella del driver corrispondente.

Windows Update
Dopo l'installazione di tutti i driver assicurarsi di aver
attivato Window update per ottenere tutti i recenti
aggiornamenti di sicurezza ecc. (tutti gli aggiornamenti
includeranno i più recenti hotfixes di Microsoft).

Tabella 5 - Procedura di installazione

Driver (Windows Vista) Pagina #

Chipset pagina 182

Video pagina 182

Audio pagina 182

Modem pagina 182

Lettore di schede/ExpressCard pagina 182

Rete (LAN) pagina 182

TouchPad pagina 182

Hot-Key pagina 182

LAN Wireless (opzione) pagina 183

Bluetooth (opzione) pagina 184

Camera PC (opzione) pagina 185

Lettore d’impronte digitali (opzione) pagina 188

CIR (opzione) pagina 191

Sintonizzazione TV (opzione) pagina 191

Intel Turbo Memory (opzione) pagina 193

Attivare Window update (vedere a sinistra)
Installazione driver - 181
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Chipset
1. Fare clic su Install Drivers.
2. Fare clic su 1.Install Chipset Driver > Sì.
3. Fare clic su Avanti > Sì > Avanti > Avanti.
4. Fare clic su Fine per riavviare il computer.

Video
1. Fare clic su Install Drivers.
2. Fare clic su 2.Install Video Driver > Sì.
3. Fare clic su Avanti.
4. Fare clic su Fine per riavviare il computer.

Audio
1. Fare clic su Install Drivers.
2. Fare clic su 3.Install Audio Driver > Sì.
3. Fare clic su Avanti.
4. Fare clic su Fine per riavviare il computer.

Modem
1. Fare clic su Install Drivers.
2. Fare clic su 4.Install Modem Driver > Sì.
3. Fare clic su OK.
4. Il modem è pronto per la configurazione della 

connessione.

ExpressCard / Lettore di schede
1. Fare clic su Install Drivers.
2. Fare clic su 5.Install CardReader Driver > Sì.
3. Fare clic su Avanti > Avanti.
4. Fare clic su Fine per riavviare il computer.

Rete (LAN)
1. Fare clic su Install Drivers.
2. Fare clic su 6.Install LAN Driver > Sì.
3. Fare clic su Avanti > Installa.
4. Fare clic su Fine.

TouchPad
1. Fare clic su Install Drivers.
2. Fare clic su 7.Install Touch Pad Driver > Sì.
3. Fare clic su Avanti > Avanti > Avanti.
4. Fare clic su Fine per riavviare il computer.

Hot-Key
1. Fare clic su Install Drivers.
2. Fare clic su 8.Install Hotkey Driver > Sì.
3. Fare clic su Next > Install.
4. Fare clic su Finish > Finish per riavviare il computer.
182 -  Installazione driver
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LAN Wireless

Installazione del driver del modulo LAN 
Wireless
1. Accertarsi che il modulo sia acceso.
2. Fare clic su Optional (pulsante).
3. Fare clic su 1.Install Intel WLan driver > Sì.
4. Fare clic su Installa il software.
5. Fare clic sul pulsante “Accetto i termini del contratto di 

licenza”, quindi fare clic su Avanti.
6. Fare clic su Avanti > OK per completare l'installazione.

Nota: Il sistema operativo è l'impostazione predefinita per
il controllo LAN wireless in Window Vista.

Connettersi a una rete wireless
Accertarsi che il modulo LAN Wireless sia acceso.

1. Fare clic sull'icona della WLAN  nella barra delle 
applicazioni, e quindi fare clic su Connessione a una rete  (o 
fare clic con il pulsante destro del mouse sull'icona , e 
quindi fare clic su Connessione a una rete).

2. Nell'elenco Mostra, scegliere Wireless dal menu a tendina.
3. Verrà visualizzato un elenco delle reti disponibili al momento.
4. Fare clic su una rete e quindi su Connetti.
5. In caso non venisse visualizzata una rete alla quale si 

desidera connettersi, fare clic su Configura una 
connessione o una rete (verrà visualizzato un elenco di 
opzioni che consente la ricerca manuale e la creazione di una 
nuova rete).

6. Spostare il cursore sull'icona  della barra delle applicazioni 
per visualizzare lo stato della connessione.

7. Per disconnettersi dalla rete wireless è possibile fare clic 
sull'icona , della barra delle applicazioni e selezionare 
Connetti o disconnetti... per accedere al menu della rete, 
quindi fare clic su Disconnetti (o fare clic con il pulsante 
destro del mouse sull'icona , e quindi fare clic su 
Disconnetti da).

Accensione/spegnimento del modulo LAN Wireless

Attivare l'alimentazione al modulo LAN Wireless utilizzando la
combinazione di tasti (Fn + F11). Quando il modulo LAN Wire-
less è acceso, il LED  è di colore verde e l'indicatore 
viene visualizzato per breve tempo.
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Bluetooth

Installazione del driver del modulo Blue-
tooth
1. Accertarsi che il modulo sia acceso.
2. Fare clic su Optional (pulsante).
3. Fare clic su 2.Install BlueTooth driver > Sì.
4. Scegliere la lingua desiderata e fare clic su OK > Next.
5. Fare clic sul pulsante “I accept the items of the license 

agreement”, quindi fare clic su Next.
6. Fare clic su Next > Install.
7. Fare clic su Finish > Yes per riavviare il computer.

Connessione all'area locale via Blueto-
oth
È possibile controllare lo stato di connessione Bluetooth da
Centro connessioni di rete e condivisione:

1. Utilizzare la combinazione di tasti Fn + F12 per accendere il 
modulo Bluetooth.

2. Eseguire il programma IVT Corporation BlueSoleil dall'icona 
sul desktop o dal menu Start.

3. Fare clic su Start, e fare clic su Pannello di controllo 
(oppure scegliere Impostazioni e fare clic su Pannello di 
controllo).

4. Fare doppio clic Centro connessioni di rete e condivisione 
(Rete e Internet).

5. Fare clic su Gestisci connessioni di rete.
6. Nel pannello di controllo viene quindi visualizzato lo stato della 

connessione Bluetooth.
7. Per disconnettere scegliere File da IVT Corporation 

BlueSoleil - Finestra principale, quindi scegliere Esci (a 
questo punto la connessione alla rete locale visualizza "Cavo 
di rete scollegato").

8. Non utilizzare il pulsante Chiudi  o la combinazione di tasti 
Fn + F12 prima di scegliere File > Esci altrimenti non verrà 
visualizzato lo stato corretto.

9. È possibile utilizzare la combinazione di tasti Fn + F12 per 
spegnere il modulo Bluetooth (controllare l'icona LED per 
conoscere lo stato di alimentazione del modulo Bluetooth).

Accensione/spegnimento del modulo Bluetooth

Attivare l'alimentazione al modulo Bluetooth utilizzando la com-
binazione di tasti (Fn + F12). Quando il modulo Bluetooth è ac-
ceso, il LED  è di colore arancione e l'indicatore 
viene visualizzato per breve tempo.
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Camera PC
Per questo computer sono disponibili 2 opzioni di
fotocamera. Il modulo camera da 1,3M pixel utilizza
l'applicazione BisonCap per catturare i file video. Il
modulo di camera da 2,0M pixel utilizza l'applicazione
VideoView per catturare i file video.

Installazione del driver della camera 
PC
Per modulo di camera da 1,3M pixel:
1. Accendere il modulo con la combinazione Fn + F10 

(l'indicatore  viene visualizzato per breve tempo 
quando il modulo è acceso).

2. Fare clic su Optional (pulsante).
3. Fare clic su 3.PC Camera, Web cam > Sì.
4. Scegliere la lingua desiderata e fare clic su  Avanti.
5. Fare clic su Avanti  > Fine per riavviare il computer.
6. Eseguire l'applicazione BisonCap dal collegamento sul 

desktop oppure dalla voce BisonCam del menu Start > 
Programmi/Tutti i programmi (se l'hardware è spento, 
utilizzare la combinazione di tasti Fn + F10 per 
riaccenderlo).

Per modulo di camera da 2,0M pixel:
1. Accendere il modulo con la combinazione Fn + F10 

(l'indicatore  viene visualizzato per breve tempo 
quando il modulo è acceso).

2. Fare clic su Optional (pulsante).
3. Fare clic su 3.PC Camera, Web cam > Sì.
4. Fare clic su Installa.
5. Scegliere Sì o No alla domanda sul sistema di risparmio 

energetico.
6. Fare clic su Fine > Fine per riavviare il computer.
7. Eseguire l'applicazione VideoView dal collegamento sul 

desktop oppure dalla voce  USB2.0 PC Camera del menu 
Start > Programmi/Tutti i programmi (se l'hardware è 
spento, utilizzare la combinazione di tasti Fn + F10 per 
riaccenderlo).
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Configurazione audio della camera PC
Configurare le opzioni di registrazione audio in Windows
per catturare video e audio con la camera.

1. Fare clic su Start, e fare clic su Pannello di controllo 
(oppure scegliere Impostazioni e fare clic su Pannello di 
controllo). 

2. Fare clic Audio  (Hardware e suoni).
3. Fare clic Registrazione (scheda).
4. Fare clic con il pulsante destro del mouse su Microfono 

(Realtek High Definition Audio) et accertarsi che la voce non 
sia disabilitata.

5. Fare doppio clic su Microfono (o selezionare Proprietà dal 
menu di scelta rapida ottenuto con il tasto destro del mouse).

6. Scegliere Livelli (scheda) e regolare i cursori Microfono e 
Preamplificazione microfono) per ottenere il livello richiesto.

7. Fare clic su OK, quindi chiudere i pannelli di controllo.
8. Avviare il programma BisonCap/VideoView dal menu Start > 

Programmi/Tutti i programmi > BisonCam/USB2.0 PC 
Camera

9. Aprire il menu Dispositivi/Devices e selezionare Microfono 
(Realtek, ecc.) (accanto ad esso dovrebbe essere presente 
un segno di spunta).

10. Aprire il menu Cattura/Capture e selezionare Audio cattura/
Capture Audio (accanto ad esso dovrebbe essere presente 
un segno di spunta).

BisonCap/VideoView
Le applicazioni BisonCap (per la camera da 1,3M pixel) e
VideoView (per la camera da 2,0M pixel) sono utili
programmi video per la visualizzazione e il test di video
generali, in grado anche di catturare file video in formato
.avi.

1. Avviare il programma BisonCap/VideoView dal menu Start > 
Programmi/Tutti i programmi > BisonCam/USB2.0 PC 
Camera (si consiglia di Impostare Cattura File prima del 
processo di cattura - vedere "Imposta cattura file" di 
seguito).

2. Aprire il menu Cattura\Capture (se si desidera catturare file 
di audio vedere "Configurazione audio della camera PC") e 
selezionare Avvia cattura\Start Capture.

3. Fare clic su OK (la collocazione del file verrà visualizzata nella 
casella a scomparsa), per avviare la cattura, quindi premere 
Esc per interromperla (è possibile visualizzare il file 
utilizzando Windows Media Player).

Imposta cattura file
Prima di effettuare la cattura dei file di video si può selezionare
l'opzione Imposta file di cattur/Set Capture File nel menu
File e impostare il nome del file e la collocazione prima della
cattura (questo contribuirà a evitare la sovrascrittura dei file).
Impostare il nome e la collocazione poi cliccare Apri, quindi
impostare la "dimensione del file di cattura:" e cliccare "OK".
Quindi  è possibile avviare il processo di cattura di cui sopra.
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Zoom 
I programmi BisonCap e VideoView che vi consentono di
ingrandire e ridurre con la camera.

Per BisonCap:
1. Avviare il programma BisonCap.
2. Aprire il menu Zoom e selezionare Nagyítás/Kicsinyítés.

Per VideoView:
1. Avviare il programma VideoView.
2. Aprire il menu Options e selezionare Setting (utilizzare il 

cursore per regolare il livello dello zoom, quindi scegliere OK 
per salvare l'impostazione).

Prendere immagini fisse
I programmi BisonCap e VideoView consente di prendere
immagine fisse.

1. Avviare il programma BisonCap/VideoView.
2. (BisonCap) Aprire il menu Opzioni e selezionare Scatta 

foto.                                                                                                      
oppure                                                                                
(VideoView) Aprire il menu Capture e selezionare 
SnapShot.

3. La fotografia (in formato JPEG) viene inserita nella cartella 
Snapshot  del desktop (non rimuovere o rinominare la 
cartella).

Eliminazione dello sfarfallio dello schermo
Se la schermata del video nel programma BisonCap/
VideoView ha uno sfarfallio, è possibile provare a regolare
l'impostazione nelle opzioni Video Capture Filter (filtro
di cattura video).

Per BisonCap:
1. Avviare il programma BisonCap.
2. Aprire il menu Options e selezionare Video Capture Filter....
3. Scegliere 50Hz oppure 60Hz sotto Frequenza nella scheda 

Pagina delle proprietà.

Per VideoView:
1. Avviare il programma VideoView.
2. Aprire il menu Options e selezionare Video Capture Filter....
3. Scegliere 50Hz oppure 60Hz sotto Flickering Reduction 

nella scheda Image.
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Lettore d’impronte digitali
Se nell'opzione di acquisto è stato incluso il lettore di impronte
digitali sarà necessario installare il driver secondo le istruzioni
riportate sotto. 

Assicurarsi di avere i diritti amministratore sul proprio
computer, e avere attivato una password di Windows per
una protezione totale. 

Prima di avviare il processo di registrazione si raccomanda
di seguire l'esercitazione per il lettore d’impronte digitali.
Per avviare l'esercitazione fare clic su Start > Programmi/
Tutti i programmi > Protector Suite QL > Esercitazione
Fingerprint.

Installazione del driver per l'impronta di-
gitale
1. Fare clic su Optional (pulsante).
2. Fare clic su 4.Install FingerPrint Driver > Sì.
3. Fare clic su Installazione software.
4. Fare clic su Avanti > Avanti > Avanti.
5. Fare clic su Fine > Sì per riavviare il computer.

Registrazione utente
1. Fare clic su Start > Programmi/ Tutti i programmi > 

Protector Suite QL > Registrazione utente, o fare doppio 
clic sull'icona  nella barra delle applicazioni.

2. Al primo avvio del programma viene richiesto di fare clic sul 
pulsante di accettazione della licenza, quindi su OK.

3. Fare clic su Avanti e selezionare “Registrazione nel disco 
rigido”, e fare clic su Fine.

Guida & Manuale

Clic destro sull'icona  della barra delle applicazioni per atti-
vare il menu dove selezionare Guida.

Inserire il DVD-ROM Device Drivers & Utilities + User’s Manual
e fare clic su Optional (pulsante). Fare clic su Unlock (pulsan-
te) et quindi fare clic su  4.Install FingerPrint Driver > Sì.

Cliccare Documentazione per aprire la cartella dove si trova il
manuale in formato .pdf.

Per installare Adobe Acrobat Reader per leggere il file, inserire
il DVD-ROM Device Drivers & Utilities + User’s Manual e fare
clic su User’s Manual (pulsante), e fare clic su Install Acrobat
Reader (pulsante).
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4. Nel caso non si sia impostata la password Windows apparirà 
l'invito per farlo (nota: Nel caso non sia stata impostata la 
password Protector Suite QL non potrà garantire la 
sicurezza all'accesso al proprio computer).

5. Fare clic su Avanti e quindi si viene invitato a inserire la 
propria password Windows.

6. Fare clic su Avanti > Avanti (attivare la cassella “Lancia l' 
esercitazione interattiva” per lanciare l'esercitazione 
Fingerprint).

7. Fare clic su Avanti ad ogni finestra dell'esercitazione (si può 
premere il pulsante “Salta esercitazione” in qualsiasi 
momento).

8. Premere il pulsante per ogni impronta per avviare il processo 
di registrazione di quell'importa.

9. Passare l'impronta tre volte per registrare la stessa.
10. Ripetere l'operazione per tutte le impronte che si desiderano 

registrare, quindi fare clic su Avanti.
11. Fare clic su Fine.
12. Fare clic su una delle intestazioni sotto “Informazioni su:” per 

visualizzare ulteriori informazioni relative a un argomento.
13. Fare clic su Chiudi.
14. Riavviare il computer.
15. Clic destroy sull'icona  della barra di applicazioni per 

attivare il menu che permette la Modifica impronte, lanciare 
Control Center, accedere al menu Guida ecc. Si può inoltre 
eseguire il Control Center ecc. dalla voce Protector Suite QL 
del menu Start > Programmi/Tutti i programmi.

16. Consultare “Guida & Manuale” a pagina 188 per altri 
dettagli.

17. Se si fa passare il ditto sul lettore ogni volt ache si può 
accedere al  Biomenu per bloccare il computer, registrare 
siti web, aprire il Control Center e accedere il menu Guida.

18. Control Center consente di cambiare le Impostazioni, le 
Impronte digitali e di visualizzare la Guida.

Figura 12 - Control Center & Biomenu 

Registrazione Impronta

Si osservi che viene raccomandato di registrare più di una
impronta in caso di ferita ecc.
Lettore d’impronte digitali - 189



Guida Rapida per l'Utente

Ita
lia

no
Modulo sintonizzatore TV USB
Se la configurazione acquistata comprende il modulo sintonizzatore TV USB opzionale,
verrà fornito in dotazione un CD contenente driver, software e un manuale per l'utente. Oltre
al driver sul DVD-ROM Device Drivers & Utilities + User’s Manual del telecomando
fornito a corredo del sintonizzatore TV.

Viene inoltre fornito un telecomando e la relativa antenna, insieme ai componenti di
montaggio del modulo del sintonizzatore TV USB.

Per mezzo del sintonizzatore TV è possibile guardare la televisione, assistere a
videoconferenze e registrare immagini e video sul computer.

Il jack dell'antenna a cavo (CATV) viene abilitato solo quando il modulo del
sintonizzatore TV è installato. Accertarsi di installare tutti i software prima di collegare
l'antenna TV. 

Antenna TV

L'antenna TV in dotazione
con i moduli di
sintonizzazione TV è intesa
esclusivamente per uso in
interni. Non utilizzare il
modulo di sintonizzazione
TV all'aperto.

Telecomando del 
sintonizzatore TV

Puntare il telecomando
verso il ricetrasmettitore
CIR per cambiare canale, e
così via.

Figura 13
Jack e porte del sinto-

nizzatore TV

1. Ricetrasmettitore ad 
infrarossi/
ricetrasmettitore CIR

2. Jack dell'antenna a cavo 
(CATV) 2

1
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Installazione del driver a infrarossi (CIR)
1. Fare clic su Optional (pulsante).
2. Fare clic su 5.Install ITE CIR Driver > Sì.
3. Fare clic su Next > Yes > Next > Finish.

Installazione del driver del sintonizzato-
re TV
1. Inserire il CD del driver del sintonizzatore TV nell’unità 

CD/DVD.
2. Fare clic su MC770A Driver V2.3.3.3 Setup for XP/

Vista.
3. Fare clic su Install > OK.
4. Fare clic su S/W Encoder V1.0.70807 Setup for Vista 

per installare l’encoder software.
5. Fare clic su Avanti.
6. Fare clic sul pulsante “Accetto i termini del contratto di 

licenza”, quindi fare clic su Avanti.
7. Fare clic su Avanti > Avanti > Avanti > Fine.
8. Fare clic su AP V2.0.1810.70802 Setup for XP/Vista per 

installare l'applicazione.
9. Fare clic su Avanti.
10. Fare clic sul pulsante “Accetto i termini del contratto di 

licenza”, quindi fare clic su Avanti.
11. Fare clic su Avanti (assicurarsi di inserire un User Name e 

il nome della società).

12. Digitare la chiave CD fornita, quindi fare clic su Avanti.
13. Scegliere la lingua desiderata e fare clic su Avanti.
14. Fare clic su Avanti > Avanti > Avanti.
15. Fare clic sul pulsante per riavviare il computer, quindi fare 

clic su Avanti.
16. Fare clic su Fine per riavviare il computer.
17. Eseguire l'applicazione Hybrid DTV dal collegamento sul 

desktop oppure dalla voce DTVplayer del menu Start > 
Programmi/Tutti i programmi > Hybrid DTV.
o

18. Avviare Windows Media Center direttamente dal menu 
Start (Start > Programmi/Tutti i programmi > 
Windows Media Center).

19. La guida in linea e supporto di Windows contiene 
informazioni sulle funzioni di Windows Media Center. 
Scegliere Start  e selezionare Guida in linea e 
supporto, quindi digitare "Media Center" nel riquadro di 
Cerca e poi fare clic sull'icona  della lente 
d'ingrandimento per visualizzare i risultati.

Windows Media Center

Osservare che il software Windows Media Center è
integrato solo a Windows Vista Home Premium e
Ultimate Editions. 
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Segnale della TV digitale
L'antenna è il fattore più importante per la ricezione di un
segale TV digitale terrestre chiaro. L'antenna passiva
fornita consente di ottenere un segnale chiaro solo quando
collocata vicino a una finestra. Se il segnale non è chiaro è
possibile acquistare un'antenna attiva (anche questa va
collocata vicino a una finestra) per migliorare il segnale. È
inoltre opportuno informarsi sui siti Web preposti per
conoscere la copertura della TV digitale terrestre della
propria area. Si noti che, a differenza della TV analogica, se
il segnale digitale è debole, quindi la TV non visualizza
alcuna immagine.

Registrazione TV e combinazioni di risparmio 
energetico
Se si intende utilizzare il sintonizzatore TV opzionale per
registrare programmi televisivi, aprire il pannello di
controllo Opzioni di risparmio energia e impostare la
combinazione di risparmio energetico su Sempre attivo al
fine di evitare che le opzioni di risparmio energetico
modifichino il livello di prestazioni del computer.

Telecomando
Il telecomando consente di avviare e inviare da remoto il
sistema in uno stato di risparmio energetico, di avviare
Windows Media Center e di navigare nei menu del Media
Center, e così via. Il telecomando consente anche di
controllare in modo completo tutte le funzioni TV e video.

Sicurezza per il cavo CATV 

Verificare che l'installatore del sistema CATV abbia
collegato la schermatura del cavo coassiale alla messa a
terra dell'edificio, il più vicino possibile al punto di ingresso
del cavo.

Questo promemoria è previsto per richiamare all'attenzione
del tecnico installatore del sistema CATV sull'articolo 820-
93 del NEC (Sezione 54, Parte I del "Canadian Electrical
Code",Codice Elettrico Canadese).
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Modulo Intel Turbo Memory
Se nell'opzione di acquisto è stato incluso il modulo scheda di memoria NAND Intel Turbo
Memory (Robson), sarà necessario abilitare l'opzione nel BIOS PRIMA di installare il
sistema operativo Windows Vista (non abilitare questa opzione in Windows XP oppure su
un sistema operativo Windows Vista che è stato installato senza l'opzione abilitata).

Intel Turbo Memory Technology (definita anche memoria flash Robson) è una tecnologia
di Intel che riduce il tempo impiegato da un computer per avviarsi, per caricare le
applicazioni e per scrivere i dati sul disco rigido. Intel Turbo Memory Technology è
supportata solo da Windows Vista (sono supportate anche funzioni di Windows Vista quali
ReadyBoost, ReadyDrive e Superfetch).

Configurazione di Intel Turbo Memory e installazione del 
driver
1. Accendere il computer e premere F2 per entrare nel BIOS.
2. Aprire il menu Advanced.
3. Selezionare Advanced Chipset Control e premere Invio.
4. Premere la barra spaziatrice per assicurarsi che Intel Robson sia Abilitato (Enabled).
5. Aprire il menu Boot.
6. Impostare l'unità CD/DVD-ROM (verificare che sia inserito il CD del sistema operativo 

Microsoft Windows Vista) come prima periferica nell'ordine di avvio (boot) dal menu 
Boot priority order.

7. Selezionare Exit Saving Changes dal menu Exit (o premere F10 ed Invio) e premere 
Invio per uscire dal BIOS e riavviare il computer.

Problema di ReadyBoost

Quando la Intel® Turbo
Memory Console viene
aperta immediatamente
dopo l'accensione del
sistema, Windows
ReadyBoost può
sembrare disabilitato.

Si tratta di un
comportamento previsto.
Lo stato sembra disabilitato
mentre Microsoft genera il
file Windows
ReadyBoost. Una volta
che il file è stato generato,
lo stato ritorna nuovamente
abilitato.

Vedere Intel website
(http://support.intel.com/
support/chipsets/itm/sb/
CS-025852.htm) per
conoscere le ultime
informazioni aggiornate su
questo problema.
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8. Premere un tasto alla visualizzazione del messaggio "Press any key to boot from CD or DVD".
9. Il software del sistema visualizza la procedura di installazione  (consultare la documentazione di Windows Vista per 

maggiori dettagli).
10. Installare i driver secondo le istruzioni fornite in “Installazione driver” a pagina 181 (verificare che i driver siano installati 

nell'ordine indicato nella Tabella 5 a pagina 181).
11. Inserire il DVD-ROM Device Drivers & Utilities + User’s Manual nell’unità CD/DVD.
12. Fare clic su Optional (pulsante).
13. Fare clic su 6.Install Robson Driver > Sì.
14. Fare clic su Avanti > Sì > Avanti > Avanti.
15. Fare clic su Fine per riavviare il computer.
16. Una volta riavviato il computer, scegliere Riavvia per completare la procedura di installazione dopo che il computer ha 

eseguito le necessarie modifiche dell'hardware.

Figura 14 - Menu Advanced & Advanced Chipset del BIOS

Main Advanced Security Boot Exit

F1 Help �� Select Item -/+ Change Values F9 Setup Defaults
Esc Exit �� Select Menu Enter Select �Sub-Menu F10 Save and Exit

Item Specific Help

Advanced

Select options for
Advanced Chipset
features.

Phoenix TrustedCore(tm) Setup Utility

�Advanced Chipset Control
Reset Configuration Data: [No]
Local Bus IDE adapter: [Both]

Boot-time Diagnostic Screen: [Enabled]
Legacy USB Support: [Enabled]
USB 2.0 Enable: [Enabled]
POST Beep Sound [Disabled]
Battery Low Alarm Beep: [Disabled]

F1 Help �� Select Item -/+ Change Values F9 Setup Defaults
Esc Exit �� Select Menu Enter Select �Sub-Menu F10 Save and Exit

Item Specific Help

Advanced

Phoenix TrustedCore(tm) Setup Utility

Intel Turbo Memory
Technology

Advanced Chipset Control

Intel Robson [Enabled]
SATA - Device 31, Function 2: [Enhanced]
AHCI Configuration Enabled]
DFOROM(Robson) Support: [Enabled]
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Risoluzione dei problemi
Problema Possibile causa - Soluzione

Non è più possibile 
modificare i codici regionali 
DVD.

Il codice è stato modificato per un massimo di 5 volte. La rilevazione regionale DVD dipende dal 
dispositivo e non dal sistema operativo. È possibile selezionare il codice regionale del modulo 5 volte. 
La quinta selezione è permanente. Non può essere modificata anche cambiando il proprio sistema 
operativo, oppure usando il modulo in un altro computer.

Il TouchPad non funziona. Il TouchPad è stato disabilitato. Premere la combinazione di tasti di attivazione/disattivazione del 
TouchPad (Fn + F1) (verificare che sia installato il driver del TouchPad).

Non è possibile rilevare i 
moduli LAN Wireless/ 
Bluetooth.

II/I modulo/i è/sono disattivato/i.  Controllare il LED indicatore appropriato  per verificare se il/i 
modulo/i è/sono attivato/i o disattivato/i (vedere “Indicatori LED” a pagina 169). Se il LED indicatore 
è spento, quindi premere la combinazione appropriata di tasti al fine di attivare il modulo (vedere la 
Tabella 3 a pagina 171).

La camera PC visualizza 
una schermata nera 
quando si esegue il 
software della camera PC.

Il software sta utilizzando la periferica sbagliata. Se sono presenti sia il modulo camera PC (opzionale) 
che il Sintonizzatore TV (opzionale), andare al menu Periferiche/Devices del programma BisonCap/
VideoView e selezionare la periferica BisonCam, NB Pro/USB2.0 2M WebCam (camera PC).

I file video catturati dalla 
camera PC prendono 
troppo spazio sul disco.

Nota catturare file di video ad altra risoluzione molto spazio disco disponibile per ogni file.

Nota Window Vista richiede un minimo di 15GB di spazio disco libero sulla partizione del disco C:. Si 
consiglia di salvare la cattura del file video in un'ubicazione diversa dal disco C:, limitare la dimensione 
del file del video catturato o ridurne la risoluzione (Options/Opzioni > Video Capture Pin... > 
Dimensioni output).
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Errore di risoluzione dello schermo
In caso di riduzione della risoluzione dello schermo, oppure di fenomeni di sfarfallio dello schermo dopo aver ripreso il
funzionamento del sistema solo dalla modalità di sospensione di Windows Vista, seguire le istruzioni seguenti per
risolvere il problema. Questo errore si verifica in conformità con il criterio di Windows Vista, che attiva il sistema TMM
(Transient Multimon Manager) quando il coperchio del notebook (S3) viene chiuso. TMM disconnette lo schermo LCD
dal sistema operativo e quindi lo ripristina alla riapertura del coperchio. Ciò potrebbe avviare TMM per ripristinare una
vecchia impostazione dello schermo, causando in alcuni casi lo sfarfallio dello schermo o il cambiamento della risoluzione.
1. Fare clic su Start, e fare clic su Pannello di controllo (oppure scegliere Impostazioni e fare clic su Pannello di controllo) e fare 

doppio clic su Strumenti di amministrazione (Sistema e manutenzione).
2. Fare doppio clic su Utilità di pianificazione (Pianifica attività).
3. Fare doppio clic su Libreria Utilità di pianificazione > Microsoft > Windows, e fare clic su MobilePC per aprire il pannello di 

controllo.
4. Clic destroy sul TMM, selezionare Disattiva, e quindi chiudere tutti i pannelli di controllo.

Figura 15 - Sistema e manutenzione (Pannello di controllo)
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Specifiche tecniche

Funzionalità Specifiche tecniche

Tipi di 
processore

Processore Intel Core 2 Duo 
478 pin Micro FCPGA package
T7100

(65nm) tecnologia di processo a 65 nm
Cache L2 da 2MB & FSB a 800MHz 
1,80 GHz

Processore Intel Core 2 Duo 
478 pin Micro FCPGA package
T7300/ T7500/ T7700

(65nm) tecnologia di processo a 65 nm
Cache L2 da 4MB & FSB a 800MHz 
2,0/ 2,2/ 2,4 GHz

Logica del core Chipset Intel(R) PM965 + ICH8M

Memoria Due prese SODIMM 200 pin, dotate di supporto per la memoria DDRII (DDR2) 533/ 667
Memoria espandibile fino a 4 GB

Sicurezza Slot blocco di sicurezza (tipo Kensington®)
Modulo lettore d’impronte digitali (opzione di fabbrica)

Password del BIOS

BIOS Una Flash ROM da 8Mb Phoenix BIOS

Ultimi aggiornamenti delle specifiche tecniche

Le specifiche tecniche elencate in questa appendice sono corrette al momento di andare in stampa. Alcuni elementi (in particolare
tipi di processore e velocità) possono essere modificati o aggiornati causa la programmazione del produttore. Per dettagli rivol-
gersi al proprio centro di assistenza.
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Opzioni di LCD Schermo piatto TFT tipo Glare, 17" WXGA 
(1280*800)
Schermo piatto TFT tipo Non Glare, 17" WXGA 
(1280*800)

Schermo piatto TFT tipo Glare, 17" WSXGA+ 
(1600*1050) 
Schermo piatto TFT tipo Glare, 17" WUXGA 
(1920*1200) 

Opzioni della 
scheda video

Scheda video NVIDIA GeForce Go 7950 GTX PCI-E
MXM-IV
512MB GDDR3 Video RAM On Board
Compatibile con MS DirectX® 9

Scheda video NVIDIA GeForce 8700M GT PCI-E
MXM-III
512MB GDDR3 Video RAM On Board
Compatibile con MS DirectX® 10
Supporta HDCP

Scheda video NVIDIA GeForce 8800M GTX PCI-E
MXM-IV
512MB GDDR3 Video RAM On Board
Compatibile con MS DirectX® 10
Supporta HDCP

Periferiche di 
memorizzazione

Una unità di tipo ottico (CD/DVD) da 12,7 mm (altezza) - vedere “Opzioni” a pagina 200 per le opzioni 
dell'unità
Un disco rigido SATA facilmente sostituibile da 2,5" di 9,5 mm (altezza)

Lettore di 
schede

Modulo lettore di schede 7-in-1 (MS/ MS Pro/ SD/ Mini SD/ MMC/ RS MMC/ MS Duo)
Nota: Schede MS Duo/ Mini SD/ RS MMC richiedono PC adattatore

Funzionalità Specifiche tecniche

Supporto della scheda video

Si noti che i tipi di scheda, le specifiche tecniche e i
driver sono soggetti a continue modifiche e aggior-
namenti. Richiedere al centro assistenza locale i det-
tagli più recenti relativi alle schede video supportate.
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Audio Interfaccia conforme Intel High Definition Audio
Sistema sonoro stereo 3D

 Audio Surround SRS WOW 
Compatibile con Sound-Blaster PRO™

Emissione digitale S/PDIF
Microfono incorporato
2 altoparlanti incorporati (1,5W, 8Ω)
1 Subwoofer (2W, 8Ω)

Tastiera Tastiera "Win Key" completa (con tastierino numerico)

Periferica di 
puntamento

TouchPad incorporato (funzionalità tasto di scorrimento integrata)

Slot
ExpressCard

Slot ExpressCard/34/54

Interfaccia Quattro porte USB 2.0
Una porta uscita DVI
Un jack uscita delle cuffie
Un jack ingresso del microfono
Un jack uscita S/PDIF 
Un jack di ingresso di linea (Line-In) per l'input audio 
Una porta seriale
Una porta Mini-IEEE 1394 
Un ricetrasmettitore ad infrarossi
Un jack RJ-11 per modem
Un jack RJ-45 per LAN

Un jack di ingresso CC
Un jack di uscita S-Video per uscita TV e HDTV 
Un jack dell'antenna a cavo (CATV) (analogico/digi-
tale) (funziona con sintonizzatore TV opzionale)
Un ricetrasmettitore CIR (funziona con sintonizzatore 
TV opzionale)
Uno slot mini card per il sintonizzatore TV o modulo 
di memoria Intel Turbo
Uno slot mini card per la sola WLAN

Risparmio ener-
gia

Supporta ACPI v3.0

Funzionalità Specifiche tecniche
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Comunicazione Fax/Modem Plug & Play da 56K conforme V.90 & V.92 
Ethernet LAN da 1 GB PCIe
Modulo WLAN PCIe Intel Wireless WiFi Link 
4965AGN (opzione)
Modulo sintonizzatore TV USB (opzione)

Modulo Bluetooth 2.0 + EDR USB (opzione di 
fabbrica)
1,3M o 2,0M Camera PC USB (opzione di fabbrica)

Alimentazione Adattatore CA/CC a pieno campo
Ingresso CA: 100 - 240V, 50 - 60Hz
Uscita CC: 20V, 6,0A (120 W)

Pacco batteria Smart agli Ioni di Litio, 4400mAH (8 
celle)

Requisiti 
ambientali

Temperatura
In esercizio: 5°C - 35°C 
Non in esercizio: -20°C - 60°C

Umidità relativa
In esercizio: 20% - 80%
Non in esercizio: 10% - 90%

Dimensioni 
fisiche & Peso

397 (l) x 284 (p) x 22 ~ 44 (a) mm (min) Circa 3,95 kg  (+/- 5%) con batteria (8 celle)

Opzioni Opzioni modulo unità ottica:
Unità Combo 
Unità DVD-Super-Multi 

Modulo WLAN PCIe Intel Wireless WiFi Link 
4965AGN
Modulo sintonizzatore TV USB
Modulo scheda di memoria NAND Intel Turbo 
Memory (Robson)

Modulo Bluetooth 2.0 + EDR USB (opzione di 
fabbrica)
Modulo di camera PC USB da 1,3M o 2,0 M pixel 
(opzione di fabbrica)
Modulo lettore d’impronte digitali (opzione di 
fabbrica)

Funzionalità Specifiche tecniche
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